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1.  

2.  

1.  

2.  

1.  

2.  

The installation process depends on the distribution type and your Operational System.

The installer distribution is the recommended way to install DBeaver in Windows and MacOS X. It contains all 
required dependencies. In addition, the installer automatically upgrades DBeaver to the new version if a previous 
version has already been installed. To install DBeaver, run the installer executable and follow the instructions on 
its screens.

NOTE:

The installer does not change any system settings or the Java installation.

The included JDK will be accessible only to DBeaver.

When installing DBeaver manually, without using an installer:

Extract the contents of the archive.
NOTE: Do not unzip the archive over a previous DBeaver version. If you already have any version of 
DBeaver extracted in the same location - remove it before unzipping the new version.
NOTE: All configurations, scripts and other necessary data are stored in a separate location (usually in the 
user`s home directory) so the program deinstallation does not affect them.

Run the  executable.dbeaver

To install DBeaver using a Debian package:

Run .sudo dpkg -i dbeaver-<version>.deb

Execute .dbeaver &

To install DBeaver using RPM package:

Run .sudo rpm -ivh dbeaver-<version>.rpm

Execute .dbeaver &

NOTE: To upgrade DBeaver to the next version, use  parameter.sudo rpm -Uvh dbeaver-<version>.rpm

Installation

Windows / MacOS Installer

ZIP Archive

Debian Package

RPM Package
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This feature is available only in Windows and macOS.

From time to time, DBeaver automatically checks for new versions. If the check is not disabled and a new version 
is available, it will prompt you to decide whether you want to stay or upgrade. If the second option is chosen, the 
installer will be downloaded and launched upon completion. Note that DBeaver itself will be gracefully closed to 
avoid data loss.

Automatic updates
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The DBeaver window contains a menu bar, a toolbar, a shortcut bar, a workspace with one or more editors and 
views, and a status bar: 

By default, the menu bar contains the following menus:

File menu contains menu items for the creation of files, folders, projects, database connections, database 
projects, and ER diagrams as well as Import and Export items.

Edit menu contains global commands like Cut, Copy, Paste, and Delete targeted at the active element.

Navigate menu allows navigation through scripts and database objects.

Search menu provides options to search among files, database objects and across data.

SQL Editor menu is for opening SQL Editor and managing its appearance.

Database menu allows management of database drivers, connections and transactions, as well as 
reconnecting to and disconnecting from a database.

Window menu includes items to manage the look of DBeaver window: show/hide and minimize/maximize 
views and editors, display bars, split editors, and manage other preferences.

Help menu contains links to information and help resources, as well as menu items to check the version 
number and availability of updates.

Application Window Overview

Menu Bar
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You can customize the menu bar and the list of menu items to display, for this, go to Window -> Customize 
 tab.Perspective -> Menu Visibility

The toolbar contains buttons for the most basic and frequently used commands: 

Some of the buttons are enabled (colored), others are disabled (grey). The sets of enabled and disabled buttons 
change depending on which editor is currently active in the workspace. Only enabled buttons are applicable to the 
active view or editor.

You can customize the toolbar, for this, go to  tab.Window -> Customize Perspective -> Tool Bar Visibility

You can hide or show the toolbar in the application window. To do it, go to the Window menu, click Appearance -> 
.Hide Toolbar / Show Toolbar

There are two shortcut bars - one on the left and one on the right side of the workspace zone. Shortcut bars host 
shortcuts of views and editors and appear if at least one view or editor is minimized, otherwise they are hidden.

Views are windows within the workspace that provide presentations and ways to navigate the information. For 
more information about particular views, see  article.Views

Editors are windows in which you can interact with the content of files and databases. For more information about 
particular editors, see the  article.Editors

Both views and editors can appear as separate windows or as tabs stacked with other views/editors in a tabbed 
window. The following image shows the title bar of a tabbed window. If tabs do not fit in the title bar of a tabbed 
window, they become hidden. To see the list of hidden tabs, click the Show List icon that also indicates their 
number:

There can be several views and editors opened simultaneously in the workspace but only one of them can be 
active at a time.

You can change the layout of the workspace by opening and closing views, docking them in different positions in 
the workspace, collapsing them to the shortcut bar, or expanding them to occupy the whole workspace and 
restoring them to the latest docked position.

Toolbar

Shortcut Bar

Workspace: Views and Editors
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You can move views and editors around the workspace and dock them in different positions:

As a tab in a tabbed window

As a separate window with a vertical or horizontal layout in any zone of the workspace

You can also swap locations of two views or editors.

To dock a view to a position in the workspace, press and hold the title bar of the view, then drag and drop it onto 
the desired position.

You can resize the view and editor windows. To resize, place the cursor to the border of the window until it 
changes to a double-ended arrow, then click and drag the border to the needed size.

To close a view or editor, click the Close button, or right-click the title bar of the view / editor, then click one of the 
options on the context menu (they change depending on the configuration of windows):

Close - to close the active window or tab in a tabbed window

Close Others (for editors and views that appear as tabs in tabbed windows) - to close all tabs of the current 
tabbed window except the active tab

Close Tabs to the Right / Left (also for tabbed windows) - to close all tabs of the current tabbed window that 
are located to the right / left of the active tab

Close All - to close all tabs of a tabbed window (close the window)

All views and editors have the Close, Minimize and Maximize buttons: 

The Maximize button changes to the Restore button when a view or editor is maximized.

To maximize a view or editor to the size of the whole workspace, do one of the following:

Click the Maximize button in the upper-right corner of the view.

Double-click the title bar of the view or editor.

On the Window menu, click .Appearance -> Maximize Active View or Editor

When one view is maximized, other views and editors appear as shortcuts on the shortcut bar.

To restore a maximized view or editor to its latest docked position, double-click its title bar or click the Restore 
button in its upper-right corner.

Changing Workspace Layout

Maximizing, Minimizing and Restoring View and Editors
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When you minimize a view, it wraps into a shortcut on the shortcut bar: 

The shortcuts of views and editors may appear on the left or on the right shortcut bar depending on the latest 
docked position of the view or editor.

To minimize a view, do one of the following:

Click the Minimize button in the upper-right corner of the view.

On the Window menu, click .Appearance -> Minimize Active View or Editor

To restore a minimized view or editor to its previous position, click the Restore button on its shortcut in the shortcut 
bar. To restore a minimized view or editor to a new position, click the view / editor name button under the restore 
button.
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Views are windows within the workspace that provide presentations and ways to navigate the information. The 
main views in DBeaver are: ,  and .Database Navigator Projects Project Explorer

To open a view:

On the Window menu, click  and then, on the submenu, click the name of the view. Click  if Show View Other
the view is not visible on the submenu.

For Database Navigator, Projects, and Project Explorer views, on the Window menu, just click the name of 
the view.

Some views open on demand, for example the  view opens to show search results.Search

Views provide their own toolbar and menu:

To open the view menu, click the View Menu button in the upper-right corner of the view's title bar, next to the 
Minimize button.

The toolbar contains buttons applicable to the objects displayed in the view. The set of enabled and disabled 
buttons depends on the object in focus.

Views also provide context menus for objects they display. To open a context menu for an object, right-click the 
object.

Views
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Database Navigator is the main view to work with the structure and content of databases. To open Database 
Navigator, on the Windows menu, click . For information on how to change the view layout, Database Navigator
please see the  article.Application Window Overview

Database Navigator contains a tree of objects, a toolbar and View menu which contain generic items. Each object 
in the tree has its own context menu. The tree contains the following objects:

Folders - 

Database connections -  and other (icons differ depending on the database type)

Database objects - various depending on the database type, such as Tables , Views , Columns  , 

Indexes , etc.

To open the view menu of Database Navigator, click the View Menu button ( ) in the upper-right corner of the 
window. For more information on where to find the view toolbar and menu, please see the  article.Views

The menu contains the following items:

Icon Menu item Description

Driver 
Manager

Opens the Driver Manager window that allows you to create, edit and delete drivers for databases. 
See  for information about managing database drivers.Database Drivers

Database Navigator
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New 
Connection

Opens the Create new connection wizard. See  for information about creating Create Connection
connections.

(empty)
Active 
Project

Displays a submenu which allows you to choose a project. See  and  for Projects Projects view
information about projects.

New 
Folder

Opens a dialog box for creating a new folder

Collapse 
All

Collapses the tree to the root level

Link with 
editor

Synchronizes the active editor with the element in the database navigator

The toolbar is located in the title bar of the window. Its buttons duplicate the menu items, except for the Active 
.Project

To open the context menu for an object, right-click the object in the tree. The following table summarizes the 
context menu items for all types of objects that may appear in the tree. Note that the presence or absence of the 
context menu items for an object depends on the database and object types.

Menu item Description

Open folder Opens a folder in a separate view

Create new connections / 
Create New Connection

Opens the Create new connection wizard

New Folder Opens a dialog box for creating a new folder

Copy Copies an object to the clipboard

Paste Inserts the copied object into a selected folder - most convenient for copy-pasting connections

Delete
Deletes an object

 The Delete menu item removes the object not only from the tree but from the WARNING!
database itself or the file system, and this action is irreversible.

Rename Opens the Rename [object] dialog box

Properties
Opens the Properties for [object] window which allows viewing and modifying the object`s 
properties

Refresh
Depending on the object, refreshes the object itself, or its parent, or its subnodes – mostly 
used for refreshing tables and schemes

Connect Attempts to connect to the database

Invalidate/Reconnect Checks the status of connection, if it is broken, attempts to reconnect

Disconnect Disconnects from the database

SQL Editor Opens a new SQL editor for the connection

Recent SQL Editor Opens the most recently opened SQL editor

Edit Connection Opens the Connection Configuration window that allows configuring connection settings

View [objects] Opens the object in a separate viewer

Edit [object] Opens the object in a separate editor

Create new [object] Opens an editor in which you can specify properties and save the new object

Opens a submenu of one or more filtering options (depending on the object):
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Filter

- Hide [object]
- Show only [object]
- Configure [objects] filter
- Toggle filter
- Clear filter
See  for information.Filters

Copy Advanced Info Copies the full name of an object

Read Data in SQL Console Opens an SQL console displaying the object`s data

Compare
- Appears only if you select several objects of the same level
- Opens the Compare objects wizard which guides you through the steps to generate a 
comparison report for the selected objects

Generate SQL

Opens a submenu on which you can select the type of SQL query to generate:
- SELECT
- INSERT
- UPDATE
- DELETE
- MERGE
- DDL
Clicking one of the items (for example INSERT) generates a relevant query in a separate 
window.

Export Table Data Opens the Data Transfer wizard that helps you select a format and export table data

Import Table Data
Opens a window with existing database connections in which you can select a table to import 
data from

Tools Opens a submenu that provides tools for database backup and restore, vacuum, etc.

For information on how to filter database objects in Database Navigator, please see the  Filter Database Objects
article.

While working in the , you can drag the desired object from the Database Navigator to the part of your SQL Editor
query. Please pay attention to the selected object name. Running the query immediately with the selected object 
will cause an error because only the selected part of the script is being executed and fails as it's not a complete 
query. An extra step to deselect it by clicking somewhere in the SQL Editor is required to remove the selection. 
Nevertheless, we cannot deselect the object name automatically after dragging. This action is needed when you 
drag and drop an object into a complex query or long script, and it would be difficult to track what and where 
exactly you've just dropped, and you can get an unexpected error. 

https://github.com/dbeaver/dbeaver/wiki/SQL-Editor
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In the  and  you can filter database objects to include or exclude some Database Navigator Database Object Editor
of them from the view. You can filter connections, schemas, tables, views, and procedures. A dots sign  (...)

next to the node`s name indicates that a filter is applied to its sub-nodes: 

There are several ways in which you can filter objects. One of the ways is to filter objects by the names of tables 
and views using the filter field above the tree of objects:

To filter objects by name, type the object name in the field. The tree dynamically updates to show connections
/containers/tables/views with that name. To reset the filter, click the Clear icon ( ) on the right end of the field.

You can select the types of filtering objects in the drop-down list on the right. And also use the filter only for active 
connections.

For multiple filtering use special symbols in the filter field - pipe ("|"), comma (","), or space between object names. 
You can also use an asterisk symbol to replace the part of the name.

Another way to filter objects is to use the  item on the context menu of a single object. To filter objects using Filter
the  menu, right-click the object, then click  on the context menu, and then click one of the items on the Filter Filter
submenu:

Filter 
submenu 
item

Description

Hide ‘[object 
name]’

Hides the current object while displaying the other ones

Show only 
‘[object 
name]’

Shows the current object while hiding the other ones

Toggle filter Inverts the filtering – shows hidden objects and vice versa

Clear filter Removes the filtering to display all objects

Filter Database Objects
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1.  

2.  

Configure 
[objects] filter

Appears only to the folder or parent nodes of database objects - like ‘Tables’, ‘Indexes’, etc. Allows the 
creation of a complex filter with multiple filtering criteria, see .Configure Filters

The third way of filtering is to use the  item on the context menu on several objects:Filter

Select several objects of the same type using Ctrl or Shift keys.

Right-click the selection, then click , and then choose one of the options on the submenu:Filter

Filter submenu item Description

Hide N objects Hides the selected objects while displaying the rest

Show only selected objects Shows the selected objects while hiding the rest

To reset such filters, right-click the parent (folder) node displaying the dots sign , and then click (...) Filter -> 
.Clear filter
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1.  

2.  

3.  

4.  

5.  

You can configure custom filters to filter database objects in the  and .Database Navigator Database Object Editor

To configure a custom filter:

In the Database Navigator, right-click the object and on the context menu click Filter -> Configure [objects] 
. In the Database Object editor, in the toolbar of the  tab, click the Filter settings button ( ). filter Properties

The Filtering window opens.

Select the  checkbox to activate the fields of the window.Enable

If you want the filter to apply to all objects of a certain type, for example to all schemes, click Show global filter
. Otherwise, the filter will apply only to the current object. NOTE: Once you apply the global filter, you cannot 
revert back to the local filer in the same window. To create a local filter, reopen the Filtering window, see Step 
1.

For objects that you want to show, click  next to the  field and then, in the field itself, enter the Add Include
name or combination of symbols to search. For objects that you want to hide, click  next to the  Add Exclude
field and then, in the field itself, enter the name or combination of symbols to search. NOTE: You can use 
masks with  and  to replace one or more symbols and  to replace one symbol in the search % * _

combination.

To remove one filtering combination, click the combination in the field and then click . To remove all Remove
combinations from either of the fields, click  next to the field.Clear

Configure Filters
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6.  

7.  

8.  

Once you set all filtering criteria, you can save a filter to use for other objects. To save the filter, in the Saved 
filter area, in the  field, enter the filter`s name and click .Name Save

You can also remove any of the saved filters. To remove a filter, in the  drop-down list, click the filter Name
name and then click .Remove

Click  to apply the filtering criteria. Otherwise, click .OK Cancel
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By default database navagator show all database objects including system objects, all schemas, tables, indexes, 
administrative and other utility objects.

If you want to change database navigator contentsm simolify or customize it then there are several options. There 
are 3 modes:

Simple - minimalistic view for people who mostly wotk with tables

Advanced - shows all database objects supported by DBeaver

Custom - manually customized view

When you change view mode you must recovvect to a database (because DBeaver will read different database 
metadata)

Shows only schemas and tables

Hides all system objects

Hides all utility objects

Hides all intermediate object folders

Shows all system objects

Hides all utility objects

Show all folders and all supported database objects

You can configure custom view by setting the following options:

Show system objects (e.g. system schema pg_catalog or SYSTEM)

Show utility objects (e.g. internal template databases needed for new database cvreation)

Show only schemas and tables. It hides all database objects except databases, schemas and tables in these 
schemas.

Hide folders. It hides all intermediate logical folders, e.g. "Tables", "Indexes", "Foreign keys". In shows folders 
contents instead. If there are multiole subfolders then it merges them into a single list.

Simple and Advanced View

Simple view

Advanced view

Custom view
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You might need to classify and group database connections into projects. Projects store objects related not to a 
particular database but to all database connections. These are usually files stored on the file system.

The Projects view displays all projects created in the system and provides tools to manage them. To open the 
Projects view, on the  menu, click  (or use  shortcut).Window Projects ALT+W+P

For information on how to change the view layout, please see the  article.Application Window Overview

The projects are organized into a tree and all have the same high-level structure:

Connections – repeat the content of the Database Navigator view for this project. You can perform the same 
actions over the objects of the databases as in the Database Navigator.

Bookmarks – contains bookmarks – shortcuts to database objects, see …

ER Diagrams - contains ER diagrams that you can drag-and-drop here from other folders

Scripts – contains scripts that you can drag-and-drop here from other folders

The Projects view provides a toolbar and View menu which contain generic items. Each object in the tree has its 
own context menu.

To open the view menu of the Projects view, click the View Menu button ( ) in the upper-right corner of the 
window. The view menu contains the following items:

Icon Item Description

Projects View
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Create Project Opens the Create Project wizard

Refresh Projects Refreshes the projects tree to display changes caused by creating modifying or deleting projects

Collapse All Collapses the tree to the root level

Link with editor
- Enabled when at least one editor is open, otherwise disabled
- Highlights the object in the tree that has its editor open

The toolbar is located in the title bar of the window, its buttons duplicate the view menu items except for the 
 one.Refresh Projects

To open the context menu for an object in the tree, right-click the object. For information about context menu items 
of all objects under the  node of the tree, please see . The context menus of other Connections Database Navigator
nodes in the tree contain some basic items for copy-pasting, renaming, deleting objects, managing their 
properties, creating folders, etc.

The  menu item (for a project root node) makes the project active, that is visible in the Set Active Project
Database Navigator.

The  and  menu items allow creating links to files and folders in the file Link File (SQL Script) Link Folder
system.

For information about managing projects, please see  article.Projects
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The Project Explorer view displays detailed contents of the currently active project. To open the Project Explorer, 
click .Window -> Project Explorer

For information on how to change the view layout, please see the  article.Application Window Overview

The title of the Project Explorer includes the name of the project: Project – [Project name].  is a project that General
initially exists in the system by default.

The Project Explorer displays the content of a project with metadata. The content includes: , Bookmarks ER 
, and . The metadata appears in columns which you can hide or show.Diagrams Scripts

The Project Explorer view provides a toolbar that contains the following buttons:

Button Name Description

Configure columns visibility Opens a dialog box in which you can select columns to display in the view

Collapse All Collapses the tree to the root level

Expand All Expands the tree nodes

Link with editor
- Enabled when at least one editor is open, otherwise disabled
- Highlights the object in the tree that has its editor open

To sort the metadata in the table by a certain column, click the column header.

Project Explorer
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Query Manager is a view that shows the history of all SQL queries that DBeaver has executed during the current 
session.

Note DBeaver saves query history after restarting only in , ,  and  editions.Lite Enterprise Ultimate Team

To open the Query Manager, do one of the following:

Click the arrow next to the  button in the toolbar and then click  on the Transaction Log Query Manager
dropdown menu:

On the  menu, click :Window Show View -> Query Manager

The Query Manager logs all queries together with their execution statistics (execution time, duration, number of 
fetched/updated rows, errors, etc.):

Query Manager

https://dbeaver.com/dbeaver-team-edition
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You can modify the look of the Query Manager by filtering queries and setting the number of entries displayed per 
page, as well as specifying some storage settings. See the ‘Query Manager Properties’ section below.

To erase all entries from the Query Manager, click the  button ( ) in the view`s toolbar. Clear query manager log
, you can also open  in the main menu and select In DBeaver PRO versions Help —> Clear History Query log 

 option. The query history will disappear after the restart.history

To manage the look of the Query Manager, filter the entries, and modify the storage settings, click the Set query 
 button ( ) in the view`s toolbar. The Properties for Query Manager window opens:manager filter

Query Manager Properties
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Select or clear the checkboxes in the  section to filter entries by object type. To filter entries by Object Types
query type, select clear the checkboxes in the  section.Query Types

To change the number of entries displayed per page, enter the new number in the  field.Entries per page

To set DBeaver to save the query log in a file, select the  checkbox and then specify the file Save log to file(s)
location in the  field.Log files folder

After you make all necessary changes to the settings, click  to apply the changes and keep the window open Apply
or click  to apply the changes and close the window. To discard all changes and return to the Apply and Close
previous state, click .Restore Defaults
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You can open the Background view from the main menu - click , then in the Show Window -> Show View -> Other
View window, expand the  folder, click  and then click :General Background Tasks Open

You can also open the Background Tasks view from some other views or editors by using a special button, for 
example from the  view.Search

The Background Tasks view shows the progress of such background tasks as search, SQL query execution, etc. 
The view shows data when background tasks take some noticeable time and is useful when you want to track the 
progress of lengthy operations. If you open this view at a short task, the view will be empty.

You can cancel the task in progress - click the  button ( ).Cancel Operation

Background Tasks



DBeaver User Guide 23.1. Page 29 of 526.

The Database object, or metadata editor is available for multiple database objects such as tables, views and 
schemas. To open the metadata editor for an object, in the  or in the  view:Database Navigator Projects

Double-click the database object

Click the database object and press  or Enter F4

The editor has three tabs:

Properties tab appears for all objects, contains properties of the database object and its sub-entities, see 
further in this article

Data tab appears for tables and views and represents the Data Editor

ER Diagram tab appears for tables and schemas and displays ERD (Entity Relation Diagrams), see ER 
 and Diagrams Database Structure Diagrams

The tabs have the following common parts:

The object's path shows the chain of all its parent entities. The entities are clickable: clicking an entity in the path, 
depending on its nature, either shows its children or opens an editor or a settings window.

The toolbar contains different tools on each of the three tabs.

An asterisk appears in the title of an editor if it contains unsaved changes:

The Database Object editor supports the  (undo) function.Ctrl+Z

Database Object Editor
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The Properties tab of the  provides you with the tools to view and edit the database object's Database Object Editor
properties.

The content area of the Properties tab falls into two parts: the top pane displays properties of the current database 
object itself while the bottom pane contains properties of the object's sub-entities or some complex properties like 
DDL (an SQL description of the current database object).

Properties of the sub-entities appear in the side tabbed editors – to open such an editor, click the tabs on the left 
side of the area:

The toolbar at the bottom of the editor provides the following tools for the majority of sub-entities except for some 
specific ones like Permissions (in PostreSQL) or SQL based views (DDL and Source):

Button Name Description

Search items
Displays a search field next to the button:
- Type in the search combination - the content updates dynamically
- To remove the filter, click the cross icon next to the search field

Filter settings Opens the Filtering window which allows setting a custom filter, see Configure Filters

Configure 
columns

Opens the Configure columns dialog box in which you can select the columns to display or 
hide in the current view

Refresh the 
selected items

Depending on the database type, refreshes either the current item or its parent or the whole 
database object – reloading data from the database

View Opens an editor/viewer for the item currently in focus

Properties Editor
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Create new 
[items]

Creates a new item of the same type as currently displayed in the open view, for example, a 
column

Delete database 
object

Deletes the item currently in focus

Save the current 
contents

- Same as the  button on the application main toolbarSave
- Same as Ctrl+S
- Opens the  window that allows saving changes in the currently open sub-Persist Changes
entity
NOTE: DBeaver recommends saving work after each change.

Revert to the last 
saved state

Reverts all changes made to the whole database object to the last saved state

Items in the tabbed editors have context menus which provide the same commands as those in the Database 
. To open a context menu for an item, right-click the item.Navigator

SQL script editors (  and ) of the Properties tab contain SQL script that you can either view or modify. DDL Source
The toolbar of the DDL and Source tabs provides the following tools:

Button Name Description

Load form file
- Allows selecting a file from the file system
- Disabled if the SQL code is read-only

Save to file Allows saving the current SQL code to a file

Open in SQL console Opens the SQL code in an SQL Editor

You can select parts of the SQL code and apply generic commands such as copy-paste or SQL-specific 
commands like formatting – using the context menu. To open the context menu, right-click the SQL code. See 

 for information about SQL-specific commands.SQL Editor

NOTE: , , and  menu items on the context menu are disabled if SQL Assist SQL Template SQL Context Information
the SQL script is read-only.

SQL Script Editors
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The Data editor appears:

As the  tab of the , which is only available for tables and views.Data Database Object Editor

As the  tab when you run a custom SQL query in Results SQL Editor

The Data editor allows the viewing and data editing of a database table or view. The central part of the Data editor 
is the data table. The editor also provides two toolbars and a filter field:

To learn how many rows the data table contains, click the  button in the bottom toolbar. Calculate total row count

The number of rows appears in a status field next to the button: 

To learn about ways to navigate data in the data table, see  article.Navigation

The top toolbar contains the following buttons:

Button Name Description

Apply filter criteria
Applies filter criteria entered in the filter field above the data table, see  article Data Filters
for more information

Remove all filters
/orderings

Removes all filters and orderings applied to the data

Save filter settings for 
current object

Saves the current filter settings for the database object to apply next time when you 
reopen it in the editor, see details in the  articleData Filters

Custom Filters Opens the Result Set Order/Filter Settings window, see article for more information

Configure auto-refresh Allows configuring data auto-refresh settings, see  article for detailsData Refresh

Forward and 
backward - history 
navigation buttons

Navigate forward and backward in the Data Editor history, see  section of History
 article for more information. The buttons are equivalent to pressing the key Navigation

combinations:  (backward) and  (forward).Alt+Left Alt+right

Data Editor
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The side bar contains the following tabs:

Button Name Description Chart_button

Grid Switches to grid view of data

Text Switches to plain text view of data

Chart Switches to chart view. For more details on charts, see the  article.Managing Charts

Record
- Same as pressing Tab
- Switches the positions of rows and columns so that the columns appear as rows, and the rows hide in 
one  column, see details in the  section of the article.Value Table vs. Record Views

The bottom toolbar provides the following buttons:

Button Name Description

Save
Saves all unsaved changes to the data such as adding, duplicating, deleting rows, inline 
editing of values, see  article for informationthe Data Viewing and Editing

Cancel Discards all unsaved changes to the data

Script
Opens the Preview Changes window in which you can see changes that you have made to 
the data, see details in the  articleData Viewing and Editing

Edit cell value in 
separate dialog
/editor

Opens the cell in focus for editing in a separate editor or dialog box, see details in the Cell 
 section of the  articleEditor Data Viewing and Editing

Add new row
Adds a new empty row below the current row, see details in the Adding, Copying and 

 section of the  articleDeleting Rows Data Viewing and Editing

Duplicate current 
row

Copies the current rows and pastes the copy below the current row, see details in Adding, 
 section of  articleCopying and Deleting Rows Data Viewing and Editing

Delete current row
Colors the rows in focus in red to mark them for deletion, see details in the Adding, 

 section of the  articleCopying and Deleting Rows Data Viewing and Editing

Move to first row Moves the focus (highlighting) from the current to the first row of the table

Move to previous 
row

Moves the focus (highlighting) from the current to the previous row of the table

Move to next row Moves the focus (highlighting) from the current to the next row of the table

Move to last row Moves the focus (highlighting) from the current to the last row of the table

Fetch next page of 
results

Fetches the next portion of data (next N rows) making it ready for display, see Scrolling 
 section of  article for more informationResults Page Navigation

Fetch all rows
Fetches the whole result set making it ready for display, see the  Scrolling Results Page
section of the  article for more informationNavigation

Panels Opens panels on the right side of the Data Editor, see the  for informationPanels

Configure Opens a dropdown menu with settings

JSON
- Available in EE version only for MongoDB documents and JSON tables
- Switches to JSON view of data

XML
- Available in EE version only for XML tables
- Switches to XML view of data

Generate Mock 
Data

Available in EE version only. Opens the  windowMock Data Generator
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Rows count details Opens the Status details dialog box showing the timing details of fetching table rows

Calculate total row 
count

Calculates the total number of rows in the table

NOTE: Some of these buttons may be disabled and may not work if you are using a read-only connection, 
connecting to a read-only database or if you see the result of a complex query, such as joining two or more tables.

Every cell in the data table has a context menu – right-click the cell to open the menu. The context menu provides 
the following items:

Menu Item Description

Cut Cuts the content of the current cell or column to the clipboard

Copy Copies the content of the current cell or column to the clipboard

Advanced 
Copy

Opens advanced copy submenu that allows copying data with preset formatting parameters

Paste Pastes the copied content to the cells in focus

Advanced 
Paste

Pastes several values delimited with a tabulation or line break

Delete
Deletes the row that has the cell in focus
NOTE: In fact, when users click , the system only highlights the red row while the actual deletion happens Delete
when users click .Save

Edit cell
- For CLOB/BLOB data format, opens the contents of the cell in a new tab
- For all formats except CLOB/BLOB, opens a properties window for the cell

Inline edit
- Same as double-click on a cell
- Makes the cell editable

Set to 
NULL

Sets the value of selected cells to NULL

Hide 
column

Hides the column currently in focus, see the Managing Display of Columns in Data Table section further in this 
article

Save to 
file…

- Appears only for columns with BLOB/CLOB data
- Opens the standard Save As window that allows saving data contained in the cell to a file

Load 
from file…

- Appears only for columns with BLOB/CLOB data
- Opens a standard window for opening files

Order
/Filter

Displays a submenu that allows selecting filter criteria for the data. The submenu contains the most common 
filters that can be applied to the cell in focus – see details in .Data Filters article
By default, DBeaver filters data by sending a request to the server (the Server-side results ordering checkbox 
selected). To filter data on the client side using DBeaver`s internal algorithm, clear the checkbox.

View
/Format

Opens a submenu that provides tools for formatting and modifying the view of data, see Data View and Format

Navigate Opens a submenu that helps users navigate throughout the data table, see Navigation

Layout Changes the layout of data, see the  section of the  articleTable vs. Record Views Data View and Format

Export 
Resultset

Opens the Data Transfer wizard that guides you through the steps to select a format and export data
NOTE: The system exports the whole result set including records that are not visible on the screen and 
preserves all applied data filters and ordering.

Generate 
SQL

Opens a submenu on which you can select the type of SQL query to generate
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Refresh Refreshes the whole results set including all items that are not visible on the screen

For more information about using the Data Editor, please see the subsections of this article - open them via the 
contents tree on the right.



DBeaver User Guide 23.1. Page 36 of 526.

If the result set has many rows, you can scroll the results page. To learn how many rows the data table contains, 
click the  button in the bottom toolbar. The number of rows appears in a status field next Calculate total row count

to the button: . Alternatively, you can right-click a cell in the table and then click  Navigate -> Row Count
on the context menu.

By default, DBeaver limits the number of rows fetched to  (you can change this value in the main toolbar or in 200
preferences). The maximum number of rows that DBeaver fetches to display in the Data tab is specified in the 

Maximum result-set size field in the main toolbar: `

Once you scroll to the last row of the current result portion, DBeaver fetches the next portion (next N rows). You 
can disable this behavior in preferences. You can also manually fetch the next portion of data equal to the 

maximum result set size. To do so, click the  button ( ) in the bottom toolbar or right-Fetch next page of results
click the table and click  on the context menu.Navigate -> Fetch next page

The number of rows fetched is visible in the status field under the data table: 

To see the details, click the details button in the status field.

To fetch the whole result set, click the  button ( ) in the bottom toolbar or right-click the table and Fetch all rows
click  on the context menu.Navigate -> Fetch All Data

NOTE: Be careful when fetching the whole result set. If it is huge, it might cause program hangup or out-of-
memory errors.

You can navigate through the result set using standard shortcuts , , , , , Home End PgUp PgDown Ctrl+Home Ctrl+End
.

To jump to the first or last row or move one row forward or backward, use the navigation buttons in the bottom 

toolbar or on the context menu: 

Navigation

Scrolling Results Page

Data Rows
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To jump to a specific line, right-click anywhere in the table and click  ->  on the context menu. Navigate Go to Line
Then in the Go to Row dialog box, enter the row number and click .OK

DBeaver remembers the history of actions such as applying filters to data, opening reference tables and other 
tables via links. You can navigate among such tables and filtered views:

Use the forward and backward buttons in the top toolbar: 

Click  or Ctrl+Left Ctrl+Right

Hovering over these buttons displays the names of the tables or filtered views saved in the history.

You can navigate with foreign keys or reference tables – those that reference the current table. To open a 
referencing table, press  or right-click the cell and click :Ctrl+1 Navigate->Referencing tables->[table name]

The referencing table opens in the same editor. To navigate back and forth between the initial and referencing 
tables, use the history navigation buttons ( ) in the top toolbar of the editor. In order to open a referencing 
table in a new window use the  shortcut to the show menu.Ctrl+Shift+1

In the data editor, you can navigate to linked tables – the ones that the current table references. To open a linked 
table, click the Navigate link icon in a cell that contains it:

Another way is to right-click such a cell and click  on the context menu. The linked table Navigate -> Navigate link
opens in the same editor, filtered by the cell value:

NOTE: The table name in green above the table indicates which table is currently open in the editor.

History

Navigate Foreign Keys / Referencing Tables

Navigation Links
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To navigate back and forth between the initial and linked tables, use the history navigation buttons ( ) in the 
top toolbar of the editor.
You can open a linked table in a separate editor. To do so, simultaneously hold the  key (or  Ctrl # command
key on macOS) and click the Navigate link icon ( ) in the cell.
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You can switch between two data presentations in SE version and four presentations in EE version. Pressing CTRL+~
switches available presentations in turn.

To see the data in a grid view, similar to an Excel spreadsheet, click the  button ( ) on the bottom Grid
toolbar of the editor.

To switch to the plain text view, click  ( ) on the bottom toolbar.Text

To switch to JSON view (available in EE version only for MongoDB documents and JSON tables), click  JSON
on the toolbar.

To switch to XML view (available in EE version only for XML tables), click  on the toolbar.XML

The table view is a standard table (Excel-like) in which columns are vertical and rows are horizontal. This view is 

the default one. If you click the  button in the bottom toolbar of the editor ( ), or press , or Record Tab
right-click a cell and then click  on the context menu, the rows and columns switch positions. The Layout -> Record
columns will appear as rows, and the rows will be hidden in one  column which will show only one row of Value
data. The column headers will shift from the top of the table to its left side: 

The Record view is useful if the table contains a big number of columns. To navigate from row to row of data, use 

the navigation buttons on the bottom toolbar of the editor: 

To return back to the standard table view, click the  button again.Record

In the data editor, you can colour all rows that have the same value as a particular cell of a certain column. To do 
so, right-click the cell and click  #  on View/Format Set the row colour for {column name = value}
the context menu:

Data View and Format

Grid vs. Plain Text Views

Table vs. Record Views

Rows Coloring
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Then choose the colour in the palette window that appears and click . The current row and all other rows that OK
contain the same value change their colour to the one you have selected:

To remove the coloring by a particular column, right-click the cell again and click  # View/Format Clear colour for {column name = value}
on the context menu.

By choosing  #  from the context menu, you can gain more precise control of View/Format Row colors ...
coloring conditions:
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Here, you can define multiple conditions for single column using rich set of predefined operators, change 
background color and define a range between two values.

Operators work as you may expect. Note that they're executed on the client-side, that means no extra queries are 
made in order to apply colors.

Value range allows you to paint your rows with gradient that fades from first value to second value:

In this example we defined a range for column  that fades from  to  between values  AlbumId #80c6ff #8000ff 1

and .10

You can use regular expressions for matching complex values. Otherwise, you can be artistic and, for example, 
paint rows with odd values in your favorite color:

Snippet for coloring odd rows: ; even rows: ^\d*[13579]$ ^\d*[02468]$

Value range / Gradient

Using regex

Coloring by Data Types
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Besides colouring rows by a value, you can colour the values in the columns by data types. To do so, right-click 
any cell in the table and, on the context menu, click . The values in the cells View/Format -> Colourize Data Types
will be coloured in different colours according to the current colour preferences:

You can change the colour preferences in the Preferences window by: clicking  on the Window -> Preferences
main menu. In the window of the navigation pane on the left, expand  and then , and User Interface Appearance
then click :Colours and Fonts

To remove the colouring by data types, on the context menu, click  again.View/Format -> Colourize Data Types

For string and numeric data types, DBeaver provides tools to transform the data presentation into a number of 
formats, such as URL and Binary for strings and Epoch Time, Number Radix, etc. for numbers. To change the 

Transforming Data Presentation
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data presentation in a certain column, right-click a cell in the column. Then, on the context menu, click View
 and click the presentation type name:/Format -> Set {column name} format

The Transformer settings window opens showing the value in the chosen format. Click  to apply the change:OK

The values in the column appear in the new format.
NOTE: For URL format, the resulting cell provides a link to the URL in a browser window.

To roll back the changes to the default format, right-click any cell in the column, and on the context menu, click 
.View/Format -> View as -> Default

For complex data types (that themselves represent a structure), such as objects, structures and arrays, DBeaver 
provides a tool for breaking them into columns:

To do so, right-click a cell in the column and, on the context menu, click View/Format -> Visualize complex 
.columns

Structurizing Complex Data Types
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You can specify the exact format of Time, Timestamp, Date, and Number data used in the currently open 
database or globally. To specify a format, right-click any cell in the table and, on the context menu, click View

. The Properties window opens displaying the  page:/Format -> Data formats Data Formats

To configure only the format for the current database, select the  Datasource "[Connection name]" settings
checkbox. To configure the settings globally, to all databases that you have in DBeaver, click .Global settings
You can specify the locale for the data format in the  area. In the  dropdown list, click the name of the Locale Type
data type and in the  table, click the required format.Settings
To apply the changes and make them visible in the table, click  and then refresh the window (Apply and Close F5
).

Configuring Numeric and Time Data Formats

Configuring Boolean presentation
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1.  

2.  

3.  

4.  

You can choose between two presentation modes :1

Text-based

Icon-based

This is the most customizable mode. You can:

Change  under  column.labels Label

Otherwise, you can use presets available in Drop-down Menu 2

Change  of value inside grid cell.alignment 3

Following variants are available: , , and left center right

Change  of value using color picker under  column .color Color 4

You can reset color to match current theme's contrast color in  #  # Drop-down Menu 2 Colors Use theme default color

Change font  in  # .style Drop-down Menu 2 Styles
Following variants are available: normal, , and bold italic

Text-based presentation
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This presentation only supports alignment changing.

Icon-based presentation
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You can apply custom filters to table contents or query results. There are several ways in which you can filter data 
in the table.

One of the ways is to use the filter field above the table next to the top toolbar. To filter data, enter an SQL 

expression into the field and click the Apply filter criteria button ( ) next to the field or press .Enter

You can apply ready-to-use SQL expressions or SQL expression templates via the context menu. To select a 
ready SQL expression or a template, press  or right-click the cell, then click  on the context menu F11 Order/Filter
and then click one of the expressions.

The third way is to filter data by a cell value using the filter icon in the column header. To filter data this way, click 
the filter icon in the column header and then double-click the cell value in the Filter by the column value dialog box:

Data Filters
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The data updates dynamically. To remove a filter, click the Remove All Filters/Orderings button ( ) in the top 
toolbar of the editor.

You can save the current filter settings for the database object to apply the next time you reopen it in the editor. To 

save the current filter settings, click the Save filter settings for current object button ( ) in the top toolbar.

The main tool for managing the appearance of the data table is the Result Set Order/Filter Settings window.

To open this window, click the Custom Filters button ( ) in the top toolbar of the editor or click the Configure 

button ( ) and then click  on the dropdown menu.Order/Filter

The Result Set Order/Filter Settings window provides tools to:

Advanced filters configuration
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1.  

2.  

Order data inside columns

Manage the display of columns in the table

Manage the order of columns in the table

Filter data in the table using an SQL expression

Another tool for managing the data appearance is the column headers. In the data table, every column header 
contains three elements which each has its own function: Data (column) type icon, column name, filter icon, and 
ordering icon.

By simply clicking the column name or column type, the icon highlights the whole column.

You can click the column type icon and then drag and drop the column to a different position in the table.

You can click the column name and then drag the cursor to the right or left to highlight multiple columns.

Clicking the ordering icon allows you to order the data in the column in ascending or descending order - see 
the 'Ordering Data in Columns' section, further in this article

Clicking the filter icon allows you to filter the data by a cell value, see [TBA]

You can order data in columns in one of the following ways:

Click the ordering icon ( ) in the header of the column.

The icon has three states:

Clicking once establishes ascending order ( )

Clicking a second time changes the order to descending ( )

Clicking a third time removes the ordering from the column ( )

To order data by several columns, go column by column, setting the order with the Ordering icon, starting from the 
column by which you want to order data first.

Click the Custom Filters button ( ) in the top toolbar of the editor to open the Result Set Order/Filter Settings 
window (see above):

a) Next to the column by which you want to order data in the first turn, set the ascending or descending order 
using the same three-state principle as described above.
b) Set the ordering in other columns by which you want to sort the data in the second, third, etc. turn. The 

Ordering Data in Columns
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1.  

2.  

1.  

2.  

3.  

 column indicates the order in which the sorting will happen.Order
NOTE: The number ( ) column indicates the initial order of columns.#

c) To easily move the ordering setting from column to column, you can use the Move up/down/to top/to 

bottom/ buttons: 

To reset the data ordering to its initial state, click the Reset button ( ) in the same window.

Also, to remove all ordering settings, click the Remove All Filters/Orderings button ( ) in the top toolbar of the 
Data Editor.

To hide a single column, right-click the column or any cell in it and click  on the View/Format -> Hide column
context menu. To unhide a hidden column, open the Result Set Order/Filter Settings window (see the image at the 

beginning of this article) and select the checkbox next to the column name, or click the Reset button ( ).

To display or hide columns in the data table, in the Result Set Order/Filter Settings window:

Select the checkboxes next to the columns that you want to see in the table and clear the checkboxes next to 
those that you want to hide.

Use the Show All ( ) and Show None ( ) buttons at the bottom of the window.

You can modify the order of columns in the data table in two ways:

Click the icon in the column header and drag-and-drop the column to a new position.

To sort the column alphabetically, in the Result Set Order/Filter Settings window (open by clicking the Custom 

Filters button ( ) in the top toolbar of the editor), click the Sort button ( )

In the Result Set Order/Filter Settings window, click the column to set the focus to it and then move it using 

the navigation buttons: ( )

Managing Display of Columns in Data Table

Sorting Columns in Data Table
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In the bottom left part of the Data editor, you can find the toolbar with actions: 

Refreshing is necessary if the database contains changes made by other users working on it simultaneously with 
you, and you want to see them in your DBeaver window. To refresh data manually, right-click anywhere in the data 

table and click  on the context menu or press .F5

You can also schedule auto-refresh to happen regularly. To auto-refresh the database on schedule:

Click on the arrow in the auto-refresh button . Now you can configure auto refresh in the two 
following ways:

You can select via choosing an available predetermined period in the context menu.

You can set your time duration between refreshes. To do that, select .The Auto-refresh configuration 
dialog box will open:

Data Refresh

Autorefresh

1. Use a predetermined duration

2. Set your duration
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a) Set  in seconds.Interval
b) Select the  checkbox if you want the refresh to stop when it encounters an error or clear it if Stop on error
the refresh should ignore mistakes.
c) Click .OK

When you perform either of these two alternative options above, the system starts refreshing the data as 

scheduled, and the Configure auto-refresh button changes to the  button . To Stop auto-refresh
stop the auto-refresh, click the  button or the arrow next to it and click  on the auto-refresh Stop auto-refresh Stop
menu.
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You can do inline editing (see the  section below) as well as open the content of a cell in a separate Inline Editing
editor (see the  section below).Cell Editor

When you make any changes to the data and save them using the steps described in this section, the changes will 
apply to the database itself. Prior to saving the changes, you can preview the SQL script that the system sends to 
the database to apply the changes there. To see the SQL script, after making changes and before saving or 

discarding them, click the  button ( ) in the bottom toolbar. The Preview Changes window opens, in Script
which you can only view the SQL script and copy it, if necessary:

Inline editing is when you modify the content right in the cell. To edit a cell inline, in the table do one of the 
following:

Double-click the cell.

Click the cell to set focus to it and press .Enter

Right-click the cell and click  on the context menu.Inline edit

The cell is now editable and you can change its value.

To set the cell value to NULL, right-click the cell and click  on the context menu.Set to NULL

To save the changes, click the  button ( ) in the bottom toolbar. To discard the changes, click the Save

 button ( ) in the bottom toolbar.Cancel

NOTE: Both the  and l buttons become editable only when you make changes in a cell and then jump Save Cance
to another cell.

To edit data in a cell using a separate editor, do one of the following:

Data Viewing and Editing

Inline Editing

Cell Editor
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Right-click the cell and click  on the context menu.Edit cell

Click the cell to set focus to it and press  or click the  Shift+Enter Edit cell value in separate dialog/editor

button ( ) in the bottom toolbar.

For cells of CLOB/BLOB data format, this action opens the contents of the cell in a new tab. For all other formats 
except CLOB/BLOB, this action opens a properties window for the cell:

The window displays properties of the column in the  section and provides the  section where Column Info Value
you can modify the value of the cell. Edit the value as required and click . To set the value to NULL, click Save Set 

. To continue editing the cell in a separate editor (tab), click .NULL Open Editor

NOTE: DBeaver has full support of CLOB/BLOB data types. You can view values, edit them, and save them back 
to the database. You can open CLOB/BLOB value in a separate editor (press  on a selected cell). Shift+Enter
You can save/load LOB value to/from regular files. DBeaver can recognize that some BLOB column keeps images 
(gif, png, jpeg, bmp). In this case DBeaver shows LOB contents as an image. It is convenient to open the value 
view panel (press ) and browse images.F7

Adding, Copying and Deleting Rows
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You can add an empty row below the row in focus. To add an empty row, click the  button ( ) on Add new row
the bottom toolbar. Use inline editing or open the cell values in a separate editor to populate them with data (see 
the sections above).

You can copy any row or several rows currently in focus. To copy rows, highlight one or more rows and click the 

 button ( ) in the bottom toolbar. The duplicate rows appear below the rows in focus.Duplicate current row

To delete a row or rows, set the focus to the rows and click the  button ( ) in the bottom Delete current row
toolbar. The rows are coloured red, which means that they are marked for deletion and will be deleted when you 
save the changes.

To save any such changes, click the  button ( ) on the bottom toolbar. To discard the changes, click Save

the  button ( ) on the bottom toolbar.Cancel

NOTE: Some of these buttons may be disabled and may not work if you are using a read-only connection, 
connecting to a read-only database or if you see the result of a complex query, such as joining two or more tables.

To copy the content of one or several cells to the clipboard in the TAB-delimited format, press  or right-Ctrl+C
click the cell or cell selection and click  on the context menu. Then you can paste the copied selection into a Copy
spreadsheet editor (similar to Excel).

DBeaver provides the advanced copy option that allows configuring additional copy settings (copy with column 
names/row numbers, configure delimiter and choose value format). To copy cells with additional settings, press Ctrl+Shift+C
or right click the cell(s) and click  on the context menu.Advanced Copy

Pressing  on a cell pastes the copied content into the cell applying appropriate data type conversion. The Ctrl+V
 option on the context menu or pressing  pastes several cells.Advanced Paste Ctrl+Shift+V

To be able to save column value changes, a table must have some unique key (primary key or unique index). 
Some databases (Oracle, DB2, PostgreSQL) support a special virtual unique column that DBeaver can use to 
save changes. In other cases, you can define a virtual key – a set of columns that forms a unique combination of 
values. When you try to save changes in a table without a unique key, DBeaver displays the following error 
message:

Copying/Pasting Cells

Defining Virtual Keys
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To use all columns as the virtual key, click . To create a custom key, click . Use All Columns Custom Unique Key

Alternatively, to create a unique custom key, you can click the  ( ) button on the bottom toolbar and Configure
then click  on the Configure menu. The Define virtual unique identifier window opens:Define virtual unique key

To define the key, select some of the columns or click  and then click . To remove a unique key from Select All OK
a table, click the  button in the bottom toolbar and then click .Configure Clear virtual unique key
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Panels provide additional space in the  in which you can manipulate data. The panels are handy if you Data editor
work with complex types (structures, arrays), long text data, or BLOBs. Panels appear as tabs in an additional 
pane in the right hand side of the Data tab:

This additional pane appears only when you open one of the four panels:

Calc

Grouping

Metadata

Value viewer (default)

To open the panels, click  on the bottom toolbar. By default, the Value viewer panel opens. Alternatively, Panels
you can open the Value panel by pressing  on a cell. To open the other panels, click the down arrow next to F7
the  button and click the name of the panel on the menu:Panels

Panels
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Panels will also open if you try to inline-edit a cell with a complex data type.

To close the panels, click the  button again or click the standard Close (cross) icon in the upper right corner Panels
of each panel.

You can also show and hide panels by clicking the  button ( ) on the bottom toolbar and then Configure Toggle 
 on the Configure dropdown menu.result panels

The Value viewer panel displays just one value that is currently in focus and allows editing.

The toolbar of the Value panel contains the following buttons:

Value Viewer
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Button Name Description

Content 
viewer 
settings

Opens a menu with a set of options for content view change.

Save to 
file...

Allows saving the content to a local file. : This button is only available for XML, JSON and Binary NOTE
content.

Load 
from 
file...

Allows uploading data from a local file. : This button is only available for XML,JSON and Binary NOTE
content.

Apply 
cell 
value

Displays the data table changes in the Value viewer. : This button does not save changes made NOTE
to the database. To save the changes in the database, you need to use the  button on the bottom Save
toolbar of the ..Data Editor

Auto-
apply 
value

Еnables the automatic display of changes made in the Value viewer in the data table. When auto-
saving is enabled, the changes appear in the data table at the same time when they are made in the 
Value viewer. : This button does not save changes made to the database. To save the changes in NOTE
the database, you need to use the  button on the bottom toolbar of the .Save Data Editor

The Metadata panel displays metadata for each cell in the row containing the cell currently in focus. You can just 
view the metadata.

The Calc panel is useful for getting basic statistics across data in several columns and rows:

Metadata Panel

Calc Panel
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You can select several columns and rows in standard ways - by pressing and holding the left mouse button or by 
clicking cells while holding the  or  keys. The panel updates dynamically to show statistics for the Ctrl Shift
selected data.

To see the data grouped by columns, click the Group by columns button ( ). To remove the grouping by 
columns and see the summary values for all columns, click the same button again.

By default, the panel applies and displays results for two functions –  and . To add other Count Count Distinct

functions, click the  ( ) button on the toolbar of the panel or right-click one of the rows in the Add function
Aggregate panel and click  on the context menu and then click the name of the function. The following Add function
functions are available:

Sum

Average

Minimum

Maximum

Median

Mode

To remove an individual function, click the function and then click  ( ) on the toolbar of the Remove function
panel, or right-click the function and click  on the context menu. To remove all functions, click Remove function

 ( ) on the toolbar or on the context menu.Reset
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You can copy the value of a particular function to the clipboard - right-click the row and click  on the Copy Value
context menu.
You can also copy all functions with their values - right-click in the table and click  on the context menu.Copy All

The Grouping panel provides tools to calculate statistics based on a table of a custom SQL query. It uses GROUP 
BY queries to extract unique values for COUNT (default), SUM, AVG, MIN, MAX and other analytics functions 
displaying the results in dedicated columns.
To obtain the grouping results for one or more columns of a data table, open the Grouping panel, then, in the 
results table, put the cursor onto the data type icon of the table header so that the cursor turns into a hand pointer (

), and drag-n-drop the column(s) into the panel:

If you add several columns to the panel, DBeaver groups data in the order in which the columns go and calculates 
statistics based on the grouping.

Grouping Panel
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1.  

2.  

3.  

By default, the COUNT function is used. You can add other functions as well. To add a function:

Click the  button on the panel`s toolbar.Edit grouping columns

In the Grouping Configuration window, in the  area, click , then type the function into the new Functions Add
row:

You can use the auto-complete options DBeaver provides.

You need to indicate the column name in brackets. COUNT is the only function that supports  instead *

of the column name.

Click :OK
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1.  

2.  

To remove a function, in the same Grouping Configuration window, click the function and click  and then Remove
. To remove all functions, click  and then .OK Clear OK

You can also add or remove columns using the same Grouping Configuration window. To add a column:

Click the  button on the panel`s toolbar.Edit grouping columns

In the Grouping Configuration window, in the  area, click , then type the column name into the Columns Add
new row (you can use auto-complete options DBeaver provides), and then click :OK
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For MySQL/MariaDB databases you can also add a column with an expression - the expression will be calculated 
in the resulting column:

To remove a column, in the Grouping Configuration window, in the  area, click the column name, then Columns
 and . To remove all columns, click  and .Remove OK Clear OK

Another way to remove a column is to click the column and then the  button ( ) in the Remove grouping column

panel`s toolbar. Clicking the  button ( ) removes all results from the Grouping panel.Clear grouping

The references panel allows you to see all the related information for the chosen row from other connected tables. 
The information is presented in an additional data viewer window, filtered to show the information related to the 
currently selected row. If a table opened in data viewer has a foreign key referencing another table, or it is 
referenced with a foreign key by another table, all of those connected tables can be picked from a dropdown list.

References panel
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When a table that is referenced by a foreign key in the current table is chosen, the information from the row 
corresponding to a referenced key will be shown, in this situation the record mode is enabled by default, but it can 
be turned off like in a normal data viewer.

When a table that references the current table is chosen, the references panel will show all the rows that refer a 
selected primary key in the current table.
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Note: This feature is available in , ,  and  editions only.Lite Enterprise Ultimate Team

The default grid view of the query resulting data is not very impressive, especially to business analysts and other 
users. The  feature lets you quickly and easily turn your SELECT queries' output into a colorized bar chart.Charts

You can easily visualize your data by creating a chart bar both in  and .SQL Editor Data Editor

Visual representation of vast data permits the analytical reasoning process to become faster and more focused. 
Charts make it easy for analysts to perceive salient aspects of their data quickly.

To build a bar chart in the , press the  button  on the left vertical toolbar of the query results SQL Editor Charts
area.

Managing Charts

Creating Charts In SQL Editor

https://dbeaver.com/dbeaver-team-edition
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A bar chart will be created.
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Charts can be very helpful for visualizing structured analytical data stored as , for example.Views

You can also create a chart for any table but you have to structure its data by first sorting and applying various 
filters to its columns. All the structural changes you make will then affect the chart you build. This way you can 
adjust the chart representation to the desired one.

To build a chart in the , press the  button  in the left vertical toolbar.Data Editor Charts

Creating Charts In Data Editor
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А bar chart will be created.

Note, that by default, the data for axis Y is taken from the first column of the table containing numeric values.
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An analytical tool such as the  also supports the  feature. In a chart built for a table Grouping Panel Charts
containing the grouping results for one or more columns of a data table, you can easily change axis X and axis Y 
source data by switching the columns in the .Charts Editor

To build a chart in the , press the  button  on the left vertical toolbar.Grouping Panel Charts

To edit the chart settings select the  option in the chart's context menu and the  will appear.Charts... Chart Editor

Creating Charts In Grouping Panel

Editing Chart Settings
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1.  

2.  

1.  

2.  

The following chart settings can be adjusted:

In the  drop down list of available columns select a column whose data will be used on axis X of the Column
bar chart. Make sure you choose unique columns for X axis.

Define a user-friendly axis name in the  text field.Label

In the  drop down list of available columns, select a column whose data will be used on axis Y of the Column
bar chart. , that only columns containing numeric data can be used for axis Y.Note

Define a user-friendly axis name in the  text field.Label

You can also set the following chart options:

Sample count - maximum number of columns used for building a chart;

Row count - maximum number of rows used for building a chart;

Setting Axis X

Setting Axis Y

Setting Other Options
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Sample function - an aggregate function where the values of multiple rows are grouped together to form a 
single summary value displayed on axis Y.

The following sample functions are supported:

Name Description

AVG Average value

SUM The sum of all values

FIRST The first value

LAST The last value

COUNT Total count of all values

You can copy a chart to a clipboard by selecting the  option in the chart's context menu.Copy to clipboard

You can export а chart into PNG format by selecting the  option in the chart's context menu.Save as...

You can print а chart by selecting the  option in the chart's context menu.Print...

Copying to clipboard

Exporting Charts

Printing Charts
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To search for data in the result set, press . The standard Find/Replace search dialog box will open:CTRL+F

You can also use the Find and Replace feature.

NOTE: The system searches only in already fetched rows.

Setting Description

Case 
sensitive

By default, the search is case insensitive.

Whole word
By default, the word specified in the search field can be found in the case when the word is part of another 
word. Enabling this setting will lead to a particular word search.

Regular 
expressions

Enable to use regular expressions in the search. In the search field, you can use  for Ctrl+Space
autocomplete regular expressions templates.

Wrap 
search

Enable this setting to find matches throughout the object from the beginning, and not only from the focus point 
to the end of the object.

Incremental Matches are found incrementally as you type, if this setting enabled.

Data Search
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1.  

Data transfer is a crucial feature that enables you to export and import data in various formats and even move 
data between tables in the same or different databases.

Export data

Import data

Importing from CSV

Importing from Excel

Importing from XML

Importing from database table

Note: The data transfer operation runs in the background, allowing you to continue working with your database 
during the export or import. However, try to avoid changing data in tables selected for export or import until the 
process is complete.

You can transfer data from one database to another or export it in different types and formats:

CSV

XLSX  (Excel spreadsheet)

HTML

XML

TXT

JSON

Markdown  files

SQL  statements

Source code arrays

The process of exporting data follows a similar procedure for the supported formats. Therefore, in this guide, we 
will focus on the data export process using the  format.CSV

Select a table or tables you want to export. In the context menu, choose .Export Data
: you can also export data from custom SQL query results. To do that, choose  in the results Note Export data

context menu.

Data export/import

Export data
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2.  

3.  

In the window that appears, choose  and click .CSV Next

Set data extraction options (how the data will be read from the tables). This may affect the extraction's 
performance. And set the export format option. They are specific to the data format you chose in step 2:
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4.  Set options for output files or clipboards. : Timestamp pattern is used here to target the file name pattern:Note
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5.  Review what you want to format and which format you will export. You can also save all your settings as a 
task in this step or change the task variables:
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6.  

1.  

Press finish. See extraction progress. You can keep working with your database during the export process as 
the extraction will be performed in the background.

You can import data to your database from , , and  files.CSV XLSX XML

Select one or more tables to which you want to import data. In the context menu, choose :Import Data

Import data

Importing data from CSV file
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2.  

3.  

In the window that appears, choose  and click .CSV Next

Select the input  file for each table you want to import, and you can change the Importer settings (format CSV

specific) at this step:
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4.  Set CSV-to-table mappings. You must set a column in the  file for each database table column. You can CSV

skip columns (the value will be set to  in the target table column). You can set constant values for the NULL

table column if there is no source column in the .CSV
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5.  Set options for loading data in the database. These options may affect the loading's performance:
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6.  

Read our guide on  to learn more about the replacing method option.Data Import and Replace

Review which file(s) and to which table(s) you will import. You can also save all your settings as a task in this 
step:
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7.  Press finish. See extraction progress. You can keep working with your database during the export process as 
the data loading will be performed in the background. In the end, you will see the status message:

1) Choose the database table (or tables) you want to import data into. Do this by right-clicking on the table name in 
the  section and then clicking on .Database Navigator Import Data

Importing data from Excel file
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2) In the window that appears, choose  and click .XLSX Next

3) In the following window, choose the file that contains the data you wish to import into the table. Select the 
appropriate settings described below, then click .Next
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Setting 
name

Description

Header 
position

Determines the location of the column names in the Excel table, either at the top or none. This setting specifies 
whether the column names are located in the first row of the Excel table or if there are no column names present.

Skip 
empty 
roes

If this setting is enabled, any open string values encountered during the data processing will be ignored and not 
inserted into the corresponding cells in the row. If the setting is disabled, all cells in the row will be filled with a 

 value if an empty string is encountered.NULL

Import all 
sheets

Specifies that all sheets in the file should be imported during the data import process.

Specific 
sheet 
name

Enables you to choose a particular sheet from the Excel file for importing during the data transfer process.

Date/time 
format

Use this setting to specify the date format used in the  file. This is used to clarify the date format during the XLSX

import process and does not affect the output data. You can refer to the  documentation java DateTimeFormatter
for details on the format pattern syntax.

Timezone 
ID

The local machine timezone is used by default. There are three ways to specify the timezone: 
1) Local zone offset: Specify the offset from UTC in the format of either a positive or negative number (e.g., +3, 
-04:30). 
2) Specific zone offset: Specify the offset from GMT or UTC in the format of GMT+/-X or UTC+/-X (e.g., GMT+2, 
UTC+01:00). 
3) Region-based: Specify the timezone using a region-based identifier such as UTC, ECT, PST, etc.

Sample 
rows 
count

Determines the number of rows that will be used as a sample to estimate the length and data types of the 
imported data.

Minimum 
column 
length

This value is used when creating a new column and specifying its type, if necessary. It indicates the minimum 
number of characters or digits expected in the column. This information helps determine the appropriate data 
type and size for the column during the creation process.

Save task
Opens the  to assist in creating a task during the data transfer process. This window provides Save Task window
options and settings for creating and configuring a task related to the data transfer operation.
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5) In the next window, set XLSX-to-table mappings. Please refer to our guide for detailed information on the 
.mapping process

6) Select your data load settings in the subsequent window, and then click . For more information, please Next
refer to our article's section .Data load settings

7) In the final window, you can review all the settings you selected earlier. If you missed something, you could go 
 and fix it. When you're ready, finish the import by clicking .Back Proceed
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8) If the  file is valid and there are no errors, you will see a notification window with information about the XLSX

completion of the task. You can keep working with your database during export, as the data loading will be 
performed in the background.

1) Select the database table (or tables) where you want to import data. Do this by right-clicking on the table name 
in the  section, then clicking on .Database Navigator Import Data

Importing data from XML file
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2) In the window that appears, select  and then click .XML Next

![](images/dt/xml/dt-xml-import-source.png)

3) In the following window, select the  file that contains the data you want to import, then click .XML Next

![](images/dt/xml/dt-xml-input-file.png)

4) In the next window,w set XLSX-to-table mappings. Please refer to our guide for detailed information on the 
.mapping process

![](images/dt/xml/dt-xml-table-mapping.png)

5) select your data load settings in the subsequent window, and then click . For more information, please refer Next
to our article's section .Data load settings

![](images/dt/xml/dt-xml-data-load-settings.png)

6) In the final window, you can review all the settings you selected earlier. If you missed something, you can go 
back and adjust it. Once everything looks good, finish the import by clicking .Proceed

![](images/dt/xml/dt-xml-confirm.png)

7) If the file is valid and there are no errors, you'll see a notification window with information about the completion 
of the task. You can keep working with your database during export, as the data loading will be performed in the 
background.

![](images/dt/xml/dt-xml-complete.png)
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DBeaver offers seamless data migration capabilities, allowing you to transfer data from one database table to 
another. For more detailed instructions and insights on data migration, you can refer to our article on Data 

 guide.Migration

Importing data from the database table
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You can generate SQL statements (SELECT/INSERT/UPDATE/DELETE) based on selected rows. To generate 
SQL, right-click the selected rows and click  and then one of the SQL commands on the context Generate SQL
menu:

The SQL result opens in a separate window where you can view and copy it:

SQL Generation
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To use table names in the format '[schema name].[table name]', select the  checkbox.Use the fully qualified names
To wrap the SQL query into one line, select the  checkbox:Compact SQL
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1.  

2.  

Spatial data is a geometry or geography value that can be represented on a map or a graph. A geometry object 
consists of a series of points. .Please find more details here

DBeaver's support of spatial data covers the following databases:

PostgreSQL (PostGIS)

MySQL

SQLite (GeoPackage)

H2GIS

SAP HANA

Oracle 

SQL Server 

Every table column has its own color on the map. This helps you find needed information on the map if you know 
which column it belongs to.

If you click on an object on the map the following information will be displayed:

Name of the column in the header

Displayable data (strings, numbers, dates etc.) from every other column in the corresponding row

Working with spatial/GIS data

Spatial data viewer

Differentiating data on the map

https://en.wikipedia.org/wiki/Spatial_database
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DBeaver ships with several predefined map tiles. The tiles can be chosen with the combo below the viewer:

You can choose which tile layers you want to see in the combo in the  dialogue. In the same manage manage
dialogue, you can add new tile layers, edit layers you previously added or delete them.

At this point, you may be wondering what to put in the Layers definition box. Here is a brief explanation.

Tile layer management

Defining custom tile layer
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DBeaver's spatial data viewer uses Leaflet (version 1.4.0 at the moment) under the hood. You type arguments for 
function L.tileLayer() when providing Layers definition, which installs a new tile layer.  function in the More on that
official Leaflet documentation. You can also see the definition of predefined tiles to help you get started.

You can also see your geodata on the map if you select the data cell setting "View/Format", then "Set 
columnName format" and among the formats - Geometry. This works for both string and binary types of columns.

String column type to spatial.

Binary column type to spatial.

Viewing string or binary data from any Database on a map

https://leafletjs.com/reference-1.4.0.html#tilelayer
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You can copy coordinates to clipboard from any point of the map: just right-click anywhere and select “Copy 
coordinates”. It copies the coordinates formatted as  to the clipboard.\  The latitude, longitude NOTE:
coordinates are copied according to EPSG:4326 CRS and are just raw numbers. You may need to remove a 
comma and switch latitude and longitude places to correctly insert it into a database.

You can use buttons at the bottom of the view for additional features:

Open the generated temporary HTML file in your default browser.

Copy a current map to clipboard as picture

Save a current map as a picture into a selected folder

Print a current map

Flip latitude and longitude coordinates in source data. This can be useful if the data in your table is saved in 
(latitude longitude) format while Leaflet reads it as (longitude, latitude). This button doesn’t change anything in 
source data, it just changes how this data is read to show accurate information on the map.

Additional features

Copying coordinates

Miscellaneous buttons
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DBeaver supports XML and JSON column types (in relational databases) by using standard JDBC interfaces. This 
feature was added in JDBC4 so you will need JDBC4 compliant driver for your database.

In the Data Editor, you can edit XML/JSON data right in the table cells/ However, a huge amount of data may 
require a larger editor so you might want to save XML/JSON scripts to a local file or upload this type of data from a 
local file.

To open the full-size XML/JSON editor click the cell containing data in XML/JSON format and press +Shift Enter
.

By default the editor opens on JSON tab, open XML tab to modify XML data.

To auto-format XML/JSON script press + +  keyboard buttons.Ctrl Shift F

Working with XML and JSON
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Use +  keyboard shortcut to save the changes made.Ctrl S

You can also edit XML/JSON content, save it locally and upload it from a local file with the help of  panel Value
toolbar.

To upload data from a local file, press the  button .Load from file...

To save the content to a local file, press the  button .Save to file...

To switch between the formats, press the  button  and select the format.Content viewer settings
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Use  feature that wraps the text within a screen.Word Wrap

Use  feature to automatically change the appearance of XML/JSON script (fix spaces around Auto Format
operators / commas, fix indentation, etc) and make it more readable.
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To learn more about  panel, see .Value Panels
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The DBeaver formatting functions allow you to set up database locale and change datasource format settings. 
This feature can be very useful, for example, for database migration.

To change the data format settings use the option Window -> Preferences in main menu.

In the Preferences dialog box go to Editors -> Data Editor -> Data Formats.

Managing Data Formats
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Or, in the  right-click a connection and select  menu option.Database Navigator Edit Connection
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In the right area of the opened  dialog window go to Data editor -> Data Formats and Data formatting preferences
select the  check box in the left area to customize the data format settings.Datasource settings
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Data format profiles allow you to apply a set of data format preferences to the whole current project by one click.

To create a data format profile press the  button. In the opened dialog window press button Manage Profiles New 
, define the name and press .Profile Create

To delete a data format profile press the  button, then in the opened dialog window select the Manage Profiles
profile you want to delete and press the button .Delete Profile

Data Format Profiles
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The following groups of data format settings can be adjusted:

Changing Data Formats

Locale
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To define this setting select a language, country and variant if available.

Native Date/Time Mode
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Select  check-box and the data format originally built-in to the datasource will be used.Use native date/time format

You can change the format of the following data types:

Data Type Format
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The format of the following data types can be customized:

Date

Time

Timestamp

Numbers

The default value for this data type is .yyyy-MM-dd

Pattern Description

yyyy or y Year of era (4 digits)

yy Year of era (2 last digits)

YYYY Week year

M Month in year without leading zeros

MM Month in year

Date
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MMM Short month name in year

MMMM Month name in year

D Day in year

d Day in month without leading zeros

dd Day in month

E Day name in week

G Era designator

z General time zone

Z RFC 822 time zone

The default value for this data type is HH:mm:ss

Pattern Description

H Hour in day (0-23) without leading zeros

h Hour in day in am/pm (1-12) without leading zeros

HH Hour in day (0-23)

hh Hour in day in am/pm (1-12)

a Am/pm marker

m Minute in hour without leading zeros

mm Minute in hour

s Second in minute without leading zeros

ss Second in minute

S Millisecond

ffffff Microseconds

The default value for this data type is yyyy-MM-dd HH:mm:ss

Link on Java date pattern documentation

The following parameters can be configured from this type of data:

Use Grouping - Long numbers can be hard to read if they have too many digits. For example, the factorial of 
30 is 33 digits long! Select this check-box to enable Grouping mode, in which digits are displayed in clumps of 
3 or 4 (depending on the current radix) separated by commas.

Maximum integer digits - Defines the maximum number of digits to the left of the decimal point.

Time

Timestamp

Numbers

https://docs.oracle.com/en/java/javase/11/docs/api/java.base/java/text/SimpleDateFormat.html
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Minimum integer digits - Defines the minimum number of digits to the left of the decimal point.

Maximum fraction digits - Defines the maximum number of digits to the right of the decimal point.

Minimum fraction digits - Defines the minimum number of digits to the right of the decimal point.

Use data type scale for fraction digits - Some numeric columns or parameters may have a predefined scale, 
that is the maximum number of digits to the right of the decimal point. Select this check-box if you want the 
predefined precision to be used.

Rounding mode - Specifies a rounding behavior for numerical operations capable of discarding precision. 
Each rounding mode indicates how the least significant returned digit of a rounded result is to be calculated. 
To learn more, please refer to .Oracle documentation

To change the data type format, change the value displayed in the  area,save the changes made by Pattern
pressing the  button and observe the expected result in the  field.Apply Sample

To restore the default data format settings, press the  button.Restore Defaults

Restoring Default Data Formats

https://docs.oracle.com/javase/7/docs/api/java/math/RoundingMode.html
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Press  link to change data format settings for a particular datasource, then adjust the settings Datasource settings
in the opened dialog box.

Datasource Settings
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To save changes made press .Apply
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You can use standard JavaScript-like expression language. DBeaver uses the Jexl engine to process expressions.
Language references and examples can be found here: http://commons.apache.org/proper/commons-jexl
/reference/syntax.html

All columns' values in the current result set can be referred to by name. Expression  will column1 + column2

produce the sum of two numeric columns or concatenation of two string columns  and .column column2

Standard functions are declared in namespaces.
You can refer to the functions in the namespaces as variables - ).nsName.functionName(parameters

You can access all math functions as .math.function(parameters)

You can find all supported math functions here: https://docs.oracle.com/cd/E12839_01/apirefs.1111/e12048
/functmath.htm

Virtual column expressions

Expression language

Column values

Standard functions

math

http://commons.apache.org/proper/commons-jexl/reference/syntax.html
http://commons.apache.org/proper/commons-jexl/reference/syntax.html
https://docs.oracle.com/cd/E12839_01/apirefs.1111/e12048/functmath.htm
https://docs.oracle.com/cd/E12839_01/apirefs.1111/e12048/functmath.htm
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Function Parameters Description

wktPoint (longitude, latitude) Produces WKT (geometry) point out of two coordinates. Default SRID is 4326.

wktPoint (longitude, latitude, srid) Produces WKT (geometry) point out of two coordinates and SRID

If you have JSON or XML columns in your table, you can add a virtual column with an expression for these 
columns.

Use content.json()[parameter1][parameter2] pattern to create expression for JSON column.

Expression example: content.json(column1)['glossary']['GlossDiv']['title']

You can read more about JSON parameters in the link on the top.

Use content.xml(columnName, "expression") or content.xml(columnName, "returnType", "expression") patterns to 
create expression for XML column. The quotation is important for parsing processes. XML expression can return 
types: string, number, boolean, node, nodeset - all these types can be used (!in quotes) for return data type 
clarification. content.xml(columnName, "expression") returns string by default

Expression example: content.xml(column1, "nodeset", "/Employees/Employee[gender='Female']/name/text()")

You can read more about XPath here: https://en.wikipedia.org/wiki/XPath

geo

content

https://en.wikipedia.org/wiki/XPath
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You can create multiple SQL scripts for a single connection. Every script opens in its own SQL editor. To open an 
SQL editor for some connection:

Click this connection in the  view and press  or click  on the Database Navigator F3 SQL Editor -> SQL Editor
main menu. Alternatively, click  on the context menu of this connection. DBeaver opens the SQL Editor
Choose SQL script editor with saved SQL scripts linked to this connection. Click the SQL script to open it in a 
separate tab.

Click  on the context menu for this connection or on the main menu (Recent SQL Editor SQL Editor -> Recent 
). This opens the latest used SQL editor. You can also open the most recent SQL editor using SQL Editor Ctrl+Enter

shortcut in the Database Navigator view.

If you need to create a new SQL script, on the main menu, click  or press  SQL Editor -> New SQL Editor F3
and then click  in the Choose SQL Script window.New Script

DBeaver uses SQL syntax highlighting which depends on the database associated with the script. Different 
databases have different sets of reserved keywords and system functions.

NOTE: SQL Editor for a connection is different from SQL console for a table or view (right-click the table and click 
). Unlike the console, it can save scripts and changes made to them.Read data in SQL console

You can see all your saved SQL scripts in the  view in the  folder.Project Explorer Scripts

The SQL editor includes the script panel at the top and the results panel at the bottom:

You can open the SQL editor preferences by pressing .Alt+Enter

Also SQL Editor has toolbar which is customizable. See .Toolbar Customization

SQL Editor
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The results panel displays tabs with results in various formats. The tabs resulting from script execution represent 
instances of the . You can create, edit and execute SQL scripts in the script panel and then see the Data Editor
results in the result tabs.

The results panel provides  and  views of results.Output Log

The execution  tab contains all queries executed in the current SQL editor:Log

The  tab contains all server-side database messages/warnings generated by a database when you execute Output
queries. This feature is supported only by a few database engines (Oracle, SQL Server and some other ones).

Results Panel
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You can modify the layout of the SQL Editor by showing/hiding the results panel and changing the horizontal
/vertical position of the panes.

To toggle (hide/show) the results panel, press  or right-click anywhere in the script pane and, on the CTRL+6
context menu, click .Layout -> Toggle results panel

To maximize the results panel, press , or double-click the results tab name, or right-click CTRL+Shift+6
anywhere in the script panel and, on the context menu, click .Layout -> Maximize results panel

To switch between the script panel and the results pane, press  or right-click anywhere in the script Alt+6
panel and, on the context menu, click .Layout -> Switch active panel

To position both panels horizontally, right-click anywhere in the script panel and, on the context menu, click Layout 
.-> Horizontal

To position both panels vertically, right-click anywhere in the script panel and, on the context menu, click Layout -> 
.Vertical

You can press and hold  and at the same time move the mouse over the SQL text. If DBeaver recognizes Ctrl
some identifier as a table/view name, it presents it as a hyperlink. You can click the hyperlink to open this object`s 
editor:

You can change the connection associated with the current SQL editor or change the active database/schema, at 
the same time retaining the SQL text.
To change the connection, press  or click the  box on DBeaver`s main toolbar:Ctrl+9 Active datasource

The Select Data Source dialog box opens. In the tree of connections, click the required connection and then click 
. To disassociate the SQL Editor with any connection, click :Select None

Layout Adjustment

Hyperlinks

Active Database/Schema Selection
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To change the active schema, press  or click the  box in DBeaver`s main toolbar:Ctrl+0 Active Catalog/Schema

The Choose catalog/schema dialog box opens. In the list of schemas, double-click the required schema:

If there are many schemas and they do not fit in the dialog box use the search field to find the schema you need: 

To configure the set of columns to be visible for each schema in the dialog box, click the  button Configure columns

( ).

You can easily associate the SQL Editor with the connection that is currently in focus in the Database Navigator 
(the focus can be on any object of the connection - a table, a folder, etc.) - click the  Set connection from navigator
button on DBeaver`s main toolbar:

The reverse action is also possible: you can set the focus of the Database Navigator to the active connection of 
the SQL Editor - press  or click the arrow next to the  button in Ctrl+Shift+, Set connection from navigator
DBeaver`s main toolbar and then click :Link with editor
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You can customize your SQL Editor toolbar to bring more commands with 
.Preferences->User Interface->Toolbar Customization

By default, only Execute SQL Statement, Execute SQL Script and Explain Execution plan are visible.

Toolbar Customization
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Templates allow you to insert frequently used SQL statements into an SQL script.

To see available templates, press  or right-click the line in the script pane and click Ctrl+Alt+SPACE SQL 
 on the context menu. A box with a list of available templates appears:Template

To apply a template, in the SQL Editor, in the script pane:

Type the template name and press Tab

Right-click the line where you want to insert a template expression, click  on the context menu, SQL Template
and then, in the list of templates, double-click the required template name.
The template SQL statement appears in the script.

To edit/add/remove templates, click Configure Icon in the bottom toolbar, then click Preferences -> SQL Editor -> 
. For more information about managing templates, please visit .Templates Eclipse Website

Standard Eclipse templates:

Variable Description

${cursor}
Specifies the cursor position when the template edit mode is left. This is useful when the cursor should 
jump to a different place than to the end of the template upon leaving the template edit mode.

${year} Takes the current year value

${date} Takes the current date value

${time} Takes the current time value

${dollar} Takes the dollar sign $. Alternatively, two dollar signs can be used: $$.

${user} Takes the user name

${word_selection} Takes the content of the current text selection

${line_selection} Takes content of all currently selected lines

DBeaver-specific templates:

Variable Description

${schema} Takes the current schema name

SQL Templates

http://help.eclipse.org/juno/index.jsp?topic=%2Forg.eclipse.jdt.doc.user%2Fconcepts%2Fconcept-editor-templates.htm
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${catalog} Takes the catalog name

${table} Takes the current table name (from the active catalog/schema)

${column} Takes the column name (from the current table)
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The SQL Assist feature provides auto-completion of database object names and SQL commands, and other 
keywords in queries.

To perform some object name auto-complete, press  or right-click the desired location in the query Ctrl+Space
and click  on the context menu. DBeaver searches for objects in a database by their names and/or SQL Assist
descriptions.

When you start typing an SQL keyword in a statement, DBeaver offers auto-complete options as well.
Another auto-complete function is that it searches for the last entered identifier - type the first letter and press Ctrl+Shift+Space
.

You can also press  after the asterisk in the query similar to  or similar to Ctrl+Space SELECT * FROM tableName

 (brackets are important) (you can use ()[]{} brackets) - the asterisk will be replaced INSERT INTO tableName (*)

with a list of all the table columns.

Hippie Engine provides autocompletion based on information from the current script file. It scans files looking for 
words and adds proposals based on similarity with the given string.

It can be toggled on or off in the  preferences.Code Completion

You can customize your SQL Assist and Auto Complete by navigating to  ->  ->  -> Window Preferences Editor SQL 
 -> , optimizing the performance of the auto-completion feature.Editor Code Completion

SQL Assist and Auto-Complete

Hippie Engine

Customize
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In DBeaver, you can build working SQL queries using human language thanks to integration with OpenAI 
(ChatGPT, to be more precise - the ).GPT-3 language model

Note:

DBeaver Corp has nothing to do with OpenAI company. We use public API to integrate with the GPT 
completion engine.

To use this feature, you need to register on the OpenAI platform and .receive a secret key

To use this feature in the DBeaver Community version, you need to .install the GPT extension

This feature isn't available in the  version.Lite

How it works |  |  |  |  |  |  | Get started Write questions Configure Disable Receive API key Install GPT extension Data 
privacy

You write what you want to get from the database in the  window, and DBeaver ChatGPT smart completion
translates your phrase into the correct SELECT query.

Enter human language request:

Generated SQL query:

AI SQL Assistance (ChatGPT)

How it works

https://platform.openai.com/docs/models/gpt-3
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Note: DBeaver must send the database metadata to the OpenAI platform to translate a phrase into a query. 
OpenAI will know table and column names in your database. DBeaver will ask about this on the first smart 
completion for every connection. Learn more about data privacy

You can specify the scope used to generate queries in the  field. You may need this if your database Scope
schema is large enough to eliminate problems when generating queries.

If you want to choose a table, select the  option.Custom

Then select a table.

Additional settings

Scope
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1.  

2.  

3.  

You can see the request history in the  field. If you are using the PRO version, you can see the request History
history for previous sessions.

If using the Community edition, .install the extension

Open  ->  ->  -> . Click  if it's not on (as in Window Preferences Editors AI (GPT Chat) Enable smart completion
the PRO versions).

Copy the available AI secret key to the  field and apply changes. .API token Where to find a secret key

History

Getting started
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4.  

5.  

6.  

Open  (F3) and click the  in the left toolbar. (Note: toolbar is customizable. See SQL Editor GPT icon Toolbar 
)Customization

Confirm the metadata transfer to Open AI.

Write your question in the  window and press .ChatGPT smart completion Translate

You can also select database objects to work within the  field. This is useful if you have a large schema with Scope
many objects.

How to write questions
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You need to write a phrase in English or any other language describing what you want to get from the database. 
You should know at least something about your database structure. You can correct the query step by step, add 
details and make it more accurate. You can add specific details, such as how to build a query or which tables or 
columns to use.

For example, using , you could write something like this:DBeaver sample SQLite database

Example 1: "show customers from Italy"

SELECT * FROM customers WHERE country = 'Italy';

Example 2: "montre les clients de France"

SELECT * FROM customer WHERE country = 'France';

Example 3: "show customers who purchased blues tracks, use joins"

SELECT c.FirstName, c.LastName, t.Name, g.Name
FROM Customer c
JOIN Invoice i ON c.CustomerId = i.CustomerId
JOIN InvoiceLine il ON i.InvoiceId = il.InvoiceId
JOIN Track t ON il.TrackId = t.TrackId
JOIN Genre g ON t.GenreId = g.GenreId
WHERE g.Name = 'Blues'
ORDER BY c.LastName, c.FirstName;

Example 4: "get names of customers who purchased blues tracks, use joins"

SELECT DISTINCT c.FirstName, c.LastName
FROM Customer c
JOIN Invoice i ON c.CustomerId = i.CustomerId
JOIN InvoiceLine il ON i.InvoiceId = il.InvoiceId
JOIN Track t ON il.TrackId = t.TrackId
JOIN Genre g ON t.GenreId = g.GenreId
WHERE g.Name = 'Blues';

You don't need to configure ChatGPT smart completion to use it. It's enough to , and specify the API key
everything will work. However, if you have problems generating SQL queries or want to experiment, you can try 
changing some settings.

To configure this feature navigate to  ->  —>  —> .Window Preferences Editors AI (GPT Chat)

Configure
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Enable smart completion shows the ChatGPT icon in SQL Editor. If this option is not selected, you can 
enable ChatGPT in Preferences.

API token it's a secret key from the OpenAI platform. Where to find a secret key

Include source in query comment — select this option if you want to see the request in human language in 
the SQL Editor before the generated query.

Execute SQL immediately — select this option if you want to run SQL query just after translation.

Model is a GPT-3 tool for understanding and generating natural language. The best model for generating 
SQL queries is .gpt-3.5-turbo

Temperature sets the level of creativity of the translation results. If you need accurate results, use 0.0. For 
less common and more creative output, use 0.9.

Write GPT queries to debug log — select this option if you want to see requests to ChatGPT in the log files.

There are some additional settings available in  and  editions only.Enterprise Ultimate

Settings in PRO versions
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1.  

2.  

3.  

1.  

2.  

3.  

Send foreign keys information and  allow to understand the Send unique keys and indexes information
relationships between tables, which can help create complex queries to a database with a complex structure.

Format SQL query add formatting.

Table join rule allows explicit JOIN or JOIN with sub-queries.

Register on the .OpenAI platform

Open  in your profile, and click Create new secret key button.API Keys section

You'll see the new secret key, copy it and paste it into the  field in Preferences.API token

You only need to install this extension in the DBeaver Community version. In other editions, it is already installed.

From the main menu, select .Help —> Install New Software

In the installation window, in the  field select  .Work with DBeaver AI (GPT) integration

Then select , press  and follow the installation process.AI (GPT) Support Next

Receive API key

Install GPT Extension

https://openai.com/api/
https://platform.openai.com/account/api-keys
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4.  Restart DBeaver.

That's all done. Open the SQL editor; in the left toolbar, you'll see the ChatGPT  icon.

You can temporarily remove the ChatGPT icon from the SQL Editor toolbar. Move on  ->  —> Window Preferences
 —>  and uncheck the  option. You can always enable it again.Editors AI (GPT chat) Enable smart completion

You can permanently disable ChatGPT smart completion only in PRO versions. In this case, it cannot be enabled 
in Preferences.

How to do it:

set system variable  to .DBEAVER_AI_DISABLED true

or add the string  to the end of .Dai.disabled=true dbeaver.ini

DBeaver needs to send the tables and column names of the current database schema to the OpenAI platform to 
convert your request into an SQL query. DBeaver does not send any data from tables. The full text of the request 
can be seen in the log file, which you can enable in  by selecting the  Preferences Write GPT queries to debug log
option.

DBeaver will ask for confirmation the first time you use ChatGPT completion for each connection. You must 
confirm the metadata sending before using this feature.

Disable

Data privacy
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If you don't want to send information about some tables, you can  in the  field.choose which tables to use Scope

You can completely disable the ChatGPT feature in PRO versions. How to disable it

If you don't want to use ChatGPT in the CE version, you can choose not to install the plugin, and it will not be 
visible at all.
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To format an SQL text, select it and press  or right-click the selected text and click Ctrl+Shift+F Format -> 
 on the context menu.Format SQL

To format a script to upper or lower case, highlight the SQL text, then right-click it and click Format -> To Upper 
, respectively, on the context menu.Case / To Lower Case

To comment out an SQL line, press  or right-click the line and click  on Ctrl+/ Format -> Toggle Line Comment
the context menu. To uncomment a commented line, manually remove the commenting syntax, or press the same 
button combination, or right-click the line and click the same item on the context menu.

To comment out a block of text, select the text, then press  or right-click it and click Ctrl+Shift+/ Format -> 
 on the context menu. To uncomment a commented block of text, you can either manually Toggle Block Comment

remove the commenting syntax or select the same block of text, right-click it and click the same item on the 
context menu or press the same button combination.

To trim spaces (leading and trailing) SQL text right-click the selected text or end of string and click Format -> Trim 
 on the context menu.spaces

You can choose a part of the text

SQL Formatting
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or put the cursor at the end of the row you want to trim

You will get the following result:

Or you can choose a part of the text from many lines

Then each of the selected rows will trim, and the final result will be like this:
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You can execute one query, a highlighted portion of a script, or a whole script. You can execute them using the 
following:

Shortcut key combinations (see details further in this article)

Tools in the main toolbar:

Note: toolbar is customizable. See Toolbar Customization

Context menu (right-click the query):

DBeaver main menu:

SQL Execution
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To execute a query under the cursor or selected text, press  or right-click the query and click Ctrl+Enter
 ->  on the context menu. You can do the same using the main toolbar or main Execute Execute SQL Statement

menu:  -> . This executes the SQL query under the cursor or selected text and SQL Editor Execute SQL Statement
fills the results pane with the query results.

To execute a query under the cursor in a separate tab, press or right-click the query and click  -CTRL+\ Execute
>  on the context menu. The same can be done using the main toolbar or the main menu: Execute SQL in new tab

 -> . This executes the SQL query under the cursor or selected text and SQL Editor Execute SQL in new tab
creates a new results tab.

To execute the whole script, press  or click  ->  on the context menu or Alt+X Execute Execute SQL Script SQL 
 ->  on the main menu or in the main toolbar. This executes all queries in the current Editor Execute SQL Script

editor (or selected queries) as a script. DBeaver parses queries one by one using a statement delimiter (“;” by 
default) and executes them consecutively. You can configure the script execution behavior in the SQL editor 
preferences ( Right-click the script and click  on the context menu).Preferences

To execute the script natively, press  or click  ->  on the context menu Alt+N Execute Execute SQL Script natively
or  ->  on the main menu or in the main toolbar. Upon activation, a setup SQL Editor Execute SQL Script natively
wizard is launched, which allows you to configure the parameters for script execution before the script is launched 
in the native client like PLSQL, MySQL, or SQLPlus. The results are displayed in a text field in the format of 
console output. It is handy when functions are not supported by DBeaver drivers and require more specialized 
clients or when the function is weighty, and a faster client is needed. 

: This function is available for MySQL/Maria, Oracle, and PostgreSQL and may require additional software Note
installation for each database.

To execute a script opening, each query results in a separate tab, press  or click  -Ctrl+Alt+Shift+X Execute
>  on the context menu or  -> Execute Statements In Separate Tabs SQL Editor Execute Statements In Separate 

 on the main menu or in the main toolbar. It executes all queries in the script but opens multiple result tabs. Tabs
Each script query is executed in a separate thread (that is, all queries are executed simultaneously). 

: Executing a massive script with numerous queries can result in unforeseen problems.Important

Result tabs
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A single query may generate several result sets represented by tabs. These tabs are linked to the query they are 
executed from.

To close an individual tab, press  or middle-click on a tab header.CTRL+Shift+\

To close all tabs expect current, click  on the context menu of this tab.Close all result tabs except this

To close all tabs of the desired query, click  on the context menu of this tab.Close all result tabs of same query

A tab is often named after the primary table of your query. For example, after executing the following query you 
will see a single tab called  (assuming that your database has a table called ):Album Album

SELECT * FROM Album;

If a query has joins or, in other words, has multiple source tables, a  is shown right to the table name. The (+)

following query will result in a tab called :Album(+)

SELECT * FROM Album al, Artist ar WHERE al.AlbumId = ar.ArtistId;

Additionally, you can change the name of a given tab via its context menu or by using a special comment:

-- title: DBeaver is cool
SELECT * FROM Album;

In other cases, tabs are named in the form of , where:Results < > (< >)A B

A is an index of query

B is an index of the result set of this query

Tabs can be moved around by dragging them with a mouse and pinned using the  on the context menu of Pin tab
the desired tab. Pinned tabs are stacked on the left. They can be moved among other pinned tabs but can't be 
mixed with unpinned tabs. Pinned tabs cannot be closed without being unpinned first and cannot be overwritten by 
executing a query (by making this tab active).

Tabs can be detached from the SQL editor into a separate view using the  action found in the context Detach Tab
menu of the desired tab. After the tab is detached, you can rearrange and move it anywhere you want (for 
example, you can put two tabs side-by-side for comparison).

Additionally, you can detach it from the application window using  found in the context menu of an already Detach
detached tab.

After the tab is detached, it's still synchronized with the SQL editor, meaning you can edit and refresh data as long 
as the SQL editor that produced that tab is open. Once you close it, tabs become read-only.

Naming

Pinning

Detaching
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To evaluate an SQL expression, right-click the expression and click  on the Execute -> Evaluate SQL expression
context menu. This command performs a query of  type:SELECT [expression] FROM DUAL

If you want to know how many rows an SQL query will produce, you need to apply the Row Count feature – 
highlight and right-click the SQL text and then click  ->  on the context menu:Execute Select row count

SQL Expression Evaluation

Row Count
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It might be useful to export a query if you have a long-running query and you do not need to see its results in the 
results panel. You can directly export the current query results to a file/table by right-clicking the query and then 
clicking  ->  on the context menu:Execute Export From Query

The Data transfer wizard opens. Go through its steps to complete the export of the query.

Query Export
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You can use dynamic parameters and variables in your SQL queries. The parameter format is . Also, :name

variables syntax could be used as . When you execute a query that contains dynamic parameters, ${varname}

DBeaver displays a dialog box in which you can fill the parameter values:

This dialog appears every time you execute the query with parameters.

If you want to set the value once, you can use  or add the variable and its value in the @set command Variables 
. Then Bind parameter(s) dialog will not appear.panel

You can also use anonymous parameters (?), but you will need to enable them in the SQL editor preferences:

Dynamic Parameter Bindings

https://github.com/dbeaver/dbeaver/wiki/Client-Side-Scripting
https://github.com/dbeaver/dbeaver/wiki/Variables-panel
https://github.com/dbeaver/dbeaver/wiki/Variables-panel
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You can open the SQL editor preferences by pressing .Alt+Enter

To select the current query row count, press .Ctrl+Alt+Shift+C

To open the definition of the database object currently in focus (under cursor) in a viewer/editor, press .F4

Miscellaneous
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SQL Terminal is an SQL Editor result tab where you can find the results for all executed queries in a text format.

To open SQL Terminal you should press the corresponding button on the left SQL Editor toolbar. (Note: toolbar is 
customizable. See )Toolbar Customization

You can execute a single statement or a sql script and see the result set with data, errors, and statistical 
information along with the corresponding query text.

SQL Terminal
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The context menu is available by right-clicking on the SQL Terminal area.
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For each sql script file, it will be saved whether the SQL Terminal is enabled, and the state of the SQL Terminal 
button will be restored when the file is opened.

You can set up whether to enable or disable the SQL Terminal for new scripts by default in 
.Preferences->Editors->SQL Editor->SQL Terminal
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You can see all of the currently assigned local variables for SQL Editor. You need to click a "Show SQL variables" 
button in the SQL editor.
A new tab alongside Output and Execution log panels will be opened with a list of assigned variables. On this 
panel, you can also show assigned parameters by clicking the corresponding button. (Note: toolbar is 
customizable. See )Toolbar Customization

You can change values for the current variable using the variables tab. Simply click on a variable's row and edit its 
value in the window below. To delete or add a variable or parameter, you can use a corresponding button. Instead 
of typing @set or @unset, you can use these buttons in the script.

If you have a long list of variables, you can click a magnifying glass to initiate a search bar. Start typing either a 
variable's name or its value to filter the list.

Variables panel is always connected to output and execution log panels, but this group of tabs can be configured 
to be shown either at the right side of the editor or at the bottom alongside the results panel. By default, the panels 
are shown on the right side. To change their location you need to either check or uncheck Show panels in result tabs
in the context menu.

Variables panel

Manipulating variables

Moving a panel
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This feature is supported for the following data sources:

The Execution plan for databases marked with a star is supported only in Lite, Enterprise and Ultimate editions

ClickHouse 

Couchbase 

DB2 LUW

Exasol

Firebird

HSQLDB

Microsoft SQL Server 

MySQL

Netezza 

OceanBase

Ocient

Oracle

PostgreSQL

SAP HANA

If a database driver supports the visualization of the execution plan, you can see the execution plan of the current 
query (under cursor) by pressing  or clicking  on the context menu or in Ctrl+Shift+E Explain execution plan

the SQL Editor toolbar:  (Note: toolbar is customizable. See ) The execution plan Toolbar Customization
command generates a tree of query execution as one of the result tabs and is convenient in estimating if the query
/script is quick/optimal enough:

Query Execution Plan

Execution Plan

Simple plan view
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You can click the rows of the execution plan to see their details (statistics) in the panels below and to the right of 
the plan.

To reevaluate the plan, click the  button ( ). To see the source script on which the plan is based, click Reevaluate
the  button ( ).View Source

In DBeaver , , and  editions you can use an advanced (graph) visualization of the execution Lite Enterprise Ultimate
plan.
This visualization shows the most expensive (cost-based) plan nodes. You can hide all irrelevant nodes (see node 
details), use horizontal or vertical plan layouts, export it to an image or save it as JSON to send to a colleague.

Advanced plan view 
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Note: This feature is available in , ,  and  editions only.Lite Enterprise Ultimate Team

Query Builder is a user-friendly visualization tool that will help you make sense of your complex database designs. 
It can be useful when you need to understand the various relationships between different tables. Also, it can be 
helpful for those who are not very familiar with SQL scripting or if you do not want to insert script commands 
manually. The tool creates SQL scripts automatically based on the visual schema you have created.

To open  click the  button in the  tool bar.Visual Query Builder Open Query Builder SQL Editor

The  will appear on the right.Visual Query Builder

Visual Query Builder

Opening Visual Query Builder

https://dbeaver.com/dbeaver-team-edition
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Start creating a query by selecting a query data source: drag-and-drop tables you want to work with from the 
 pane into the  area. All the connections existing between the tables will Database Navigator Visual Query Builder

be shown automatically.

Creating Visual Query
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To create a new join between the tables, press the left mouse button when the cursor is over the column of one 
table, holding the right mouse button drag the cursor to the column of another table and release the right mouse 
button. The connection between the selected columns of the tables will be created visually and in the SQL script a 
new join will be added.
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To remove a join between the tables, click on it. The connection will be highlighted. Then, press  or use Delete
the  option in the context menu. The visual connection will be removed and the corresponding join will be Delete
automatically removed from the SQL script area.

To build a SELECT query you need to select columns in the tables you added. To select a column, click the check-
box next to its name - the column will be added to the  tab of the  and SELECT Columns Query Settings Editor
query will be added to the SQL script area automatically.

Visual Query Builder also allows you to set the query conditions and adjust the representation of query results by 
means of .Query Settings Editor

To open  use  button  in the vertical tool bar on the left.Query Settings Editor Visual builder query settings

Query Settings window contains five tabs described below.

Adjusting Query Settings
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Columns tab of the  contains all the columns you added by selecting column names in Query Settings Editor Visual 
 main window. In this tab you can add and remove columns using  and  buttons Builder Add Remove

correspondingly.

To add a column, press  button  and a new instance will be added to the table. Click on the first cell in Add
 column and select a column from the list of available columns displayed in the dropdown Column or Expression

list appeared.

To remove a column, click on the row containing its name and press the  button  on the right.Remove

To change the display order of columns in the result table use  buttons .Move Up/Down

You can also define a user-friendly name of the column to be displayed in the result table. To set a user-friendly 
name, click on a cell in  column and insert the name. The change will be immediately displayed in the SQL Alias
script area.

Columns



DBeaver User Guide 23.1. Page 153 of 526.

If you want a  condition to be added to your expression, you can click on the checkbox in the column row. grouping
The expression will update automatically. The other previously selected columns will become aggregate. If there 
are no other columns, then the expression COUNT(*) will be automatically added.

You can select other aggregation functions from the drop-down list. Or enter your own version in the cell.

When removing columns from the list, they will be removed from the grouping expression as well. When adding 
new columns to the list, it is added to the grouping expression.

The  tab is used for managing query conditional expressions.Conditions

Conditions
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To add a new conditional expression, use the  button  on the right - a new instance will be added and the Add
default conditional expression WHERE will be added to the SQL script area automatically. This default conditional 
expression can then be adjusted to the one you need:

Left Operand setting defines the left operand of the conditional expression. To set the left operand, click the 
cell in the  column and a drop down list of all available columns will be displayed. Select a Left Operand
column you want to use as the left operand in your conditional expression or insert a digit.

Operation setting defines the comparison rule between the left and the right operands of the conditional 
expression. To set a comparison rule, click the cell in the  column and select the rule you need from Operation
the drop down list which will appear.
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Right Operand setting defines the right operand of the conditional expression. To set the right operand, click 
the cell in the  column and a drop down list of all available columns will be displayed. Select a Right Operand
column you want to use as the left operand in your conditional expression or insert a digit.

To remove a conditional expression, click on the row containing the expression and press the  button  Remove
on the right.

Joins



DBeaver User Guide 23.1. Page 156 of 526.

All the joins existing between the tables in  main window are displayed in the  tab of Visual Query Builder Joins
.Query Settings Editor

Joins cannot be added or removed by means of , however, the following join settings can be Query Settings Editor
adjusted here:

Type - defines the type of the join. Click the cell in the  column - a drop down with available join types Type
will be displayed. Select the required option from the list by clicking on it.

Alias - defines a user friendly name of the join. To define this setting click on the cell in the  column and Alias
input the name.
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In the  tab you can set the order of rows in the result table.Sorting

To add a new sorting condition press the  button  on the right and the default conditional expression Add
ORDER BY will be added to the SQL script area automatically. This default conditional expression can then be 
adjusted to the one you need:

Once a new condition is added, click the first cell in  column and a drop down list of Conditions or Expressions
all available columns will appear. Select the required column by clicking on its name.

Sorting
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In the  column you can define whether the rows of the selected column should be sorted in ascending Order
or descending order in the result table. To set the order, click the cell in  column and select the required Order
option from.The order by command will be added to the script.

To remove a condition use the  button  on the right.Remove

In the  tab it is possible to:Miscellaneous

Miscellaneous
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Enable or disable the automatic generation of aliases for tables by selecting the  check-box.Add table aliases

Disable auto-completion for table names by selecting the  check-box.Use fully qualified table names

Enable Autosave on SQL-editor switch by selecting the  check-box.Autosave on SQL-editor switch

To execute a query, use the  button  to get the results in the same tab or Execute SQL statement Execute SQL 

 button  to get the results in a new tab. Both buttons are located in the statement in new tab Visual Query 
 vertical toolbar.Builder

Executing Visual Query
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You can save scripts to a predefined space in the currently active project or somewhere in the file system.

To save a script to the current project space, just press  or right-click the script and click  on the Ctrl+S Save
context menu:

You can find the script saved this way in the  view in the  folder.Project Explorer Scripts

To save a script to the file system, right-click the script, click  on the context menu and File -> Export SQL script
then select the folder in the file system. You can also click  on the main menu:SQL Editor -> Export SQL script

Script Management

Saving Scripts
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Unsaved data is highlighted in color on the left side of the editor, in addition to having an asterisk in the name of 
the script.

To load a script stored in the file system to the SQL Editor, press , or click CTRL+SHIFT+O SQL Editor -> Import 
 on the main menu, or right-click the script panel and click  on the context menu:SQL script File -> Import SQL script

To rename a script, right-click anywhere in the script panel, click  on the context menu File -> Rename SQL Script
or press :CTRL+F2

Loading Scripts

Renaming Scripts
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Then enter the new name in the Rename SQL script dialog box and click :OK

If you want to revert all changes made to the current SQL script and return it to its initial state (reload from disk), 
right-click anywhere in the script panel and click  on the context menu.File -> Revert

By default all of the scripts are saved to a "Scripts" folder located in your project inside the workspace directory. 
This can be changed by clicking the  button in  view. There you can click on a folder's Configure Project Explorer
name an pick any other folder inside the Project.

Reverting Changes

Changing default scripts directory



DBeaver User Guide 23.1. Page 163 of 526.

You can also link an external directory to your project to either save your scripts into it, or to access scripts that 
were created outside of DBeaver.
To link an External directory right-click anywhere in the Project Explorer and pick . There you Create -> Link Folder
can link any directory on your drive to a project. This will allow you to open any externally created scripts through 
Project explorer and to set this folder as default to save new scripts into.

In some cases you might want to execute a query and not save it in a script. For example, when you read table 
data using "Read data in SQL console" or open procedure/function source from DDL editor. SQL console does not 
have an associated .sql file. Its contents will be lost when you close it.

Adding external directory

SQL Console
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You can use special commands in the SQL scripts.
These commands are executed on DBeaver's side, not on the server-side.

DBeaver supports the following commands:

Command Database Description

@set var = value All

Sets a script variable.
You can use expressions as a value. Variables can be used as SQL queries input 
parameters.
For more information see Dynamic parameter bindings

@unset var All Unsets a script variable.

@echo message All
Prints message to output log. You can use a macro in a message (for example 

).${var}

@include fileName All

- Executes a specified file name,
- Can be used in scripts, 
- Opens a new SQL console with the specified file and processes SQL queries as in a 
regular SQL editor.

@export { ... } All
Opens the data transfer wizard with predefined settings.
For more information see .the main article

source fileName MySQL The same as  but in MySQL CLI syntax@include

define var = value Exasol The same as  but in Exasol EXAPlus syntax.@set

Client Side Commands
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The  command allows you to open the data transfer wizard with prefilled settings.@export

It may be helpful in case you're editing several SQL queries and want to quickly perform the export of the 
produced results without creating any additional data transfer tasks.

Disclaimer: This article describes supported settings by the  command, their purpose, and allowed @export

values. Generally, this article contains every setting accessible in the data transfer wizard. Settings are written in 
the order they appear in the wizard, so you can always look at the wizard to quickly locate any of these settings.

The body of the command consists of JSON text, which looks like this:

{
    "type": <ID of the processor>,
    "producer": {
        <producer settings>
    },
    "consumer": {
        <consumer settings>
    },
    "processor": {
        <processor-specific settings>
    },
}

Due to certain limitations, it must be written on a single line, without line delimiters:

@export { "type": "csv", "producer": { ... }, "consumer": { ... }, "processor": { ... } }

The command itself doesn't do anything. It must be followed by any other query:

@export { "type": "csv", "producer": { ... }, "consumer": { ... }, "processor": { ... } }

SELECT * FROM Album;

You can either execute each line separately, or execute the entire script at once.

Here's the description of each attribute:

Attribute Description

type Type of the processor.

producer
Settings that affect how the data is extracted.
See the full table of supported settings in .the main section

consumer
Settings that affect how the data is transformed before processing.
See the full table of supported settings in .the main section

processor

Settings that affect how the data is processed. This includes formatting, transformations, etc.
These settings are specific to the processor specified by the  attribute.type

See the full table of supported processors in .the main section

Export Command

Usage

Settings
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Id Name Description Type Default Value
Allowed 
Values

extractType
Extract 
type

Data extraction mode. Denotes 
whether a single query or 
multiple segmented queries 
should be used to extract data.

String SINGLE_QUERY
SINGLE_QUERY

, SEGMENTS

segmentSize
Segment 
size

Specifies how many rows are 
read per segment during data 
extraction.
See extractType

Integer 100000 Any

fetchSize Fetch size

Number of rows to fetch per one 
server round trip.
May greatly affect extraction 
performance.

Integer 10000 Any

openNewConnections

Open new 
connection
(s)

Open new physical connection 
for data reading.
Makes great sense if you are 
going to continue to work with 
your database during the export 
process.

Boolean true Any

queryRowCount
Select 
row count

Query row count before 
performing export.
This will let you track export 
progress but may cause 
performance faults in some 
cases.

Boolean true Any

Id Name Description Type Default Value
Allowed 
Values

formatterProfile
Formatting 
Profile

Specifies the profile 
used for formatting data.

String Any

valueFormat
Value 
Formatting

Specifies how the data 
is interpreted.

String UI

UI , 
, EDIT

NATIVE

lobExtractType
Binaries 
Policy

Specifies how binaries 
are processed.

String INLINE

SKIP , 
FILES

, 
INLINE

lobEncoding
Binaries 
Encoding

Specifies how binaries 
are encoded.

String BINARY

BASE64

, , HEX

BINARY

, 
NATIVE

Copy to 
Specifies that the data 
should be copied to the 

Producer Settings

Consumer Settings
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outputClipboard
Clipboard clipboard rather written 

to files on a disk.
Boolean

false
Any

outputFolder
Output 
Directory

Output directory 
pattern. Specifies there 
the output files should 
be located.

String N/A Any

outputFilePattern
Output 
Filename

Output filename pattern. String ${table}_${timestamp} Any

outputEncoding
Output 
Encoding

Specifies the file 
encoding.

String UTF-8 Any

outputEncodingBOM Insert BOM

Specifies whether the 
byte order mark should 
be written to the output 
file.
Common for encoding 
such as , UTF-16LE

, , UTF-16BE UTF-32LE

and .UTF-32LE

Boolean false Any

outputTimestampPattern
Timestamp 
Pattern

Pattern used for the 
 variable ${timestamp}

in  and outputFolder

.outputFilePattern

String yyyyMMddHHmm Any

appendToFile

Append to 
the end of 
the file

If file already exists, 
appends data at end of 
it.
Only works against 
compatible processors.

Boolean false Any

useSingleFile

Write to 
the single 
file

Write all streams to the 
single file.
Only works against 
compatible processors.

Boolean false Any

compressResults Compress
Specifies whether the 
output file should be 
compressed using ZIP.

Boolean false Any

splitOutFiles
Split 
output file

Specifies whether the 
output file should be 
split using the 

 maxOutFileSize

threshold. If size 
exceeds this threshold, 
a separate file is 
created and so on.

Boolean false Any

maxOutFileSize
Maximum 
file size

Maximum size of a 
single file.
See splitOutFiles

Integer 10000000 Any

Id Name Description Type
Default 
Value

Allowed Values

Processor Settings

CSV ( )csv
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extension
File 
extension

  String csv Any

delimiter Delimiter
Column delimiter. You can use special 
characters \ + t,n,r

String , Any

rowDelimiter
Row 
delimiter

Row delimiter. Default is system-
specific line feed delimiter. You can 
use special characters \ + t,n,r

String default

default , , \n

, , \r \r\n

\n\r

header Header CSV header settings String top
none , , top

bottom

headerFormat
Header 
format

Header format String label

label , 
, description

both

escape
Characters 
escape

Bad characters escaping model 
(surrounded with quotes or escaped 
with '\' character)

String quotes quotes , escape

quoteChar
Quote 
character

Character which will be used to quote 
strings (space means no quote)

String " Any

quoteAlways
Quote 
always

Quote all cell values. Cannot be used 
with "quoteNever"

String disabled

disabled , all

, , strings

all but numbers

, all but nulls

quoteNever
Quote 
never

Do not quote cell values. Cannot be 
used with "quoteAlways"

Boolean false Any

nullString
NULL 
string

String which will be used instead of 
NULL values

String Any

formatNumbers
Format 
numbers

Format numeric values using locale 
settings

Boolean false Any

Id Name Description Type
Default 
Value

Allowed 
Values

upperCaseTableName Force upper case table name   Boolean true Any

upperCaseColumnNames
Force upper case column 
names

  Boolean true Any

extension File extension   String xml Any

includeNullValues Include NULL values in export   Boolean true Any

nullValueString Replace NULL values with   String [NULL] Any

Id Name Description Type
Default 
Value

Allowed 
Values

extension File extension   String html Any

Output table Output query or table name as first row in 

DbUnit ( )dbunit

HTML ( )html
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tableHeader header generated table Boolean true Any

columnHeaders
Output column 
headers

Output column names as extra row in 
generated table

Boolean true Any

extractImages Images Extract images to graphic files Boolean true Any

Id Name Description Type Default Value Allowed Values

printTableName Print table name   Boolean true Any

formatDateISO Format dates in ISO 8601   Boolean true Any

extension File extension   String json Any

Id Name Description Type
Default 
Value

Allowed 
Values

extension File extension   String md Any

nullString NULL string
String which will be used instead of NULL 
values

String Any

formatNumbers
Format 
numbers

Format numeric values using locale 
settings

Boolean false Any

showHeaderSeparator
Show header 
separator

Print header separator (---). Required for 
GitHub markdown.

Boolean true Any

confluenceFormat
Confluence 
format

Use Confluence format (special format of 
header and no separator line)

Boolean false Any

Id Name Description Type
Default 
Value

Allowed Values

includeAutoGenerated

Include 
generated 
columns

Include auto-generated 
columns (e.g. auto-
increment) in SQL 
INSERT

Boolean false Any

extension
File 
extension

  String sql Any

nativeFormat

Native 
date/time 
format

Use native date/time 
format in INSERT 
statements

Boolean true Any

omitSchema

Omit 
schema 
name

Omit schema/catalog 
name in INSERT 
statements

Boolean false Any

rowsInStatement

Data rows 
per 
statement

Number of data rows per 
single insert statement

Integer 10 Any

Insert line Insert line feed before 

JSON ( )json

Markdown ( )markdown.table

SQL ( )sql
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lineBeforeRows before 
rows

values (for multi-row 
inserts)

Boolean true Any

keywordCase
Keyword 
case

You can choose lower or 
upper keyword case

String upper upper , lower

identifierCase
Identifier 
case

You can choose lower or 
upper keyword case for 
table and column names

String as is as is , , upper lower

upsertKeyword
Upsert 
keyword

You can choose different 
upsert keywords

String INSERT

INSERT , , INSERT ALL

, UPDATE OR UPSERT INTO

, , REPLACE INTO

ON DUPLICATE KEY UPDATE

, ON CONFLICT

insertOnConflict

On 
conflict 
expression

Expression for the end of 
the statement. Enter the 
required value in this 
field.
This is database specific 
setting

String Any

Id Name Description Type Default Value
Allowed 
Values

language Language Programming languages String PHP &lt; 5.4
PHP &lt; 5.4

, PHP 5.4+

formatDateISOPHP
Format dates 
in ISO 8601

  Boolean true Any

extension File extension   String php Any

quoteChar
Quote 
character

Character which will be used to 
quote strings

String " " , '

rowDelimiter Row delimiter

Row delimiter. Default is 
system-specific line feed 
delimiter.
You can use special characters 
\ + t,n,r

String default

default , \n

, , , \r \r\n

\n\r

Id Name Description Type Default Value Allowed Values

extension File extension   String txt Any

batchSize Batch size   String 200 Any

minColumnLength Min column length   String 3 Any

maxColumnLength Max column length   String 0 Any

showNulls Show NULLs   Boolean false Any

delimHeader Show header delimiter   Boolean true Any

delimLeading Show leading delimiter   Boolean true Any

Source code ( )source.code

TXT ( )txt
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delimTrailing Show trailing delimiter   Boolean true Any

delimBetween Show in-between delimiter   Boolean true Any

Id Name Description Type Default Value Allowed Values

extension File extension   String xml Any

Id Name Description Type
Default 
Value

Allowed Values

extension
File 
extension

  String xlsx Any

rownumber

Row 
number
(s)

Set row index as first column Boolean false Any

border
Border 
style

Cell borders style String THIN NONE , , THIN THICK

nullString
NULL 
string

String which will be used 
instead of NULL values

String Any

header

Column 
names 
as 
header

Use column name as first row Boolean true Any

headerfont
Header 
row font

First row font properties String BOLD
NONE , , , BOLD ITALIC

, STRIKEOUT UNDERLINE

trueString

Boolean 
string 
TRUE

String which will be used 
instead of TRUE boolean values

String true Any

falseString

Boolean 
string 
FALSE

String which will be used 
instead of FALSE boolean 
values

String false Any

exportSql
Export 
SQL

Export SQL to a second sheet Boolean false Any

splitSqlText
Split 
SQL Text

Split exported SQL on rows by 
CR

Boolean false Any

splitByRowCount
Max row 
on sheet

Split by row count Integer 1048575 Any

splitByColNum
Column 
group

Column number for grouping 
rows on sheet by column value

Integer 0 Any

dateFormat

Excel 
date 
format

Excel date and time format (e.
g. m/d/yy h:mm) it can be 
changed in Excel application

String m/d/yy

m/d/yy , , d-mmm-yy

, , d-mmm mmm-yy

, h:mm AM/PM

, , h:mm:ss AM/PM h:mm

, h:mm:ss m/d/yy h:mm

XML ( )xml

XLSX ( )xlsx
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To enable interactive debugging of PL/pgSQL procedures on a Postgres server, you need to use the _plugin
. The _plugin  is a typical interactive debugger delivered as an extension. It requires a shared debugger debugger

library preload in Postgres to operate the shared_preload_libraries parameter in the settings. The debugger is 
developed and maintained by EDB. Its source code is available for examination and improvement.

The debugger provides the required server API for debugging PL/SQL procedures with:

Breakpoint management;

Step-by-step tracing;

Variable acquisition and management.

If you happen to have a PostgreSQL 12 installed via , then the procedure is quite straightforward:apt

sudo apt install postgresql-12-pldebugger
sudo service postgresql restart

After that, run the following command in the database or databases that you wish to debug functions in:

CREATE EXTENSION pldbgapi;

You can find the source code in . Installation instructions are located in the README file.this repository

Open the source code of the function you want to debug. To toggle breakpoints, place the caret on the line you 
want the function to be stopped at and use a shortcut . Alternatively, you can toggle the Shift + Control + B

breakpoint with your mouse by clicking on a ruler, as demonstrated in the screenshot below:

PostgreSQL Debugger

Prerequisites for Debugging

Installation

PostgreSQL 12 on Ubuntu-based distros

Installation from source code

Running debugger in the DBeaver interface

https://github.com/EnterpriseDB/pldebugger
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NB. You must only toggle the breakpoints when  option is  on.Show header not

Then you need to set up a debugging configuration. Locate the downward-facing arrow right to the bug icon, click 
on it, then

Debug As -> :Database Debug

The  dialog opens. Set up input values in the table .Edit Configuration Function parameters
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Click on  button, and you are ready to go!OK

The usual buttons essential for debugging such as  and  are located here:Step Over Continue
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ER diagrams appear on the rightmost tab of the :Database Object Editor

Entity Relation Diagrams (ERD) are graphic presentations of database entities and the relations between them. 
DBeaver allows you to view the diagrams of existing tables and whole database schemas, see Database Structure 

. DB also allows the creation of custom diagrams, see .Diagrams Custom Diagrams
By default DBeaver uses  notation.IDEF1X

Both types of diagrams provide the same tools to adjust their view and structure. They can be printed and 
exported to image file formats.

You can use one of the two tools to select elements in diagrams:

Select – supports both, single and multi-select modes. To select a single element (table, connection, entity 
inside a table) in a diagram, just click that element. To select multiple elements, similar to using the Marquee 
tool, click outside the first element and draw until all elements you need are in focus:

ER Diagrams

Selection of Elements in Diagrams

https://en.wikipedia.org/wiki/IDEF1X
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NOTE: All changes to existing database schemas cannot be saved and are intended for exploration purposes only.
You can do the following structural changes in the diagrams.

Add new tables to a diagram by drag-n-dropping them onto the diagram field from the .Database Navigator

Rearrange tables in the diagram by dragging them all over the space. You can select several tables and drag 
them to a new location.

Auto-arrange tables into a compact view after manual rearrangements: click the  ( ) in the Arrange Diagram
toolbar or on the context menu (right-click anywhere on the diagram tab).

(Available for  only) - connect tables with a connector: click the  button ( ) in Custom Diagrams Show Palette
the upper-left corner of the diagram tab and then, in the Palette panel, click :Connection

Now click the tables that you want to connect with each other in turn, one by one. To stop the connection line, 
double-click the last table

(Available for  only) - removes tables and connections: right-click the table or conection and Custom Diagrams
click  on the context menu or just click the table or connection and press .Delete Delete

Structure Adjustment
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You can adjust the view of any diagram in the following ways:

Enable/disable the diagram grid: Click  ( ) in the toolbar.Toggle Grid

Modify attributes visibility: Right-click the diagram and, on the context menu, click  and then Show Attributes
select one of the options:

All - all attributes

Any keys - primary and foreign keys

Primary key - only primary keys

None - no attributes

Modify attributes presentation: Right-click the diagram and, on the context menu, click  and then View Styles
select one of the options:

Show Icons

Show Data Types

Show Nullability

Show Comments

Show Fully qualified names

Change the color of the entities/notes: Right-click the header of the entity or comment and then click  Set color
on the context menu. Then you can select the color and click .OK

For elements located in front of/behind others, bring an element to the front or send it to the back: Right-click 
the element and then click  /  on the context menu.Bring to front Send to back

Zoom the diagram in/out: Click the /  buttons or choose the scaling value in the dropdown Zoom In Zoom Out

list in the toolbar: 

To see changes made by others to the database schema, you might need to refresh the diagram: click Refresh 

 ( ) in the toolbar.Diagram

You can create notes only in . To create a note, click the  button ( ) in the upper-Custom Diagrams Show Palette
left corner of the diagram tab. Then, in the Palette panel, click  and click anywhere in the diagram tab. Now Note
you can double-click the  box to enter the note text:Note

View Adjustment

Refresh

Notes
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To search among entities of a diagram, click the  button ( ) in the toolbar, then type in the search Search items
combination. The entities that contain the search combination are highlighted in the diagram. To remove the filter, 
click the cross icon next to the search field.

Use  to navigate between tables.ARROWS

Press |  +  to select multiple tables.SHIFT # ARROWS

Press |  +  to select additional tables using .CTRL # ARROWS SPACEBAR

Press  to select the current table.SPACEBAR

Press  (period) to change the mode to move/resize tables, then use  and |  to move/resize . ARROWS ENTER #

tables.

Note: To use this feature on macOS, you may need to enable accessibilitу permissions for DBeaver. This can be 
done in .System Preferences —> Security & Privacy —> Accessibility

Press |  to focus on attributes in the table.ENTER #

Press |  to leave the focus.BACKSPACE #

Search in Diagram Entities

Bindings

Navigation and selection:

Table Manipulation:

Focus:
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Use , ,  to focus on associations.| ? \

Press |  to focus on the diagram.ALT/FN + 1 #/FN + 1

Press |  to focus on the palette.ALT/FN + 2 #/FN + 2

Press |  to focus/open the outline.ALT/FN + 3 #/FN + 3

Press |  to focus on the parameter view.ALT/FN + 4 #/FN + 4

Press  |  to open the selected table diagram.CTRL + ENTER # + #

You can export (save) a diagram as an image (PNG, GIF, BMP formats) or as a file in GraphML format. To export 

a diagram, click  ( ) in the toolbar.Save diagram in external format

To print a diagram, press  or click  ( ) on the toolbar.CTRL+P Print Diagram

To modify the diagram settings, click  ( ) on the toolbar.Configuration

Other Functions:

Diagram Export

Diagram Printing

Settings
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You can view a database structure in the standard ERD (Entity Relation Diagram) form. ER diagrams are available 
for all tables and schemas (databases).

The ER diagram for a table shows the table itself and its relations with other tables inside the schema. To view the 
ER diagram for a table or view, double-click the table or view in the  and then, in the Database Navigator Database 

, switch to the  tab:Object Editor ER Diagram

To view the ER diagram for a full database schema, double-click the schema name in the Database Navigator or 
the previous node in the path (usually - ):Tables

Database Structure Diagrams
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NOTE: Table and schema diagrams are read-only. You can rearrange the layout, drag-n-drop elements inside a 
diagram but you cannot save the changes state or delete/add anything. This is because the diagrams represent 
the actual state of databases.

Lines representing the relationship between tables can look different depending on the nature of the relationship. 
Please note that any line can have only one beginning and one end. We may have links between two tables not 
only for one pair of attributes, which means that several associations will be displayed:

Relationship Notation
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Notation Description

A solid line means that the foreign key column in one table is a primary key in another table

A dashed line means that the foreign key column is not a primary key but a regular column in another table

A black dot is used as the start of the line

A diamond is used at the end of the link when the column in the source table is optional (there is no NOT NULL)

A one-to-one relationship is always a solid line due to the unique primary key - foreign key relationship:
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A dashed line is for the one-to-many relationship:
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1.  

You can create custom ER diagrams that can contain any tables, relations and notes.
However, even custom diagrams may contain only real existing database entities (tables).

You can create a custom diagram in one of the ways:

On the DBeaver main menu, click . Then in the new diagram wizard, click File -> New DBeaver -> ER Diagram
, and then :Next

Custom Diagrams
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2.  In the  view, right-click the  node and then click  on the Project Explorer ER Diagrams Create New ER Diagram
context menu.

In both cases, in the Diagram Create Wizard, specify the diagram name and (optional) choose the initial diagram 
contents (set of tables):

The new diagram appears in a separate editor. Now you can drag-n-drop any number of tables into it. You can 
add tables from different connections as well as from different database types (for example, combine Oracle and 
MySQL tables in one and the same diagram).
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1.  

2.  

3.  

You can also add notes and custom relations (associations) using the ERD palette on the left side of diagram tab - 
see details in the  article. For example, to create a diagram similar to the one shown at the beginning ER Diagrams
of this article, you need to:

Add required tables and relationships between them and move them around to create a well-shaped structure 
(see  section of the  article).Structure Adjustment ER Diagrams

Add notes (see the  section of the  article).Notes ER Diagrams

Stretch the notes to cover the intended tables, then send the notes to the back, and then set a color to the 
tables and notes (see the  section of the  article).View Adjustment ER Diagrams

Undo/redo functions are fully supported in diagram editing.
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Note: This feature is available in ,  and  editions only.Enterprise Ultimate Team

Edit mode for ER Diagrams is a special feature that lets you create database objects while using the visual 
presentation of ER Diagrams. It can be accessed on the ERD tab of any database object that supports it. Changes 
made to a diagram in edit mode will generate an SQL script that can be executed to persist all the changes made. 
You can enable Edit mode by either choosing it from the context menu or by clicking a button on the bottom 
toolbar.

To create an object you need to right-click on the diagram and select an object that you want to create. Foreign 
keys are created similarly to virtual foreign keys in custom diagrams. Just drag a column from a table for which the 
foreign key is being added and drop it in the referenced table. This will open a window that lets you choose a 
unique key in the referenced column.

Edit mode

Working in Edit mode

https://dbeaver.com/dbeaver-team-edition
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Saving changes to a database is performed by clicking a save button. This will show you a preview of a generated 
script that you then can execute or cancel. The revert button will cancel all the changes that you did to a diagram 
after the last save.
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DBeaver provides:

File search (search among file contents)

Database full-text search

Database metadata search

To use search, click the Search button on the main toolbar:

Please see the dedicated articles for information about searching for different types. This article describes 
common features of the three search types.

Search results for any of the search types appear in a separate Search view. The following image shows the 
Search view for the database full text search:

The view contains a toolbar that provides common tools for all types of search as well as specific tools for the File 
Search type. The following are common tools:

Button Name Description

Run the 
Current 
Search 
Again

Refreshes the search results

/
Cancel 
Current 
Search

- Active state (red) indicates that the search is still in progress and appears if the search takes some 
time to complete. Clicking the button in this state stops the current search.
- Inactive state (grey) indicates that the search is complete. The button in this state is non-actionable.

Show 
Previous 
Searches

- Clicking the button itself opens the Previous Searches window.
- Clicking the arrow next to the button opens a dropdown menu.
See the  section further in this article.Search History

Pin the 
Search 

Ties the current search results to the Search view. If you click this button, the current results stay in 
the view while the results of the next search appear in a new Search view. Otherwise, every new 

Search

Search View
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View search replaces the previous results with new results.

For information about specific tools of File search, see the  article.File Search

If the search is short, the results appear almost instantly. But if it takes some time, the Search view indicates the 
progress in the following ways:

The  button in the toolbar has the Active state ( )Cancel Current Search

The progress bar appears in the bottom-right corner of the view indicating the process: 

The button to show the search progress in a separate view ( ) appears in the bottom-right corner of the 
view next to the search progress bar. Clicking the button opens the Background Tasks view:

DBeaver stores the history of search queries made during the current session. You can reopen the Search view 
with results of a previous search query. You can also remove individual queries and clear the history. To manage 

the search history, use the  button in the toolbar ( ).Show Previous Searches
To open the results of a previous search query, do one of the following:

Click the arrow next to the  button in the toolbar and then click the query in the Show Previous Searches
dropdown list:

Click the  button itself or the arrow next to it and then  on the dropdown menu Show Previous Searches History
to open the Previous Searches window. Then, in the window, click the query and then either click  to Open
open it in the active Search view or click  to open it in a new view:Open in New

Search History
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1.  

2.  

3.  

To remove one or more of the previous search queries:

Click the  button in the toolbar or click the arrow next to it and then  on the Show Previous Searches History
dropdown menu. The Previous Searches window opens.

Click the query to remove or select several of them by clicking and simultaneously holding the  key.Ctrl

Click .Remove

To clear the history by removing all previous queries, click the arrow next to the  button Show Previous Searches
on the toolbar and then click  on the dropdown menu.Clear History
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To search file contents for a string, click the Search button on the main toolbar or the arrow next to the Search 
button and then  on the dropdown menu:File Search

The Search window opens displaying the File Search tab:

You can apply a case sensitive search, search by regular expressions, search among particular file types (File 
 field), and use the find and replace function.name patterns

After you click , the results appear in a  view. The results represent a tree or list of files with the Search Search
search combination highlighted:

File Search
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The toolbar of the Search view for File search provides more tools in addition to those available for all search 
types:

Button Name Description

Show Next / Previous 
Match

Open the file in a separate viewer and move the highlight to the next/previous match, 
respectively

Remove Selected 
Matches

Removes selected row (row in focus) of the results

Remove All Matches Removes all results in the view

Expand/Collapse All Expand/collapse the tree of results

The view also provides a view menu (click the  button ( ) in the upper-right corner of the view) that View Menu
contains the following items:

Menu item Description

Show as List Presents the results in the form of list

Show as Tree Presents the results in the form of tree

Filters Opens Search Filters dialog box

Preferences Opens the Preferences window on the Search page

Double-clicking a results row opens it in a separate viewer.
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To do a full text search in the database, click the arrow next to the Search icon in the main toolbar and then click 
 on the dropdown menu:File Search

Alternatively, you can click the  button on the main menu and then click the  tab in the Search Search DB Full-Text
window:

Now you need to choose the database connection or database objects against which to run the search – expand 
the tree in the  field to the database connections level or further down and select the checkboxes next Databases
to the required connections or database objects.
NOTE: The  button is enabled only when you select the right level of checkboxes – database connections Search
or lower nodes.

You can apply a case-sensitive search, fast search and search in numbers and LOBs.

After you click , the results will open in  view:Search Search

DB Full-Text Search
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Double-clicking a row in the Search view opens the respective object in a dedicated .Database Object editor
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To search for database metadata, click the arrow next to the  button in the main toolbar and then click Search DB 
 on the dropdown menu:Metadata Search

Alternatively, you can click the  button on the main menu and then click the  tab in the Search Search DB Metadata
window:

Now you need to choose the database connection against which to run the search. You only need to select the 
database connection(s) in the  field.Objects Source
In the  field, you can select the database objects among which DBeaver will run the metadata search Object Types
– select or clear the checkboxes.
You can specify that the object name starts with, contains or is similar to the search combination (  Name match
field). You can also set the maximum number of results to display (  field) and apply  Max results Case-sensitive
search.

After you click , the results will open in a  view:Search Search

DB Metadata Search
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Double-clicking a row in the Search view opens the respective object in a dedicated .Database Object editor
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NB: This feature is available in ,  and  editions only.Enterprise Ultimate Team

Supported databases

How it works

What is possible to compare

Compare logs

Liquibase changelog generation

Save comparison as a task

Using schema compare with Liquibase PRO key

Additional object types in Liquibase PRO

----------------------- -----------------------

Cockroach Oracle

Databricks PostgreSQL

DB2 Redshift

Derby SAP HANA

EnterpriseDB Snowflake

Firebird SQLite

Greenplum SQLServer

Informix Teradata

MySQL
/MariaDB

Vertica

Netezza YugabyteDB

DB2i

You can compare two schema/database structures and generate a report in the following formats:

DDL script (series of create/alter/drop statements)

Diff diagram (sort of ER diagram)

Liquibase changelog

Schema compare

Databases supporting schema comparison

How it works

https://dbeaver.com/dbeaver-team-edition
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1.  

2.  

3.  

Liquibase change report (JSON, YAML, or plaintext)

In most cases, you can compare . However, some databases (such as SQLite and schemas, databases, or tables
Firebird) do not have catalogs and schemes that can be compared. In this case (and only for these databases), it 
is possible to compare the entire .datasources

Usually, you can compare the following database objects: , and so on columns, primary keys, foreign keys, indexes
(it depends on your database). If you want to compare , such as more objects check constraints, procedures, 

, you need to enable .functions, triggers Liquibase PRO

Select the two objects (schemas, databases, or tables) you want to compare in the .Database Navigator

Open the context menu.

Open the sub-menu  and click the . You'll see the comparison Compare/Migrate Compare/Migrate Schema
window.

Re-validate that you have chosen the correct objects to compare. You can change target and source containers by 
clicking the .Swap sources

What is possible to compare

How to use schema compare

Step1. Select two entities to compare

Step 2. Check the selected entities
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Note: You must select only those schemas/directories/containers that contain tables:

Schemas – if the database supports schemas.

Databases – if the database supports catalogs and does not support schemas.

Datasources – if there is no support for schemas or catalogs.
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1.  

2.  

3.  

4.  

If everything is correct, click . You'll see the comparison settings.Next

If you want to export the comparison result in a file, select  option, then specify the Export result to the file
folder and file name. You can use variables in the file name. Click on the field with a file name to see a list of 
available variables.

Select the report format in the  field.Report Engine

You can simply exclude specific types of objects from comparison.
For example, it is possible not to show sequences, views, or external keys in the final comparison result.

You can also specify which changes should be processed: create, drop, or alter. By default, all kinds of 
changes are enabled. If you do not want to compare objects with equal names but in different cases (like 
"test" and "TesT"), enable the . (Note: This settings section is unavailable for the Case insensitive compare
generation changelog process.)

Step 3. Specify compare settings
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Click  to generate a diff report.Proceed

By default, DDL diff is generated. It contains a series of creating, altering, and/or dropping statements that will 
modify the schema on the right side. Thus it will make it identical to the schema on the left side.

You can enable/disable certain changes in the tree on the left side of the diff page:

Use the  button after objects change in the left tree to refresh the report on the right side.Refresh Report

You can view all changes in the SQL Editor with the help of the  button.Open in Editor

If you are sure that compared changes should be applied to a target container, click the  button. And all Migrate
generated SQL statements will be executed in a target container.

You can select another diff report representation (diagram, JSON, YAML, plaintext) in the .Report type

Click . That's it. Your report is saved.Save

Step 4. Look at the comparison results and save the report
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For the objects in the report to be dressed in quotation marks, select the  option in Quote all objects names

Preferences.

To get acquainted with the comparison logs, you first specify the logging level on the Preferences-> Editors-> 
 preference page. Specify one of the logging levels and click on . By default, the logging Schema Compare Apply

level is the OFF level. To get complete information, you can choose the DEBUG level.

Quote objects names in the report

Compare logs
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After comparing operations, click the  button. A log will be open in the Editor, and the content of this log Show log

will depend on the logging level you choose in the settings. Log level сhanges from preferences will not be applied 
to the comparison wizard if it is already open in another window. Close and open the schema compare wizard in 
this case.

Liquibase Changelog generation
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Suppose you want to create a report about the objects in your table container (similar to the metadata dump 
operation). In that case, you can select in the navigator tree on your container  -> Compare/Migrate

 command.Liquibase changelog

One or several table containers can be chosen. The report will contain creation statements of tables/views/keys
/sequences - metadata from the table containers. But without data from tables/views. You can use this report in 
the future to restore the structure of your database.
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If you plan to constantly use the comparison or generation changelog/schema comparison, exporting the result as 
a file, you can save this as a task. The task can be completed anytime and put on the .schedule

Also, generating a changelog or schema comparison can be part of the . For example, if you keep composite task
the log as a script with a certain name, then the implementation of this script can be set by the second operation of 
the composite task.

Save operation as a task
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If you have a Liquibase PRO key, then you can use it with DBeaver. Steps you need:

Find and open your dbeaver.ini file. It is located in the DBeaver root directory.

Find -vmargs command

Add a new line after this command: -Dliquibase.license.key=yourKey (example: -Dliquibase.license.
key=ABwwGgQU...)

Open DBeaver and the "Schema compare" window. The key will be checked at this step.

You can also add the Liquibase Pro key via UI in Preferences->Editors->Schema Compare preference page. Use 
the  button to open the Import key dialog.Import Liquibase Pro Key

You can manually add your key in the Liquibase Key text field, throw the  button, or use the  button to Paste Load

download a file. You can check the license state with the  button. After pressing the button, you Check Key State

can see the result of the checking in the  field.Messages

Using schema compare with Liquibase PRO key
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We suggest you restart the program after adding a key for the correct program work. Settings сhanges will not be 
applied to the comparison wizard if it is already open in another window. The key will be saved in the DBeaver 
settings. If you specify the key in the .ini file and install another key through the Import Key dialog, the key from the 
.ini file will be in priority.

If the license key is valid, the  dialog will be extended to PRO objects. (If PRO objects didn't appear Object types

in the schema compare changelog - check your logs. Maybe the license expired, or the key is invalid)
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Check Constraints

Procedures

Functions

Triggers

Synonyms (Oracle)

Package with the body (Oracle)

Object types being compared by LiquibasePRO
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1.  

2.  

3.  

4.  

Sometimes you need to compare data from two sources (tables) which have almost identical data with just a few 
differences. There may be plenty reasons to do so: quickly visualize and navigate through all the differences; copy 
different rows or individual values; export them using .Data Transfer

This feature is available in DBeaver PRO.

You will need to choose one or two desired tables in the  - it may be the tables from the Database Navigator
same databases or from different databases or even from different RDBMS (e.g. PostgreSQL and MySQL).

Then choose  #  #  from the menu and the Data Database Compare/Migrate Data Compare
Compare Wizard will appear. Here you can preview selected tables or choose other ones. Then you can 
navigate to the second page.

On the second page you should choose the columns that will be used as a  during the comparison unique key
(the amount of columns must be equal). If the  chosen are wrong, it may lead to invalid results. By keys
default, if the table has a unique key in it, it will be chosen automatically during the initial setup: 

Without unique keys the rows cannot be compared properly, since there is no way to distinguish between 
individual rows.

After reaching the last page, you can tweak limits (e.g. you only care about the  first rows) and exclude N

categories of the resulting rows (e.g. you are not interested in modified rows). Also, you can press the Save task
button to save the configuration in  to use it later, or  it.Task Schedule

Data compare

Preparing the tool

Changing columns mapping
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If tables you want to compare have different ordering, naming or quantity of columns, you can tweak their 
mappings and/or entirely skip columns you're not interested in:

Please note that this page only features columns that aren't used as primary key configured on a previous page.

Pressing the  button will attempt to link columns with same names.Auto assign

After finishing the wizard, you can press the  button to begin the actual comparison process - it may take Start
some time depending on the databases you are comparing, the amount of data in them, and your network speed 
(*).

Viewing the results
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1.  

2.  

When the results are ready, DBeaver will play a  sound, and the editor will open: beep

Here you can examine the differences, swap the panels using the  button in the toolbar, or Swap Containers
preview the summary including the statistics by using the  button in the toolbar too. Everything Show Summary
you can do in the regular data editor is possible to perform here - you can copy data or transfer it to another 
database, except modify the values.

* - Please note that the actual preview is only available when Data Compare is launched through the wizard - 
otherwise only the statistics will be written into the .Task Log

You can export results as an SQL script containing statements that will turn the second table into the first one by 
-ing unrelated rows, -in new ones, and -ing existing ones, so the data will look the same.DELETE INSERT UPDATE

You can export results either by:

Setting the  option found on the last pageExport compare results to file

Pressing the  button found in the compare viewerPreview SQL diff

This section is under construction. It will include information about the engine's implementation details and more.

Exporting the results

Under the hood
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Note: since version 6.2 MockData generator extension is available only in , , and  editions.Enterprise Ultimate Team

Sometimes in software development we need to generate mock, but valid, data for testing. Populating a database 
manually is a time-consuming and exhausting process. It can be very complicated when you need to generate not 
just 5–10 users, but thousands of entities of different types. DBeaver Mock Data generator helps you generate test 
data much easier.

Disclaimer: The idea behind Mock Data is to generate mock data in a table but it should NOT TO BE USED 
. Please make sure you have a backup of your database before running IN PRODUCTION ENVIRONMENTS

the Mock Data generation process.

Th following are features of the DBeaver Mock Data generator:

Works for all the RDBMS that are supported by DBeaver (DB2, MS SQL Server, MySQL, Oracle, 
PostgreSQL, SQLite, etc.)

MockData generation

https://dbeaver.com/dbeaver-team-edition/
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Generates data that matches your database schema:
Generated data matches the database column types.

All base data types are supported.

Constraints (PK, FK, multi-column FK, unique) are supported.

Supports over 20 configurable data generators (constants, randoms, sequences, names, domains, 
addresses, prices, regex based, etc.)

Automatically associates a column with a generator based on the column characteristics

Saves or overwrites old database data

The following are mock data generators for data types with their configurable parameters:

Boolean
Random

Sequence (initial, order)

Date
Random (start, end)

Sequence (start, step, reverse)

Numeric
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Random

Sequence (start, step, reverse)

Advanced (min, max, precision, scale) *

Price preset *

Coordinate preset *

String
Text (template, min length, max length)

UUID

Address *

City *

Country *

Domain *

Email (gender, with surname, numeric suffix) *

Name (gender, with surname) *

Price (country, min, max) *

Regex based random (regex template) *

Credit Card preset *

Email preset *

Gender preset *

HEX Color preset *

IP4 address preset *

IP6 address preset *

Phone Number preset *

Postal Code preset *

Price preset *

Template with parametrized directives for other generators :*

address() - US postal address

city() - one of the world's largest cities

country() - country
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domain() - one of the top Internet domains

email(gender,surname) - e-mail address (gender is ALL|FEMALE|MALE, surname is true|false)

name(gender,surname) - personal name (gender is ALL|FEMALE|MALE, surname is true|false)

random(minimum,maximum) - random integer

regex(pattern) - regex based value for the pattern

sequence(start,step) - sequence of integers

NULL values

FK - data from the referenced table according to the constraint
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* These features are available in  and  editions only.Enterprise Ultimate
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Note: This feature is available in , ,  and  editions only.Lite Enterprise Ultimate Team

DBeaver's spelling function is a feature designed to detect spelling errors. It allows you to change the incorrect 
words, upload custom dictionaries in any language and it provides you with advanced options for a more refined 
text management experience.

The spelling function is accessible in your SQL script files. Words that are not spelled correctly are underlined, 
which will alert you to potential inaccuracies.

To change these incorrect words, open the context menu by right-clicking on the word and selecting  or Quick Fix
by using the  (or  for Mac OS).Ctrl+1 #1

The context menu offers several options:

Change the incorrect word with to a suggested word.

Add the word to the dictionary.

Ignore the word during the current session.

Disable the spell checking entirely.

To apply any of these changes, you need to double-click on the chosen option with the left mouse button or press 
the  key.Tab

To open the settings for the spelling page, navigate through the following steps:  ->  ->  Window Preferences Editors
->  -> .Text Editors Spelling

Spelling

Usage

Settings

https://dbeaver.com/dbeaver-team-edition
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The spelling function is enabled by default but can be customized to your requirements.

You can disable the spelling function by unchecking the box next to  in Preferences.Enable spell checking

DBeaver's spelling settings provide specific options for this feature that can be tailored to your needs.

Option name Description

Ignore words with digits Skips words containing numbers.

Ignore mix case words Skips words with combined upper and lower case letters.

Ignore sentence capitalization Skips words starting with a lowercase letter at sentence beginnings.

Ignore URLs Excludes web addresses from spell checking.

Ignore words shorter than 4 letters Disregards shorter words from spell checking.

Activation

Options

Custom Dictionaries
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DBeaver includes an integrated English dictionary. However, you can choose to disable it and connect your 
custom dictionary, or use both simultaneously, according to your needs.

In DBeaver's spelling settings you can add your own custom dictionary by specifying the path to it in the User 
 field. This dictionary should be a  file with one word per line.defined dictionary .txt

To disable the custom dictionary, clear the  field and apply the changes.User defined dictionary

You can adjust the . This setting controls the number of suggested Maximum number of correction proposals
substitutions that appear in the context menu for each misspelled word.

Also, you can specify the . This setting determines the total number Maximum number of problems reported per file
of words, starting from the first one, that the system will flag for replacement in each file.

Advanced Settings
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Dashboards tool allows DBAs and programmers to quickly identify performance, disk space issues, the number of 
connections and other important KPIs associated with a single database connection. To learn more about 
database connections, see .Database Connections

By default, DBeaver is delivered with a number of predefined sets of dashboards for such data bases as 
PostgreSQL, MySQL, Oracle and Exasol. Custom dashboards are also supported. To learn more about custom 
dashboards, see the Managing Dashboards section below.

Dashboards panel is a collection of real-time dashboards, which are dashboards that are updated continuously. 
Dashboards displayed on the dashboards panel are actually a combination of continiously run SQL SELECT 
queries and charts continiously built on the data fetched.

To open the dashboards panel press the  button  on the main toolbar. The default Open Dashboard
configuration of the dashboards panel for the current database connection will appear. To learn more about 
database connections, see .Database Connections

You can also right-click a connection name in the  editor and select the  Database Navigator Open Dashboard
menu option or use the keyboard shortcut + + +  and the dashboards panel will be opened.Ctrl Alt Shift B

Dashboards, DB monitoring

Managing Dashboards Panel

Opening Dashboard Panel
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The following controls are available on the dashboards panel toolbar:

Icon Name Description

Settings Opens dashboard's configuration.

Add dashboard Adds dashboard to the dashboard panel.

Remove dashboard Removes dashboard from the dashboard panel.

Reset dashboards Restarts dashboard's calculation.

To add a dashboard to the dashboards panel, press  button  on the dashboards panel's toolbar, Add dashboard
choose one of the dashboards from the list of available dashboards and press the  button.Add

Adding Dashboards



DBeaver User Guide 23.1. Page 225 of 526.

Note: Different databases have different sets of predefined dashboards. DBeaver is delivered with sets of 
predefined dashboards for such databases as Postgress SQL, MySQL, Oracle, and Exasol. It is also possible to 
create new custom dashboards, for more details see Managing Dashboards.

You can also add a dashboard by right-click in any place of the dashboards panel and then select the Add 
 menu option.dashboard

To remove a dashboard from the dashboards panel, click on the dashboard you want to remove and press button 

  in the dashboards panel toolbar or select  option in the dashboard's Remove dashboard Remove dashboard
context menu.

Removing Dashboards
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If you want to restart the dashboard's calculation you can reset it.

You can reset all the dashboards displayed on the dashboards panel by a single click on   Reset dashboards
button on the dashboard panel's toolbar.

To reset a particular dashboard right-click on it and select  menu option or left click a dashboard Reset dashboards
and press  button on the dashboards panel's toolbar.Reset dashboards

To adjust dashboard representation settings, right click on a dashboard and select the  menu option, then, Settings
in the opened dialog change the parameters you want.

Resetting Dashboards

Changing Dashboard Representation



DBeaver User Guide 23.1. Page 227 of 526.

The following dashboard representation parameters can be adjusted:

Parameter Description

Name Defines a name of a dashboard.

Description
Defines dashboard's description. Use this field to make it easy to understand what kind of information the 
dashboard represents.

Update periods
(ms)

Defines how often dashboard's rendering should be updated. The default value is 1000 ms.

Maximum items Defines maximum number of fetched items. The default value is 300.

View Defines visual representation of the dashboard. The following options are available: Bar, Pie, Time series.

Show legend If this check-box is selected, the legend will be displayed on the dashboard.

Show grid If this check-box is selected, the grid will be displayed on the dashboard.

Show domain 
axis

If this check-box is selected, the domain axis will be displayed on the dashboard.

Show range 
axis

If this check-box is selected, the range axis will be displayed on the dashboard.
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To adjust dashboard's configuration settings right-click on a dashboard, select the  menu option, then, in Settings
the opened dialog box press the  menu option.Configuration

The following dashboard parameters can be configured:

Parameter Description

ID Defines dashboard's ID. Make sure that ID has numeric values in it.

Name Defines dasboard's name.

Database Defines the database driver. To learn more about database drivers, see .Database Drivers

Defines the data type. The following options are availabe: timerseries (the default option) and statistics. Select 

Adjusting Dashboard Configuration
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Data type timeseries type if you want to track the actual value returned by the server. Select the statistics type if your 
dashboard will show historical data.

Calc type

Defines how the data should be calculated. The following options are available: value (the default option) and 
delta. Select value if you are interested in the current value. Select delta if you want to track the difference 
between the current value and the previous one. This may be very useful when you work with statistics data, for 
example.

Value type
Defines the value to be shown on the range domain. The following options are available: decimal (the default 
option), integer, percent, bytes. Choose the value type in accordance with your data, for example, memory 
usage is convinient to be tracked in KBytes.

Interval
Defines time interval to be shown on the domain axis. The following time intervals are available: millicecond(the 
default option), second, minute, hour, day, week, month, year.

Fetch type Defines whether the query should fetch data from rows or columns.

Description
Defines the description of a dashboard. Use this field to make it easy to understand what kind of information the 
dashboard represents.

Queries Defines an SQL query whose fetched data will be used to build the chart displayed on the dashboard.

Default 
view

Defines the default visual representation of a dashboard on the dashboard panel. The following options are 
available: Bar, Pie, Time series(the default option).

Update 
period(ms)

Defines how often the dashboard's rendering should be updated.

Maximum 
items

Defines the maximum number of items to be fetched for the dashboard.

Note: Predefined dashboards are read-only and cannot be re-configured, but you can copy them and use them 
templates to create new dashboards with any query and other settings. To learn about creating new dashboards, 
see the Managing Dashboards section.

By default, if there is no active connection to the database and you open its dashboards panel, all the dashboards 
on the panel will be empty.

You can force a database connection on the dashboard panel's activation by pressing the  button  on Settings
the dashboards panel's toolbar and then selecting the  check-box.Connect on activation

If you have several monitors and would like to place a dashboard into a separate screen, you can either detach 
the whole dashboards panel or a single dashboard, and drag-and-drop them to any place you want.

To detach the whole dashboard panel, right click on the dashboard's tab name and select the menu option.Detach

Setting Connection Prefereces

Detaching Dashboards
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To detach a single dashboard, double left click over it. You can also right click the dashboard and then, select the 
 menu option, the dashboard will be detached from the panel and you will be able to move it to View Dashboard

any place on your screen.

You can change the representation of a dashboard and view it as a Pie, Bar or Time series. To change the 
dashboard view, right click on it and select the  menu option.View as

Changing Dashboard View
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To copy a dashboard onto the clipboard, right click on the dashboard and use the  menu option. Copy to Clipboard
The screenshot of the dashboard will be placed onto the clipboard.

If you want to save a screenshot of a dashboard locally in PNG format, right click on it and select the  Save as ...
option in the context menu displayed.

Copying Dashboards to Clipboard

Saving Dashboards
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If you want to print out a screenshot of a dashboard, right-click the dashboard to be printed and select the  Print…
option.

For Time series and Bar dashboard representations the following zooming options are available on the 
dashboard's context menu:

Zoom In

Zoom Out

Zoom Reset

Printing Dashboards

Zooming
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1.  

2.  

3.  

4.  

You can extend the list of predefined default dashboards by creating your own custom dashboards. This section 
describes dashboards' list management.

You can create a new custom dashboard either from scratch or from any existing dashboards.

Press the  button  on the dashboards panel toolbar.Settings

In the opened dialog box click the  button.Manage...

In the  window click the  button.Manage dashboards New dashboard...

Set up all configurational parameters as required and press . To learn more about the dashboard's OK
configuration parameters, see .Adjusting Dashboard Configuration

Managing Dashboards

Creating Dashboards

To create a dashboard from scratch:
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1.  

2.  

3.  

4.  

Press the  button  on the dashboards panel toolbar.Settings

In the opened dialog box click the  button.Manage...

In the  window select any of the existing dashboards from the list and click .Manage dashboards Copy

Adjust all configurational parameters as required and press . To learn more about the dashboard's OK
configuration parameters, see .Adjusting Dashboard Configuration

To create a dashboard from a template:
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1.  

2.  

3.  

4.  

If you need to change the dashboard's name , ID or any other configurational setting, you can edit a dashboard.

Note: Only custom dashboards can be edited, predefined dashboards are read-only, but you can use them as 
templates and create a custom dashboard whose parameters will be editable. To learn how to create dashboards 
from templates, see .Creating Dashboards

Press the  button  on the dashboards panel toolbar.Settings

In the opened dialog box click the  button.Manage...

In the  window select any of the custom dashboards from the list and click .Manage dashboards Edit...

Adjust all configurational parameters as required and press . To learn more about the dashboard's OK
configuration parameters, see .Adjusting Dashboard Configuration

Editing Dashboards

To edit dashboard's configuration:
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1.  

2.  

3.  

Note: Predefined dashboards cannot be deleted, but any custom dashboards can be deleted.

If you want to delete a dashboard, follow the steps described below.

Press the  button  on the dashboards panel toolbar.Settings

In the opened dialog box click  dashboards.Manage...

In the  window select any of the custom dashboards from the list and click .Manage dashboards Delete

Deleting Dashboards

To delete a dashboard:
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1.  

2.  

3.  

1.  

The  allows the creation of new projects as well as renaming and deleting projects that are not active. Projects view
NOTE: You cannot rename or delete a project that is set as active.

To create a project, in the Projects view, in the toolbar, click  ( ). The Project Create Wizard opens.Create Project

In the Project screen, in the  field, specify the name of the project.Project name

To keep the default location to store the project, leave the  checkbox selected. If you want Use default location
to change the location, clear the checkbox and enter the name of the new directory into the  field or Location
click  and select the directory in the folder tree.Browse

Click . The new project appears in the projects tree.Finish

To delete a project, in the Projects view, right-click its name in the tree and click  on the context menu. Two Delete
confirmation dialog boxes will appear one after another:

Delete object dialog box is to confirm the deletion of the project itself. Click  if you are sure you want to Yes
delete it. Otherwise, click .No

Projects

Creating Project

Deleting Project
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2.  Delete project dialog box is to confirm the deletion of the project's contents. These are the project 
configuration files and scripts stored in the file system. Click  if you want the contents to be deleted as Yes
well. To keep the contents, click .No

NOTE: If you have deleted a project and then re-create it with the same name, the new project picks up all the 
database connections of the deleted project.
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Note: This functionality is available in , , , and  editions only.Enterprise Ultimate Lite Team

DBeaver supports local storage for connection secure data. It includes:

Database server user credentials

SSH tunnel user credentials

Proxy user credentials

By default, user names and passwords are stored in file . This file is encrypted using the credentials-config.json

AES key. However the key is insecure because it is found in the DB open-sources and thus this file can be un-
encrypted by 3rd party people using some 3rd party software.

In the DBeaver Enterprise, the security support is much safer because of its strong encryption.

It is possible to set a master password for all projects in a local workspace. Go to Preferences->Database-
>Security and enable the option . There are several password storage providers Use secure passwords storage

(you can see them on page General->Security->Secure Storage),  is the DBeaver Enterprise Password Provider

default one (in standalone DBeaver). It will ask you to specify master password. DBeaver doesn't store this 
password anywhere, it only encrypts user credentials in a special local storage. It is not possible to decrypt this 
password without a password (at least easily).

The side effect of this configuration is that you cannot share your connections (with password) between different 
users because user credentials are stored in a completely separate location and they are protected by a local user 
password.

Project security

Master password for local configuration

https://dbeaver.com/dbeaver-team-edition
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You can disable the default password provider and enable a "Windows Integration" provider. This provider does 
not need a master password but it uses a randomly generated password stored in a local user secure storage (in 
Windows). This is easier (as you don't need to remember the master password) but less secure (anybody who has 
access to your Windows user account will have access to DBeaver's stored credentials).

You may specify a password for a project. It will encrypt all the project's configurations with this password. Also, 
you will be able to share your project settings with other users (you will need to pass the project password as well).

In order to enable a project password open the project properties. You can do this by:

Clicking on main menu File->Project security

Clicking on "Configure" icon in the project explorer view toolbar and switching to the Project Security tab

Pressing  on a project element in  view and switch to Project Security tabALT+Enter Projects

On the project security page click on the "Set Password" button to enable the project password. Click on Clear to 
disable it (you will need to enter a current project password to clear it).

Use Windows Integration password provider

Project password
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1.  

2.  

DBeaver is fully integrated with the Git team work/version control system. You can keep your project configuration, 
scripts, diagrams, bookmarks and other artifacts in a Git repository.

This extension is included in the EE version. It can also be installed manually to the CE version.

Marketplace URL:https://marketplace.eclipse.org/content/dbeaver-git-support

P2 repository URL:https://dbeaver.io/update/git/latest/

This includes three main steps: 1) creating a local git repository 2) creating a remote git repository 3) sharing your 
project

Here is how to do these steps in detail:

Open , then choose the Project that you need to share and choose  from Projects tab Team - Share project

the context menu:

Create a new local repository or choose an existing one:

Team work (Git)

Create Repository

Share Existing Project

https://marketplace.eclipse.org/content/dbeaver-git-support
https://dbeaver.io/update/git/latest/
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3.  Create a new GitHub repository. Make sure to pay attention to the security. The repository should not be 
 as there are credentials to the databases you are working with. Here you fill in the , public Repository name

,  and click :Description Accessibility Create repository
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4.  

5.  

Then, on the page of the repository at GitHub, click on the  button and copy the URL: Code

Paste the URL of the GitHub repository on DBeaver's side. You have to specify the GitHub  and User

. You have to use your GitHub username. However, instead of a password you have to specify the Password

GitHub . We also recommend ticking  in DBeaver below:access token Store in Secure Store
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6.  

7.  

8.  

The GitHub access token is located at . You need to Settings/Developer Settings/Personal access tokens

generate the new one and tick some options: all from the  section ( , , ‘repo’ repo:status repo_deployment

etc.). You should also tick  in section . You will see the  token:‘read:org’ admin:org only once

When you click  on the Source Git Repository form, you will have to generate a password for all the Finish
secure data in DBeaver. You must remember this password.

Commit the project by right-clicking the project node and selecting  or  from the Team - Commit… Ctrl+#

context menu. Enter a commit message (the first line should be headline-like, as it will appear in the history 
view) and hit the  button. If the commit was successful, the question icons will have turned into Commit
repository icons:
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9.  

1.  

Then push changes to a remote repository using  button:Push HEAD

You can learn more here

You need to have a GitHub account.

Choose  button at  Tab or  in the Main menu:Create Project from Git Projects File - Git - Create Project

Cloning existing repositories

https://wiki.eclipse.org/EGit/User_Guide#GitHub_Tutorial


DBeaver User Guide 23.1. Page 248 of 526.

2.  On the first page of the wizard, enter the location of the remote repository. Make sure the repository's owner 
has given you access to it. Here you have to specify the GitHub  and . You have to use your User Password

GitHub username, but instead of a password, you specify the GitHub . We also recommend access token
ticking  in DBeaver below:Store in the Secure Store
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3.  The remote repository's location comes from the repository's page at GitHub. Click on the  button and Code
copy the URL:
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4.  The GitHub access token is located at . You need to Settings/Developer Settings/Personal access tokens

generate the new one and tick some options. Please, tick all from  section ( , ‘repo’ repo:status

, etc.). You should also tick  in the  section. You will see the repo_deployment ‘read:org’ admin:org only 
 token:once
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5.  

6.  

On the next page, choose which branches should be cloned from the remote repository:

On the next page in DBeaver define where you want to store the repository on the local file system and define 
some initial settings:
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7.  Choose the type of wizard you want to use and then finish the repository cloning. The project should now 
appear in the Navigator/Project Explorer:
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1.  

More information can be found here

If some changes were made, e.g., Connection, Script or ERD was created, deleted or changed and you want to 
update your remote repository, you should:

Go to the Context menu of the project (  tab) and choose :Projects Team - Commit

Work with Project (Connections, Scripts, etc.)

https://wiki.eclipse.org/EGit/User_Guide#Cloning_Remote_Repositories
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2.  

3.  

Git Staging tab is opened at the bottom of the screen.  are shown here. Add needed Unstaged Changes
changes to the index using  or  button (highlighted at Add Selected files to the index Add all files to the index
the picture), input commit message and then Commit changes (  button or ). Commit Commit Ctrl+Enter

appears on the History tab (Main menu: ):Window - Show view - Other - Version Control(Team) - History

The  button can also be used. In case you need to Push changes, it can be done from the Commit and Push

Project context menu ( ) or from the  tab if all commits do not need to be pushed Team - Remote - Push History
(right click at needed commit - Push commit). The changes will appear in your git repository.

More information can be found here

Right-click on a project in the  Tab and select  or right-click on a repository in the Git Project Team - Pull

Repositories view and select  to pull new changes from the upstream branch that your local branch is tracking.Pull

If no local change was made or you want to discard your local changes, use Team - Reset

Pulling New Changes from Upstream Branch

https://wiki.eclipse.org/EGit/User_Guide#Committing_Changes
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The level of security is one of the key questions for enterprises, and the DBeaver team pays a lot of attention to it. 
One of the best reasons to use PRO versions is to take advantage of its security tools and features, such as 
password protection, SSO authentication, teams and roles in Team Edition.

This article briefly describes the most important security options available in DBeaver PRO.

Changing database password

Password protection for Projects

Secure authentication

Predefined connections

User roles and permissions

Centralized updates

License management

Users can change the current database password directly in DBeaver in the following databases: Cockroach, 
Exasol, Greenplum, Netezza, Oracle, PostgreSQL, Redshift, Snowflake, SQL Server, and Vertica.

Oracle, PostgreSQL, and Netezza allow changing an expired password in DBeaver as well.

How to change the user password

You can protect all  in your local workspace with a master password. This feature is only available in Projects
DBeaver PRO versions.

You can set this password and store it in DBeaver password provider or use a generated password from your local 
password provider (for instance, OS X Keystore Integration or Windows integration provider).

Learn more about master pasword

You can specify a password for any project to protect all the project's configurations. This feature is only available 
in DBeaver PRO versions.

Learn more about project pasword

Security in PRO products

Changing database password

Password protection for Projects

Master password for all your Projects

Password for one project

https://dbeaver.com/docs/wiki/Change-current-user-password/
https://dbeaver.com/docs/wiki/Projects-View/
https://github.com/dbeaver/dbeaver/wiki/Project-security#master-password-for-local-configuration
https://github.com/dbeaver/dbeaver/wiki/Project-security#project-password
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In DBeaver PRO versions, you can connect to databases using secure authentication via Kerberos or GCP, AWS, 
and Azure cloud services.

Kerberos is an authentication protocol, the default authentication technology used in Microsoft Windows.

You can connect via Kerberos using keytab, kinit, or a password. Open the connection settings, choose one of the 
 and select Kerberos as the authentication method.supported databases

Learn more about authentication via Kerberos

Users can connect to all company services using only one login and password. This is possible if you use SSO - 
Single Sign-On authentication service.

You do not need to manage, store, and transfer user credentials. When a user connects to the database, DBeaver 
opens a web browser with SSO authentication.

DBeaver supports the following SSO authentication services:

AWS SSO

GCP SSO

Azure

You can describe all available database connections in  (in JSON format) or configuration files import from CSV or 
 DBeaver.XML

If you want to restrict users from editing connection parameters, you can .protect them with passwords

Secure authentication

Kerberos support

SSO authentication

Predefined connections

Connections import

Read-only connections

Users roles and permissions

Configuring preferences

https://dbeaver.com/docs/wiki/AWS-SSO/
https://dbeaver.com/docs/wiki/GCP-SSO/
https://github.com/dbeaver/dbeaver/wiki/Azure-Cloud-Explorer
https://dbeaver.com/docs/wiki/Admin-Manage-Connections/#provide-predefined-connections
https://dbeaver.com/docs/wiki/Admin-Manage-Connections/#importing-connections-from-csv-xml
https://dbeaver.com/docs/wiki/Admin-Manage-Connections/#importing-connections-from-csv-xml
https://dbeaver.com/docs/wiki/Admin-Manage-Connections/#secure-connections-from-editing
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You can customize users preferences before they run DBeaver. For example, you can set the default  simple mode
for all connections (to show only schemas and tables and hide all system and service objects).

How to manage preferences

The best way to manage user access, restrictions, and permissions is to use .Team Edition

Team Edition allows you to create users and assign them appropriate roles with predefined capabilities.

You can add Viewers and Editors to work with prepared data, Managers to prepare data for them, Developers to 
work with scripts and connections, and administrators to manage everything.

Learn more about Team Edition

If your team works on Microsoft Windows, you can organize DBevaer mass updates in silent mode, without user 
input, using the Windows Installer command line options.

Learn more about silent install

You can place the license file in the user's workspace or store it elsewhere, and specify the license path on the 
command line or in the DBeaver configuration file.

Learn more about lisense management automation

How to specify license path in config

Roles in Team Edition

Centralized automatic updates

License management

https://dbeaver.com/docs/wiki/Simple-and-Advanced-View/
https://dbeaver.com/docs/wiki/Admin-Manage-Preferences/#configuring-default-navigator-view-for-new-connections
https://dbeaver.com/dbeaver-team-edition/
https://dbeaver.com/dbeaver-team-edition/
https://github.com/dbeaver/dbeaver/wiki/Windows-Silent-Install
https://dbeaver.com/docs/wiki/License-Administration/#license-management-automation
https://dbeaver.com/docs/wiki/License-Administration/#passing-license-file-through-command-line
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1.  

2.  

3.  

Bookmarks are quick access links to objects of a database. They appear in the project tree inside the  or Projects
 views.Project Explorer

To create a bookmark:

In the  or under  node of the Projects view, click the database object of Database Navigator Connections
interest to focus on it.

Press . The  dialog box appears.CTRL+ALT+SHIFT+D Bookmark Name

In the  field, enter the bookmark name, then in the  field, click the folder, and Bookmark Name Bookmark folder
then click :OK

The bookmark appears in the selected folder of the related project.

To open an object using its bookmark, double-click the bookmark or right-click it and click  on the Open Bookmark
context menu. You can rename and delete bookmarks using the context menu as well.

Bookmarks
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Here is a complete list of default hotkeys in DBeaver UI for Windows, Linux, and macOS users. It will help you 
work in DBeaver faster and more efficiently. Remember that you can always change the keyboard shortcut in the 
DBeaver settings. Go through: . Select command and add a Window - Preferences - User Interface - Keys
keyboard shortcut to the Binding row.

If you mostly use keyboard, to get more shortcuts you can switch default key scheme to  DBeaver Keyboard Only
key scheme in  settings.Window - Preferences - User Interface - Keys

Shortcut for Windows
/Linux

Shortcut for 
macOS

Action

F4 F4 Open object editor

Ctrl+Shift+D ##D Open database meta-object

Ctrl+Alt+Enter ### Open a new SQL console. No script file will be created.

Ctrl+] #] Create a new SQL script( )***

F3 F3 Open existing SQL script ( )***

Ctrl+Enter ## Open most recent SQL script( ) for an active connection***

Ctrl+Alt+Shift+K #4 Commit changes in current session

Alt+` #V Shows context menu with database tools

Ctrl+Alt+Shift+U ###U
Generates UUID/GUID and inserts into an active text editor or data 
editor

Ctrl+Alt+Shift+B ###B Open database dashboard

Ctrl+Alt+Shift+R #8 Rollback changes in current session

Ctrl+0 #0 Select active schema for current database

Ctrl+9 #9 Select connection for current editor

Shortcut for Windows/Linux Shortcut for macOS Action

Alt+Insert #Insert Add new row

Ctrl+D #D Copy values from row above to current row

Ctrl+Alt+D ##D Copy values from row below to current row

Alt+Delete ## Delete current row

Ctrl+Alt+Insert ##Insert Duplicate current row

Enter # Edit cell value with inline editor

Esc Esc Reset cell to original value

Shortcuts

Connection

Result Set
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Ctrl+S #S Apply data changes

Ctrl+Alt+Shift+T ###T Set focus to filter editor/data editor

Ctrl+Shift+7 ##7 Switch focus to results viewer/active panel

Ctrl+Alt+Shift+Enter #### Apply cell changes

Shift+Enter ## Edit cell value in separate dialog/editor

Ctrl+Shift+= ##= Fetch all rows

Ctrl+Alt+; ##; Fetch next page of results

Ctrl+F11 #F11 Filter by unique attribute values

F11 F11 Filter context menu

Ctrl+Alt+Shift+Left ###← Move to first row

Ctrl+Alt+Shift+Right ###→ Move to last row

Alt+Space #Space Follow foreign key link

Ctrl+Alt+Right ##→ Move to next row

Ctrl+Alt+Left ##← Move to previous row

Ctrl+1 #1 Foreign keys and tables referencing current table

Ctrl+R #R Reject data changes

Ctrl+Backspace ## Set cell to default value

Ctrl+` #` Switch results presentation

Tab Tab Toggle results Grid/Record view

F7 F7 Toggle extra result panels

Ctrl+2 #2 Toggle results sort order (ascending/descending/default)

Ctrl+Alt+C Select column(s)

Ctrl+Alt+R Select row(s)

Shift+F11 Show context menu for column

Shortcut for Windows/Linux Shortcut for macOS Action

Alt+Shift+Right Move column(s) right

Alt+Shift+Left Move column(s) left

Alt+Shift+C Copy column names

Alt+Shift+H Hide columns

Alt+Shift+T Show hidden columns

Alt+Shift+F Open filters settings

Ctrl+Alt+F6 Show/hide results panel (Calc)

Ctrl+Alt+F5 Show/hide results panel (Grouping)

Result Set (Additional shortcuts for  key scheme)DBeaver Keyboard Only
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Ctrl+Alt+F4 Show/hide results panel (Metadata)

Ctrl+Alt+F3 Show/hide results panel (References)

Ctrl+Alt+F2 Show/hide results panel (Value)

Shortcut for Windows/Linux Shortcut for macOS Action

Ctrl+Space #Space Enable autocomplete

Ctrl+F #F Find and replace text

Ctrl+Shift+Space ##Space Show Context Information in DIalogs and Windows

Ctrl+Alt+Space ##Space Show Context Information (SQL Editor Context)

Ctrl+X #X Cut the selection to the clipboard

Ctrl+C #C Copy the selection to the clipboard

Ctrl+V #V Paste from the clipboard

Delete # Delete the selection

Ctrl+O #O Export Diagram

Ctrl+K #K Find next item

Ctrl+Shift+K ##K Find previous item

Ctrl+J #J Incremental find

Ctrl+Shift+J ##J Incremental find reverse

Ctrl+Shift+Q ##Q Toggles quick diff information display on the line number ruler

Ctrl+1 #1 Suggest possible fixes for a problem

Ctrl+Y ##Z Redo the last operation

Ctrl+Z #Z Undo the last operation

Shift+Delete ## Remove selected Pictogram Elements

Ctrl+A #A Select all

Alt+Shift+A ##A Toggle block/column selection in the current text editor

Ctrl+Shift+Insert ##Insert Toggle insert mode

Alt+Shift+Y ##Y Toggle word wrap in the current text editor

Ctrl+F5 #F5 Update selected Pictogram Elements

Alt+/ #. Context insensitive completion

Ctrl+Shift+Space ##Space Context insensitive completion (SQL Editor Context)

Shortcut for Windows/Linux Shortcut for macOS Action

Data Editor

Text Editor
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Ctrl+Shift+Y ##Y Changes the selection to lowercase

Ctrl+Shift+X ##X Changes the selection to uppercase

Ctrl+Numpad_Subtract #Numpad_Subtract Collapses the folded region at the current selection

Ctrl+Shift+Numpad_Divide ##Numpad_Divide Collapses all folded regions

Ctrl+Alt+Down ##↓ Duplicates the selected lines and moves the selection to the copy

Ctrl+D #D Delete a line of text

Ctrl+Delete ## Delete the next word

Ctrl+Backspace ## Delete the previous word

Ctrl+Shift+Delete ### Delete to the end of the line of text

Ctrl+Alt+Up ##↑ Duplicates the selected lines and leaves the selection unchanged

Ctrl+Numpad_Add #Numpad_Add Expands the folded region at the current selection

Ctrl+Numpad_Multiply #Numpad_Multiply Expands all folded regions

Ctrl+Shift+Enter ### Adds a new line above the current line

Shift+Enter ## Adds a new line below the current line

Ctrl+Alt+J Join lines of text (Editing Text)

Ctrl+Shift+J ##J Join lines of text (SQL Editor Context)

End #→ Go to the end of the line of text

Home #← Go to the start of the line of text

Alt+Down ##↓ Moves the selected lines down (Editing Text)

Ctrl+Shift+Down #↓ Moves the selected lines down (SQL Editor Context)

Alt+Up ##↑ Moves the selected lines up (Editing Text)

Ctrl+Shift+Up #↑ Moves the selected lines up (SQL Editor Context)

Ctrl+Right #→ Go to the next word

Ctrl+Left #← Go to the previous word

Ctrl+Shift+Numpad_Multiply ##Numpad_Multiply Resets the folding structure

Ctrl+Down Scroll down one line of text

Ctrl+Up Scroll up one line of text

Shift+End ##→ Select to the end of the line of text

Shift+Home ##← Select to the beginning of the line of text

Ctrl+Shift+Right ##→ Select the next word

Ctrl+Shift+Left ##← Select the previous word

## Select to the end of the text

## Select to the beginning of the text

F2 F2 Displays information for the current caret location in a focused hover

Ctrl+End # Go to the end of the text
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Ctrl+Home # Go to the beginning of the text

Ctrl+Numpad_Divide #Numpad_Divide Toggles folding in the current editor

Insert Insert Toggle overwrite mode

Ctrl++ #+ Zoom in text, increase default font size for text editors

Ctrl+= #= Zoom in text, increase default font size for text editors

Ctrl+- #- Zoom out text, decrease default font size for text editors

Shortcut for Windows/Linux Shortcut for macOS Action

Alt+X #X Execute SQL script( )**

Alt+N #N Execute SQL script natively

Ctrl+Enter ## Execute SQL statement( )*

Ctrl+ # Execute SQL statement in a new tab

Ctrl+Alt+Shift+X ###X Execute script's statements in separate results tabs

Ctrl+/ #/ Add or remove single line comment

Ctrl+Shift+/ ##/ Add or remove multi line comment

CTRL+Alt+6 ##6 Switch active SQL editor panel

Ctrl+6 #6 Show/hide results panel

Ctrl+Shift+ ## Close results tab

Ctrl+Shift+F ##F Format text

Ctrl+Alt+' ##' Select value of the selected SQL expression

Ctrl+Shift+E ##E Explain execution plan

Ctrl+Shift+[ ##[ Position cursor on the matching bracket

Ctrl+Alt+Shift+O ###O Load SQL script from file system

Ctrl+Shift+6 ##6 Maximize/normalize results panel

Alt+Down #↓ Switch to the next query

Alt+Up #↑ Switch to the previous query

Ctrl+F2 #F2 Rename current SQL script

F4 F4 Open editor of current (highlighted) database object

Ctrl+Alt+Shift+A ###A Select and show all rows (no fetch size limit)

Ctrl+Alt+Shift+C ###C Select row count for query under cursor

Ctrl+Shift+. ##. Set active connection from database navigator selection

Ctrl+Shift+O ##O Show server output console

Ctrl+Alt+Shift+W ###W Toggles text editor soft word wrap

SQL Editor
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See  for a list of shortcuts.ER Diagrams documentation

Shortcut for Windows/Linux Shortcut for macOS Action

Ctrl+B #B Open Visual Query Builder

Ctrl+Shift+B ##B Show/hide generated SQL query text

Shortcut for Windows/Linux Shortcut for macOS Action

Ctrl+H #H Open the Search dialog

Ctrl+Alt+G ##G Searches the files in the workspace for specific text

Ctrl+Alt+Shift+F ###L Quick search in Windows

Shortcut for Windows/Linux Shortcut for macOS Action

Tab Tab Cycle through hand tool and previously used tool

Ctrl+= #= Zoom In

Ctrl+- #- Zoom Out

Alt+Shift+Q, Q ##Q Q Shows a particular view

Alt+Shift+Q, B ##Q B Shows a particular view (Breakpoints)

Alt+Shift+Q, C ##Q C Shows a particular view (Console)

Alt+Shift+Q, L ##Q L Shows a particular view (Error Log)

Alt+Shift+Q, Z ##Q Z Shows a particular view (History)

Alt+Shift+Q, O ##Q O Shows a particular view (Outline)

Alt+Shift+Q, X ##Q X Shows a particular view (Problems)

Alt+Shift+Q, S ##Q S Shows a particular view (Search)

Alt+Shift+Q, Y ##Q Y Shows a particular view (Synchronize)

Alt+Shift+Q, V ##Q V Shows a particular view (Variables)

ER Diagrams

Visual Query Builder

Search

Data viewer

Window
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Shortcut for Windows/Linux Shortcut for macOS Action

F12 #F12 Activate Editor

#W Closes the active Dialog

Ctrl+3 #3 Find actions. Quickly access UI elements

Ctrl+M #M Maximize/restore a state of active view or editor

Ctrl+F6 #F6 Switch to the next editor

Ctrl+F8 #F8 Switch to the next perspective

Ctrl+F7 #F7 Switch to the next view

Ctrl+Shift+F6 ##F6 Switch to the previous editor

Ctrl+Shift+F8 ##F8 Switch to the previous perspective

Ctrl+Shift+F7 ##F7 Switch to the previous view

Ctrl+E #E Open the editor drop-down list

#F10 Show the context menu

Alt+Shift+F3 ##F3 Shows contribution information for the currently selected element

Ctrl+Shift+L ##L Show the key assist dialog

Ctrl+F10 #F10 Show the context menu for the ruler

Alt+- ##F10 Show the system menu

Ctrl+F10 #F10 Show the view menu

Ctrl+Shift+E ##E Switch to an editor

Alt+F11 ##F Toggles the window between full screen and normal

Ctrl+_ ##- Split or join the currently active editor (Horizontal)

Ctrl+_ ##[ Split or join the currently active editor (Vertical)

Shortcut for Windows/Linux Shortcut for macOS Action

Ctrl+Shift+, ##, Link with editor

Ctrl+Alt+Shift+D ###D Add Bookmark

Enter # Opens task configuration

Ctrl+Shift+A ##A Set as default object

Shortcut for Windows/Linux Shortcut for macOS Action

Alt+Shift+Up Alt+Shift+Up Switch to the next entity property left-side tab

Alt+Shift+Down Alt+Shift+Down Switch to the previous entity property left-side tab

Database Navigator

Properties Entity Editor
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Shortcut for Windows/Linux Shortcut for macOS Action

Alt+Left #[ Move backward in the editor navigation history

Ctrl+Shift+Numpad_Divide ##Numpad_Divide Collapse the current tree

Ctrl+Shift+Numpad_Multiply ##Numpad_Multiply Expand the current tree

Alt+Right #] Move forward in the editor navigation history

Ctrl+G #G Go to a specified line of text in Windows

Ctrl+L #L Go to a specified line of text (Editing Text)

Ctrl+. #. Navigate to the next item

Ctrl+Alt+Right ##→ Next edit location

Alt+F7 #F7 Switch to the next page

Alt+PageDown ## Switch to the next sub-tab

Ctrl+PageDown ## Switch to the next tab

Ctrl+Shift+R ##R Open an editor on a particular item

Ctrl+, ##. Navigate to the previous item

Ctrl+Alt+Left #Q Previous edit location

Alt+Shift+F7 ##F7 Switch to the previous page

Alt+PageUp ## Switch to the previous sub-tab

Ctrl+PageUp ## Switch to the previous tab

Alt+Shift+W ##W Open the Show In menu

Shortcut for Windows/Linux Shortcut for macOS Action

F2 F2 Rename the selected item

F5 F5 Refresh the selected items

Ctrl+S #S Save the changes in current file

Ctrl+Shift+S ##S Save changes in all open files

Ctrl+F4 #W Close the active editor

Ctrl+Shift+F4 ##W Close all editors

Ctrl+N #N Open the New item wizard

Alt+Shift+N ##N Open the New menu

Ctrl+O #O Open a file

Navigation tree

File
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Ctrl+P #P Print

Alt+Enter #I Display the properties of the selected item

Shortcut for Windows/Linux Shortcut for macOS Action

Ctrl+Alt+M ##M Add memory block

Ctrl+W #W Close the selected rendering

F11 #F11 Launch in debug mode

Ctrl+Z #D Send end of file

Ctrl+G #G Go to Address

Ctrl+N #N Add a new rendering

Ctrl+Alt+N ##N Show renderings from next memory monitor.

Ctrl+Shift+. ##. Load next page of memory

Ctrl+Shift+, ##, Load previous page of memory

Ctrl+F11 ##F11 Launch in run mode

Ctrl+R #R Resume and break when execution reaches the current line

Ctrl+Alt+B ##B Sets whether or not any breakpoint should suspend execution

F5 F5 Step into

F6 F6 Step over

F7 F7 Step return

F8 F8 Resume

Ctrl+F2 #F2 Terminate

Ctrl+Shift+B ##B Creates or removes a breakpoint

Ctrl+T #T Toggle visibility of the Memory Monitors Pane

Shift+F5 #F5 Toggles enablement of debug step filters

Shortcut for Windows/Linux Shortcut for macOS Action

Ctrl+Left #← Collapse Working Tree

Ctrl+# ##3 Commit

Ctrl+C #C Copy Path to Clipboard

Ctrl+O #O Show the quick outline for a unified diff

F2 F2 Rename Branch

Ctrl+Shift+K ##K Commit changes to Git

Run/Debug

Git
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Ctrl+Shift+U ##U Update changes from Git

Shortcut for Windows/Linux Shortcut for macOS Action

Ctrl+B #B Build all projects

Shortcut for Windows/Linux Shortcut for macOS Action

Ctrl+F9 #F9 Compile

Shortcut for Windows&Linux
Shortcut for 
macOS

Action

Ctrl+Shift+C ##C Advanced Copy

Ctrl+Shift+V ##V Paste with extra settings

CTRL+ALT+PAGE_UP 
CTRL+ALT+PAGE_DOWN

Switch between tabs in database object Properties 
view

Shortcut for Windows&Linux Shortcut for macOS Action

F1 F1 Open the documentation

*  - Current query is the query under cursor or the selected text. Query is separated from other script queries by 
delimiter (; by default) or by empty lines.

 - Current script is a set of all queries in the current SQL file. If there is a text selection then only queries in this **

selection are processed. Queries are separated from each other with a delimiter (; by default).
 - Current connection detected from active window and selection. If active (focused) window is SQL editor or ***

database object editor then the current connection is the same as in this editor. If the active window is the 
database navigator then the active connection is the "owner" connection of the currently selected element. In other 
cases there is no current connection and DBeaver will ask you to choose the connection explicitly.

Project

Oracle

Utility

Help

References
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If you want to test  features, you can create a demo database. There is a specialized database that can DBeaver
be created. You can create a sample  database at the first launch. The database can be added at any time SQLite
by the following sequence. Chinook is used as a reference database

Help -> Create Sample Base

Sample Database

Introduction
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To be able to manage your database in DBeaver, you need to create a connection to this database – see Creating 
. A connection includes a driver and a number of configuration parameters including the location of Connections

the database and credentials to access it. You need to create a separate connection to every database you want 
to manage. Every database type requires its own set of connection parameters.

Connections reside in the  and in the  views. In these views, you can:Database Navigator Projects

Edit connections, see Editing Connections

Rename and delete connections - via corresponding context menu items, see Database Navigator

Connect to and disconnect from databases using connections, see  and Connect to Database Disconnect 
.from Database

Database connections might have the following states:

 - not connected

 - has network settings specified (such as SSH tunnel, etc.) 

 - connected

 - connection error

Also see:

Disable multiple connections opening for MFA authentication

Database Connections



DBeaver User Guide 23.1. Page 271 of 526.

DBeaver provides a wizard that guides you through the steps to create a connection. If you run DBeaver for the 
first time (standalone version), the new connection wizard appears automatically. In other cases, to create a 
connection, do one of the following:

Click the  button in the application toolbar or in the Database Navigator view toolbar:New Connection Wizard

Click  in the menu bar:Database -> New Connection

Press  or click  in the menu bar:Ctrl+N File -> New

Create Connection
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Then, in the wizard, click  and then click :Database connection Next

Then, in the  wizard:Create new connection
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1.  Choose a driver for the new connection: click the name of the suitable database type in the gallery. Then click 
.Next

To quickly find the needed driver, you can type a hint in the text field above the list of drivers.
If you cannot find a driver for your database then probably there is no suitable driver and you need to create 
one. Please see  article.Database Drivers

NOTE: The list of database drivers diaplays the number of exising connections next to each driver. No 
number is displayed if there are no connections.

If you prefer the classic list view of the available drivers, use the  button.Classic
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2.  

You can choose the Simple mode on this step. Simple mode gives simplified access to the database, which is 
basically with the ability to view data only in schemas and tables.

In the Connection Settings screen, on the General tab, set all primary connection settings:
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3.  

4.  

5.  

For most drivers required settings include:

Host

Port

Database name

User name and password

However, the number and type of connection properties are very dependent on the driver.
For example, embedded drivers (such as SQLite, Derby Embedded, HSQLDB, H2 Embedded), unlike remote 
ones, require only the path to the database.

If necessary, specify advanced settings, see  section below, and click .Advanced Settings Next

To test if the connection works, click .Test Connection

Click . The connection appears in the tree of connections in the Database Navigator and DBeaver Finish
actually connects to the database.

Advanced Settings
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If your database cannot be accessed directly, you can use SSH tunnel:

DBeaver supports following SSH authentication methods: user/password, public key authentication and agent 
authentication. Supported implementations for agent authentications are  and .pageant ssh-agent

If a connection has network settings specified, such a connection appears in the application with a special 'arrow' 
icon such as this: 

More information about SSH configuration can be found on  page.SSH configuration

You can also set the connection name, type and initial settings (such as bootstrap queries, transaction state, 
global filters, etc.).

Network Settings (SSH, SOCKS, SSL)

Connection Details (name, type, etc.)

https://www.digitalocean.com/community/tutorials/how-to-use-pageant-to-streamline-ssh-key-authentication-with-putty
https://help.github.com/en/github/authenticating-to-github/generating-a-new-ssh-key-and-adding-it-to-the-ssh-agent
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Each driver has its own set of additional properties. Refer to the driver documentation to get information about 
available properties and their values.

Driver Properties
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You can use variables in all connection parameters and in the driver properties. Variables are system environment 
variables or one of the following list:

Name Value

${host} Host name

${port} Port number

${database} Database name

${server} Server name

${url} Connection URL

${user} User name

Variables in parameters
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${password} User password

Note: option  must be turned on (see preferences).Use environment variables in connection parameters
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To edit the configuration settings of a database connection, in the  or in the  view, right-Database Navigator Projects
click the connection and click  on the context menu. The Connection configuration window will Edit Connection
open:

The navigation pane on the left displays the configuration sections, most of which are the same as those in the 
Create new connection wizard, see . There are additional configuration sections as well, such Connect to Database
as  and . Click the section name to open the configuration settings for editing.Result Sets SQL Editor

You can test if your connection works with modified settings - click . When you finish editing your Test Connection
connection, click  to save the changes or  to discard them.OK Cancel

In development

JDBC Time Zones

Edit Connection

Driver settings
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To be able to work with the content and structure of a database, you need to connect to it. When you create a new 
connection to a database, DBeaver automatically connects to the new database, see .Create Connection

To connect to a database using an existing connection, in the  or  view, click the Database Navigator Projects
connection and then click the Connect button in the toolbar or click  on the main menu:Database -> Connect

You can also right-click the connection and click  on the context menu.Connect

If a database connection exists but DBeaver is not connected to the database, the connection appears with its 

original icon (for example,  for PostgreSQL database). When DBeaver connects to the database, the icon 

changes to signal the connected status: .

If DBeaver cannot connect to a database, the connection will appear with an error sign: . If you attempt to 
connect to such a database, DBeaver displays an error message describing the cause for the error.

Connect to Database
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You might need to invalidate a database connection and then reconnect to it again in cases such as where the 
connection to the server is temporarily lost, etc. To invalidate a database connection and then reconnect to the 
database, click the database connection in the Database Navigator or Projects view, and then click the Invalidate

 button in the toolbar or  on the main menu:/Reconnect Database -> Invalidate/Reconnect

You can also right-click the connection and click  on the context menu.Invalidate/Reconnect

Invalidate/Reconnect to Database
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You might need to disconnect from a database to free up resources or close transactions. To disconnect from a 
database, click the connection in the  or  view, and then click the Disconnect button in Database Navigator Projects
the toolbar or click  on the main menu:Database -> Disconnect

You can also right-click the connection and click  on the context menu.Disconnect

NOTE: The Disconnect button and menu items are available only for those connections that are activated, that is, 

marked with the connected sign: .

When DBeaver disconnects from a database, its icon changes to its original state (not connected), for example, 
for PostgreSQL database.

To disconnect from all active connections, click  on the main menu.Database -> Disconnect All

Disconnect from Database
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1.  

2.  

3.  

DBeaver can change credentials for the current database user.

Databases that support this feature:

PostgreSQL

Greenplum

Cockroach

Redshift 

Netezza 

SQL Server

Oracle

Exasol

Snowflake 

Vertica

Different databases perform password management for users in different ways. For some of them, you can 
change the user password after the expiration date. It works for Oracle, PostgreSQL, and Netezza databases.

For the rest, database users must change the password before the expiration. Otherwise, it will be impossible to 
do it in DBeaver.

You can change the current user password in the Navigation Tree according to the instructions below:

Connect to the database.

Open the context menu by right-clicking on the connection in the Navigation tree.

Select a "Security" point and click on a "Change user password" point in a sub-menu.

Change current user password

Changing expired user password

How to change the user password
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4.  

5.  

When a new password input dialog opens, enter and confirm the new password.

Confirm the password changes. (This dialog will not appear if the entered password is incorrect).

The password has been changed.
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Sometimes the database cannot be accessed directly, in such cases you can use the SSH tunnel. The SSH or 
Secure Shell is a network communication protocol that allows two computers to communicate and encrypts the 
shared data.

DBeaver supports the following SSH authentication methods:

Username/password

Public key authentication

Agent authentication

Available agent authentication implementations:

pageant (Windows only)

ssh-agent

Note that you have to run the agent first before connecting to the database in DBeaver.

SSH can either be configured individually for each connection in  #  or as a Connection settings SSH 1

which can be selected from the drop-down menu  on the same page mentioned earlier:2

SSH Configuration

Configuring SSH

https://www.digitalocean.com/community/tutorials/how-to-use-pageant-to-streamline-ssh-key-authentication-with-putty
https://help.github.com/en/github/authenticating-to-github/generating-a-new-ssh-key-and-adding-it-to-the-ssh-agent
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In order to use SSH, you have to enable it first. After that, configure it for your needs, then click on Test tunnel configuration
to test whether all parameters are valid or not.

It is often required to set the hostname to  in  # . SSH establishes a localhost Connection settings Main
connection between two machines, authenticating each side to the other, and passing commands and output back 
and forth. After connecting to remote machine, all commands you execute are executed on that remote machine, 
so by having the host set to  you are opening a connection to the database on this remote machine, localhost

not on your local machine, and just redirect I/O to the latter.

Gateway host, sometimes known as jump host, is used in situations when you cannot access a particular machine 
directly from your local machine, but it is possible to use a gateway server.

Just like SSH configuration, you have to enable it first. Gateway has the same configuration as for regular SSH 
tunnel:

Imagine you have the following situation: your database is located on remote machine with IP address 
 and which is accessible through SSH. You cannot access this IP directly from your machine 100.100.100.100

because of your network settings or firewall, but you can access other machines with the IP address 
 through SSH and which  to access the desired remote machine. You will need to specify 200.200.200.200 is able
 as a host in regular SSH configuration and  as a host in a gateway 100.100.100.100 200.200.200.200

configuration to achieve such a "connection order":  →  → .localhost 200.200.200.200 100.100.100.100

Jump servers are only available with Jsch implementation. See information .below

Configuring Gateway Host

Practical use

Availability note

Advanced options
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1.  

2.  

3.  

Optional port forwarding configuration, see information at .below

Keep-alive interval. Can be used to "ping" a remote machine to make sure that the SSH connection is still 
alive.

Connection timeout. If the destination SSH machine is quite slow and the connection takes ages to complete, 
you can adjust the value of this parameter.

Port forwarding is used to expose some socket sitting on a remote port to your local port, allowing you to 
communicate with it. After the SSH connection to the remote machine is established, you now need to connect to 
the database on that machine. Now you need to pass the port on which the database is listening to from that 
remote machine to your local machine. This is when port forwarding becomes handy.

By default, it randomly chooses the local port and forwards it to the destination port set in Connection settings
# Main

It is not usually required to change this configuration, but it can be useful e.g. when you want to use a particular 
local port.

By defaul DBeaver opens random local port and forwards it to a target database port. It then implicitly replaces 
port configured in the connection with this random port.
So technically DBeaver will connect to something like  (radnom port on localhost) instead of localhost:45678

 (default PostgreSQL server port).database.server.domain:5432

But if you use URL instead of manual connection configuration then you connect to 
. DBeaver cannot replace port number automatically jdbc:postgresql://database.server.domain/postgresql

because you can use any type of sophisticated URLs. DBeaver just don't know how to chnge this URL.

If you use URL connection then you must configure port forwarding manually. In the Advanced Settings set both 
Local Port and Remote Port to 5432 (database server port, 5432 is the default value for PostgreSQL). It will work 
in most cases.
But it will fail if you have PostgreSQL server on your local machine because port 5432 is already occupied. In this 
case you can use any random port number for Loca Port (e.g. 15432). Use the same 5432 for Remote Port 
because it is real port number for remote PostgreSQL server.

Port Forwarding

SSH + URL-based connections
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Sometimes DBeaver needs to access external internet resources for tasks such as:

3rd party JDBC drivers download

Information about a new DBeaver version

Connect to remote databases outside of your corporate network

Subscription license activation (commercial version)

License information update (commercial version)

If you are behind some corporate firewall which restricts access to external internet resources then it may become 
a real problem.
Sometimes corporate firewalls allow access to external resources using a web browser but restricts this for all 
other applications.

You need to ask your network administrator about proxy parameters.
Then go to Preferences->Connections->Drivers.

You can enter a proxy host/port and (optionally) user/password here. It will be used for drivers download only.

Proxy configuration

External resources access

How to configure a proxy for drivers download



DBeaver User Guide 23.1. Page 290 of 526.

Drivers are usually downloaded from maven.org web site. You may also ask your network admin to add 
 to the list of allowed external domains.maven.org

You need to configure a global proxy server.
If you cannot activate your subscription license then you first need to use a trial version to start DBeaver and 
configure a proxy.

Go to Preferences->General->Network Connections: 

Switch to Manual or Native proxy (native proxy settings will use an active web browser proxy configuration).
Note: in order to activate/update a license DBeaver only needs to access the website . You may ask dbeaver.com

your network administrator to add  to the white list.dbeaver.com

You can configure proxy settings for an individual connection.

Note: Automatic proxy configuration is available in , , and  editions only.Lite Enterprise Ultimate

You may set the proxy settings manually or use the active OS/web browser settings:

How to configure network for license activation

How to configure a proxy for external databases access
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Note: This feature is available in , ,  and  editions only.Lite Enterprise Ultimate Team

Databases that support this feature:

Cockroach

EnterpiseDB (EDB)

Fujitsu

Greenplum

HANA

MySQL

MariaDB

Oracle

PostgreSQL

PrestoDB

PrestoSQL (Kerberos can be used with SSL from JKS)

Redshift

Teradata

TimescaleDB

Yellowbrick

YugabyteDB

There are a lot of ways to use Kerberos in your database authentication. On this page, you will learn a few of 
them. This page describes only the part that you need to do on the client machine (the one on which DBeaver is 
installed), and it is implied that Kerberos KDC and the necessary configuration are already done on the server.

Setting Description

Authentication

Username Name of the user/role in the database

Kerberos 
User

A Kerberos user represents a unique identity in a Kerberos system to which Kerberos can assign tickets to 
access the Kerberos-aware services.

Realm
A Kerberos realm is the domain over which a Kerberos authentication server has the authority to authenticate 
a user, host, or service. A realm name is often, but not always the upper case version of the name of the 
DNS domain over which it presides.

The hostname of your KDC server. The Kerberos Key Distribution Center (KDC) is a network service that 

Kerberos authentication

Possible settings

https://dbeaver.com/dbeaver-team-edition
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KDC Server supplies session tickets and temporary session keys to users and computers within an Active Directory 
domain. The KDC runs on each domain controller as part of the Active Directory Domain Services (AD DS). 
So the KDC hostname is the hostname of your DC.

Password The password of your Kerberos user.

Extra 
configuration

Use keytab Select this checkbox if you want to use a keytab file on your machine instead of entering a password.

Use kinit
Select this checkbox if you use the kinit tool on your machine. kinit is a tool that obtains and caches an initial 
ticket-granting ticket for the user. If this checkbox is selected, you will only need to fill in your Kerberos 
username in most cases.

Custom krb5.
conf

Path to your local Kerberos configuration file.

Debug 
Kerberos 
Connection

Select this checkbox if you want to see full Kerberos connection information in your .log files

Important Note Some settings can be saved in a session cache. If you have changed the settings and it does not 
help to connect - restart DBeaver.

A keytab is a file containing pairs of Kerberos principals and encrypted keys (which are derived from the Kerberos 
password). You can use a keytab file to authenticate various remote systems using Kerberos without entering a 
password. However, when you change your Kerberos password, you will need to recreate all your keytabs. Keytab 
files are commonly used to allow scripts to authenticate automatically using Kerberos without requiring human 
interaction or access to a password stored in a plain-text file. The script can then use the acquired credentials to 
access files stored on a remote system. For DBeaver, it means that when you use a keytab file, you still need to 
provide all of the credentials other than a password. You can find this setting in the "Extra configuration" section.

Using the keytab file
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kinit is a command-line/terminal tool that obtains and caches an initial ticket-granting ticket for the Kerberos user. 
All of the credentials are provided either in a configuration file or in a command-line interface. This means that to 
authenticate with kinit in DBeaver, you only need to provide a kerberos username and select this checkbox to use 
kinit. You can find this setting in the "Extra configuration" section.

Using kinit
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This method is almost the same as using a keytab file, but instead of providing an encrypted file, you must 
manually enter a password.

Using a password
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Sometimes you may need to specify the path to the Kerberos configuration file. You can do it in the "Extra 
configuration" settings section. You can also specify the path to Kerberos credential cache file near the "Use kinit" 
checkbox.

Extra options
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If your database Kerberos authentication requires the remote coordinator Kerberos service name, add it to the 
"Service" field. If SSL on the server is not trusted - you can check the "Use SSL from JKS" setting and manually 
add a path to your .jks file. A Java keystore (JKS) file is a secure file format used to hold certificate information for 
Java applications. SSL JKS password can be added in the "SSL JKS" field. For now, these settings are only 
available for the PrestoSQL connection.
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Oracle JDBC driver 21 has broken Kerberos authentication, at least for most of the old configurations.
Use an older driver (12.x or 19.x) in order to use Kerberos authentication in Oracle.

Oracle
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Connection types define how DBeaver behaves regarding:

Default transactions commit mode - with or without automatic commit of changes to the database.

NOTE: You can override the default commit behavior during your work with connections by changing the 
commit mode, see .Auto and Manual Commit Modes

SQL statements execution (with or without user confirmation): If set to the required user confirmation for SQL 
execution, DBeaver shows a confirmation message every time you attempt to execute a ‘transaction’ type of 
query (INSERT/DELETE/UPDATE, etc.):

For your convenience, DBeaver supports color-coding of connection types so that you know at once which 
behavior to expect when you use a certain connection. The screenshot below visualizes how the color coordinated 
database connections are used in  and  views as well as editors related to these Database Navigator Projects
connections:

Connection Types
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To manage connection types for a database connection, in the Database Navigator or Projects view, click the 
connection to set the focus on it and then press  to open the connection properties window. Then, in the F4
properties window, in the navigation pane on the left, click  to see the general settings. You can see General

 field among the settings:Connection Type
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1.  

2.  

1.  

There are three default connection types – , , and . You can change the connection Development Test Production
type for your database connection as well as you can create a new connection type, edit or delete an existing one.

By default, the  connection is preset for all database connections. You can change the connection Development
type to one of the default connection types or to a custom type, if there are any.

To change the connection type:

In the connection properties window, on the  page, click the  field and then click the General Connection type
connection type in the dropdown list:

To test the connection, click . To confirm the change, click .Test Connection OK

To create a connection type:

In the connection properties window (  on a connection), on the  page, click  next to the F4 General Edit
 field. The Properties for connection types window opens:Connection type

Change Connection Type

Create Connection Type
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2.  

3.  

4.  

The window displays existing connection types and their settings.

Click the new connection type button. A new connection type appears in the list: 

Now you can specify the settings for the new connection type:
Enter the connection type`s name into the  field.Name

Enter a description into the  field, if needed.Description

Click the  box and select the color for the new connection type.Color

To set DBeaver to automatically commit changes to the database when connections use this connection 
type, select the  checkbox. Otherwise, leave it empty.Auto-commit by default

To set DBeaver to ask for your confirmation at each execution of SQL statement of ‘transaction’ type, 
select the  checkbox. Otherwise, leave it empty.Confirm SQL execution

Click  to apply the changes and keep the window open or click  to apply the changes Apply Apply and Close
and close the window. To discard all changes and return to the previous state, click .Restore Defaults

Edit Connection Type
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1.  

2.  

3.  

1.  

2.  

3.  

4.  

To edit a connection type:

In the connection properties window (  on a connection), on the  page, click  next to the F4 General Edit
 field.Connection type

Specify the settings for the new connection type the same way as when you create a connection type, see 
'Create Connection Types' section above.

When you finish editing the connection types, click  to apply the changes and keep the window open or Apply
click  to apply the changes and close the window. To discard all changes and return to the Apply and Close
previous state, click .Restore Defaults

To delete a connection type:

In the connection properties window (  on a connection), on the  page, click  next to the F4 General Edit
 field. The Properties for connection types window opens.Connection type

In the Properties window, in the list of connection types, click the connection type to set the focus on it and 

then click the delete button under the list: 

Click  in the confirmation dialog box to confirm the deletion. Otherwise, click .Yes No

Click  to apply the changes and keep the window open or click  to apply the changes Apply Apply and Close
and close the window.

Delete Connection Type
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DBeaver supports two modes for committing changes to the database:

Auto-commit transfers all changes that you make immediately to the database.

Manual commit requires your confirmation before committing a change to the database or rolling it back.

Though available in many cases, the two modes are actionable only in . See the next sections for SQL Editor
details of using the modes.

To switch between the modes, use the mode selection button that appears in one of the two views:  or .

Auto-commit mode is the default one for the Development and Test connection types, see . Connection Types

Auto-commit mode is on if you can see the auto-commit view of the mode selection button ( ) in the application 

toolbar. If you see the manual commit view ( ), then in order to switch to auto-commit mode, click the mode 
selection button – it changes to auto-commit. At the same time, this disables the two manual commit buttons in the 
toolbar:  and  – these are available only in manual commit mode.Commit Rollback

The statistics field next to the mode selection button always shows  in auto-commit mode: .Auto

Clicking the statistics field opens the .Transaction Log

Manual commit is intended to protect your database from inadvertent changes and that is why it is the default 
mode for Production connection type, see .Connection Types

Manual commit mode is on if you can see the Manual commit view of the mode selection button ( ) in the 

application toolbar. If you see the auto-commit view ( ), then in order to switch to manual commit mode, click the 
auto-commit button – it changes to manual commit. At the same time, this enables the two manual commit buttons 

in the toolbar:  ( ) and  ( ).Commit Rollback

In manual commit mode, when you execute SQL statements ( ), the number of database modifying Ctrl+Enter
statements that pend commitment to the database appears in the statistics field next to the mode selection button: 

.

If you hover your mouse over the field, you can see the statistics of your SQL statements:

To commit statements to the database, click the  button in the toolbar. To discard them, click .Commit Rollback

Auto and Manual Commit Modes

Auto-Commit Mode

Manual Commit Mode
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If no modifying statements have been made, the statistics field shows : None

Clicking the statistics field opens the .Transaction Log

When smart commit is enabled and you are in auto-commit mode, which allows DBeaver to monitor your activity.
When you try to execute any data modifying query (UPDATE, INSERT, DELETE, UPSERT, MERGE, etc) 
DBeaver will switch to manual commit mode before executing your query. Also if you edit any table data and save 
your changes - DBeaver will also switch to manual mode before the actual data modification.

If the option "Return to auto-commit on transaction end" is on, then DBeaver will switch back to auto-commit mode 
once you have executed Commit or Rollback command (using the main toolbar or the main menu actions).

Smart commit mode is very useful if you work mostly in the read-only mode. It does not lock tables when you 
perform SELECT queries. The transaction will only be started when you start to modify your data.

For both, Auto and Manual commit modes, you can select the transaction isolation level. To do so, click the arrow 
next to the mode icon and then click the required option in the dropdown list:

Smart Commit Mode

Transaction Isolation Level
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The Transaction Log shows all transactions (queries of ‘transaction’ type such as INSERT/DELETE/UPDATE and 
others) made during the current DBeaver session. To open the Transaction Log, click the  button (Transaction log

) in the toolbar or the statistics field to the left of it.

The Transaction Log window shows transactions that are:

In progress or pending - shown without any special color

Successfully committed – in green: 

Rolled back – in orange or red: 

To see all previous transactions during the current session, select the  checkbox. To Show previous transactions
see all queries including non-transactional ones, select the  checkbox.Show all queries

Transaction Log
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It might be useful to check your pending transactions because they might lock your database. To see your pending 
transactions, click the arrow next to the  button in the toolbar and then click  Transaction Log Pending Transactions
on the dropdown menu:

The upper table of the Pending transactions window shows currently active connections and the number of their 
transactions. The bottom table shows query details of the connection that is currently in focus in the upper table:

When the Pending transactions window opens, the upper table shows only those connections that have pending 
transactions. If no connections have pending transactions, the table is empty. To see all connections that are 
currently active (connected), select the  checkbox.Show all connections

You can commit or roll back transactions right from the Pending transactions window: in the upper table, click the 
row with the required uncommitted transactions and then click the  or  button, depending on your Commit Rollback
purpose. If a transaction is committed/rolled back successfully, both buttons are disabled. If the operation is 
unsuccessful, the system displays an error message.

To see all previous transactions made during the current session, select the  Show previous transactions
checkbox. To see all queries including non-transactional ones, select the  checkbox. The green Show all queries
rows are committed transactions, the orange (or red) ones are rolled back, rows without a special color are non-
transactional or pending transactions.

Pending transactions
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You can use a pre-configured database driver or create a new driver.

DBeaver has a lot of pre-configured drivers including SQL, NoSQL, key-value databases, graph databases, 
search engines, etc. But sometimes you need to connect to a database which was not configured in DBeaver yet.

All you need is a JDBC driver of your database. The rest is easy.

JDBC driver is a program (in Java) which can connect and operate with some local or remote database server. It 
usually provides all needed functionality to cover 100% of database functionality. The JDBC driver is usually 
provided by database vendors to allow customers to work with their databases.

The JDBC driver consists of one or multiple  files. The Jar file is a library which contains program code and jar

some other files. You need to download the driver's jar files before adding them to DBeaver. Sometimes the jar 
files are included in the database server distribution - in that case you need to refer to your database 
documentation or ask your DBA.

Database drivers

Obtaining JDBC driver

Adding driver configuration in DBeaver

Open driver manager dialog
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You can open the driver manager from the main menu:

or from Database Navigator drop-down menu.

Add a new driver
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Just click the button New and create a new driver. On the driver edit dialog you need to enter all required 
information:

Parameter Description

Driver Name Name of your driver. It can be any name you like

Driver Type Driver provider. In 99% cases you will need a generic driver (JDBC provider)

Class Name
JDBC driver class name. You can get it from the documentation or find it in the jar files (see "Find Class" 
button description)

URL 
Template

Template of driver URL. You can leave it empty. But in this case you will be ready to set JDBC URL for each 
your connection. It is better to define a valid template, which will greatly simplify the connections creation. 
See "URL Templates" for a detailed description

Default Port Default database port. You can get it from the documentation or leave it empty

Embedded
Enable it for server-less databases. This flag affects a few config options related to the network/connections 
management

Main parameters
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No 
Authentication

This means that driver does not require authentication (no user/password fields will be shown)

Category Driver category, deprecated

ID Driver unique ID, ignore it

Description Driver description, it is shown in some dialogs/wizards as a hint

This is the list of jar files, binary libraries (dll or so) and any other files required by the driver. In most cases you 
only need the jar files.
Click "Add File" to add a single jar file, "Add Folder" to add to the folder with Java classes/resources and "Add 
Artifact" to add the Maven artifact (see below).

After you add the jar files you will be able to find all JDBC driver classes which are found in these jars. Just click 
on the "Find Class" button and DBeaver will show all of them. In most cases there is just one driver class in the 
driver. If there are many of them, you need to refer to the driver's documentation.

DBeaver can download driver jars directly from the Maven repository (it is a global public repository of Java 
libraries, usually an open-source). If your database driver is published on some public repository you can use this 
feature. Maven artifacts are better than plain jar files because you can see all existing driver versions and can 
change the driver version in runtime without any driver properties reconfiguration.

for additional information look How to add additional artifacts to the driver

After you have finished configuring your driver, just press the Ok button.
Now you can .create connection

If you need to change some driver properties later you can access them directly from connection properties dialog:

Libraries

Maven artifacts

Saving driver, adding connection
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JDBC drivers use URLs to identify remote servers - strings similar to classic web URLs. Usually, URL has form 
, for example `jdbc:postgresql:localhost:5432/postgres'. It is not very convenient jdbc:vendor:host:port/database

to edit such a long and an unobvious string. DBeaver can construct this URL from connection parameters (like 
host, port, etc).

For example above the URL template is: jdbc:postgresql://{host}:{port}/{database}
Host, port and database are parameters which you will need to enter on the connection configuration page.

Supported URL variables:

Parameter Description

{host} Database server host name

{port} Database server port number

{database} Target database name

{server} Target server name (rarely used)

{folder} Folder path (on the local file system). Used for embedded drivers

{file} File path (on the local file system). Used for embedded drivers

URL Templates

Advanced settings
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For most drivers you do not need to change any advanced properties. But in some cases you can use this as 
driver tuning, e.g. for better performance or for structure fixing.

Parameter Description

Driver supports indexes Driver supports table indexes

Driver supports stored code
Whether this driver supports stored code (procedures, functions, packages, 
etc)

Driver supports references Driver supports table references (foreign keys)

Driver supports SELECT count() clause | 
) clauseDriver supports SELECT count(

Driver supports views Driver supports table views

Split procedures and functions Show procedures and functions in different folders

Script delimiter Literal for SQL queries separation in scripts

Main parameters
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Script delimiter redefiner SQL clause which redefines script delimiter value

Use script delimiter after query Keep SQL script delimiter after each SQL query

Use script delimiter after SQL block Keep SQL script delimiter after SQL script blocks (BEGIN/END)

String escape character Character used to escape special symbols in strings

Meta model type Type of metadata reading model - standard or indexed

All Objects Pattern SQL pattern for all metadata objects

Omit catalog(s) Do not read and use catalog (aka database) information

Omit single catalog Hide catalog (database) if there is only one catalog on server

Omit schema(s) Do not read and use schemas information

Omit single schema Hide schema if there is only one schema on the server

Use schema filters
Use JDBC schema filters when the database does not support catalogs. 
Otherwise just read all database schemas and filter on client-side

Omit type cache Do not use data types provided by driver

Shutdown parameter Database shutdown URL parameter

Create database parameter Database create URL parameter

Driver supports multiple results Driver supports multiple results for a single query

Driver supports result set limit Driver supports multiple result set limit (max rows)

Driver supports structure cache Driver supports structure cache reading. Enables schema columns, keys, etc

Driver supports TRUNCATE operation
Driver supports TRUNCATE command. It is much faster than DELETE 
without criteria

Parameter Description

Get active database Query to obtain active database name

Set active database Query to change active database

Shutdown database Query to shutdown active database connection. Used for some embedded databases

PING query Query to check connection state

Dual table name Name of dummy 'DUAL' table which is used for expressions evaluation

Active object type Type of selectable object (schema, catalog)

Driver supports results scrolling Driver supports resultset scrolling

Quote reserved words Quote columns/table names if they conflicts with reserved SQL keywords

Escape LIKE masks in search 
queries

Use to access JDBC metadata API. Enabled by default but should be disabled for some 
(broken) drivers

Parameter Description

Queries (Custom driver queries)

DDL (DDL generation options)
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Drop column short syntax Use 'ALTER TABLE DROP column-name' instead of standard syntax

Drop column - use brackets Use 'ALTER TABLE DROP (column-name)' instead of standard syntax

Use legacy SQL dialect for DDL Use legacy SQL dialect for DDL

Add COLUMN keyword in alter table 
query

Add COLUMN keyword after keyword ADD and before column name in alter table 
query

Parameter Description

Timestamp 
format

Format pattern for timestamp columns

Date format Format pattern for date columns

Time format Format pattern for time columns

If you have configured some driver, it works well and you think that it makes sense to have this driver configuration 
in standard DBeaver, please send your configuration to us. Just create a feature request issue on GitHub and copy
/paste driver description to the ticket (in any suitable form).

Thank you.

Formatting (SQL values formats)

Summary
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1.  

2.  

1.  

2.  

3.  

4.  

ODBC allows you to create a connection to almost any database in DBeaver by using native ODBC drivers. You 
can use it as an alternative to DBeaver drivers or if DBeaver does not have a driver for your database.

Note: This feature is only available in , ,  and  editions.Lite Enterprise Ultimate Team

DBeaver works with ODBC drivers using ODBC driver manager. A driver manager is a component is installed in 
your operating system that provides access to drivers written in native programming languages.

On , a driver manager is already installed by default. Windows
You can access it by pressing  and typing .WIN+R odbcad32

On  and , you need to install this component separately. Linux macOS
We recommend the  as it's confirmed to work flawlessly with DBeaver against Linux iODBC driver manager
and macOS. To install, follow the provided instructions. 
You can access it by typing  in the terminal.iodbcadm-gtk

On , it's done by installing a driver using Windows Installer ( ). The installation is the same as Windows .msi

for any other software.

On  and , a driver can be either installed from a package manager or by building it manually. Linux macOS
Once a driver is installed, you need to add it to the driver manager. Open the driver manager, go to ODBC 

 tab, press  and select required files.Drivers Add a driver

Note: The process is mostly the same for all operating systems.

Open the driver manager

Go to  or  tabUser DSN System DSN

Choose  if you want to create a data source accessible only by the current userUser DSN

Choose  if you want to create a data source accessible by all usersSystem DSN

Click  and choose the appropriate driverAdd

Configure data source settings and click OK

JDBC-ODBC bridge

Installing ODBC driver manager

Installing ODBC drivers

Configuring ODBC data sources

Creating ODBC connections in DBeaver

https://dbeaver.com/dbeaver-team-edition
https://www.iodbc.org/
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Open the  dialog and select  (Not ).New Database Connection ODBC ODBC - Legacy

If you want to use a , switch to  connection type and choose it from a configured ODBC data source Data Source
drop-down menu:

Data Source Data Source (drop-down)

If you want to use an  and manually configure connection parameters, switch to  ODBC driver directly Manual
connection type and choose an appropriate driver from a drop-down menu and fill rest of the fields according to 
your configuration:

Manual Manual (drop-down)

DBeaver allows you to replace the underlying database driver of a connection with our ODBC driver. This is not 
the same as creating a new ODBC connection as it keeps all database-specific functionality untouched.

Note: In this mode, you can't use database-specific authentication methods and settings.

To do so, open existing connection and choose  as the driver type from the drop-down menu:ODBC

As of now, it's available for the following database drivers:

DB2

Making existing DBeaver connections use ODBC driver
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PostgreSQL

SQL Server

SQLite

MySQL
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1.  

Data transfer is a crucial feature that enables you to export and import data in various formats and even move 
data between tables in the same or different databases.

Export data

Import data

Importing from CSV

Importing from Excel

Importing from XML

Importing from database table

Note: The data transfer operation runs in the background, allowing you to continue working with your database 
during the export or import. However, try to avoid changing data in tables selected for export or import until the 
process is complete.

You can transfer data from one database to another or export it in different types and formats:

CSV

XLSX  (Excel spreadsheet)

HTML

XML

TXT

JSON

Markdown  files

SQL  statements

Source code arrays

The process of exporting data follows a similar procedure for the supported formats. Therefore, in this guide, we 
will focus on the data export process using the  format.CSV

Select a table or tables you want to export. In the context menu, choose .Export Data
: you can also export data from custom SQL query results. To do that, choose  in the results Note Export data

context menu.

Data export/import

Export data
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2.  

3.  

In the window that appears, choose  and click .CSV Next

Set data extraction options (how the data will be read from the tables). This may affect the extraction's 
performance. And set the export format option. They are specific to the data format you chose in step 2:
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4.  Set options for output files or clipboards. : Timestamp pattern is used here to target the file name pattern:Note
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5.  Review what you want to format and which format you will export. You can also save all your settings as a 
task in this step or change the task variables:



DBeaver User Guide 23.1. Page 323 of 526.

6.  

1.  

Press finish. See extraction progress. You can keep working with your database during the export process as 
the extraction will be performed in the background.

You can import data to your database from , , and  files.CSV XLSX XML

Select one or more tables to which you want to import data. In the context menu, choose :Import Data

Import data

Importing data from CSV file
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2.  

3.  

In the window that appears, choose  and click .CSV Next

Select the input  file for each table you want to import, and you can change the Importer settings (format CSV

specific) at this step:
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4.  Set CSV-to-table mappings. You must set a column in the  file for each database table column. You can CSV

skip columns (the value will be set to  in the target table column). You can set constant values for the NULL

table column if there is no source column in the .CSV
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5.  Set options for loading data in the database. These options may affect the loading's performance:
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6.  

Read our guide on  to learn more about the replacing method option.Data Import and Replace

Review which file(s) and to which table(s) you will import. You can also save all your settings as a task in this 
step:
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7.  Press finish. See extraction progress. You can keep working with your database during the export process as 
the data loading will be performed in the background. In the end, you will see the status message:

1) Choose the database table (or tables) you want to import data into. Do this by right-clicking on the table name in 
the  section and then clicking on .Database Navigator Import Data

Importing data from Excel file
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2) In the window that appears, choose  and click .XLSX Next

3) In the following window, choose the file that contains the data you wish to import into the table. Select the 
appropriate settings described below, then click .Next
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Setting 
name

Description

Header 
position

Determines the location of the column names in the Excel table, either at the top or none. This setting specifies 
whether the column names are located in the first row of the Excel table or if there are no column names present.

Skip 
empty 
roes

If this setting is enabled, any open string values encountered during the data processing will be ignored and not 
inserted into the corresponding cells in the row. If the setting is disabled, all cells in the row will be filled with a 

 value if an empty string is encountered.NULL

Import all 
sheets

Specifies that all sheets in the file should be imported during the data import process.

Specific 
sheet 
name

Enables you to choose a particular sheet from the Excel file for importing during the data transfer process.

Date/time 
format

Use this setting to specify the date format used in the  file. This is used to clarify the date format during the XLSX

import process and does not affect the output data. You can refer to the  documentation java DateTimeFormatter
for details on the format pattern syntax.

Timezone 
ID

The local machine timezone is used by default. There are three ways to specify the timezone: 
1) Local zone offset: Specify the offset from UTC in the format of either a positive or negative number (e.g., +3, 
-04:30). 
2) Specific zone offset: Specify the offset from GMT or UTC in the format of GMT+/-X or UTC+/-X (e.g., GMT+2, 
UTC+01:00). 
3) Region-based: Specify the timezone using a region-based identifier such as UTC, ECT, PST, etc.

Sample 
rows 
count

Determines the number of rows that will be used as a sample to estimate the length and data types of the 
imported data.

Minimum 
column 
length

This value is used when creating a new column and specifying its type, if necessary. It indicates the minimum 
number of characters or digits expected in the column. This information helps determine the appropriate data 
type and size for the column during the creation process.

Save task
Opens the  to assist in creating a task during the data transfer process. This window provides Save Task window
options and settings for creating and configuring a task related to the data transfer operation.
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5) In the next window, set XLSX-to-table mappings. Please refer to our guide for detailed information on the 
.mapping process

6) Select your data load settings in the subsequent window, and then click . For more information, please Next
refer to our article's section .Data load settings

7) In the final window, you can review all the settings you selected earlier. If you missed something, you could go 
 and fix it. When you're ready, finish the import by clicking .Back Proceed
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8) If the  file is valid and there are no errors, you will see a notification window with information about the XLSX

completion of the task. You can keep working with your database during export, as the data loading will be 
performed in the background.

1) Select the database table (or tables) where you want to import data. Do this by right-clicking on the table name 
in the  section, then clicking on .Database Navigator Import Data

Importing data from XML file
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2) In the window that appears, select  and then click .XML Next

![](images/dt/xml/dt-xml-import-source.png)

3) In the following window, select the  file that contains the data you want to import, then click .XML Next

![](images/dt/xml/dt-xml-input-file.png)

4) In the next window,w set XLSX-to-table mappings. Please refer to our guide for detailed information on the 
.mapping process

![](images/dt/xml/dt-xml-table-mapping.png)

5) select your data load settings in the subsequent window, and then click . For more information, please refer Next
to our article's section .Data load settings

![](images/dt/xml/dt-xml-data-load-settings.png)

6) In the final window, you can review all the settings you selected earlier. If you missed something, you can go 
back and adjust it. Once everything looks good, finish the import by clicking .Proceed

![](images/dt/xml/dt-xml-confirm.png)

7) If the file is valid and there are no errors, you'll see a notification window with information about the completion 
of the task. You can keep working with your database during export, as the data loading will be performed in the 
background.

![](images/dt/xml/dt-xml-complete.png)
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DBeaver offers seamless data migration capabilities, allowing you to transfer data from one database table to 
another. For more detailed instructions and insights on data migration, you can refer to our article on Data 

 guide.Migration

Importing data from the database table
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DBeaver supports data migration of tables from one database to tables of another one.

To perform a data transfer, please, follow the steps below.

In the  select one or more tables you want to export. In the context menu choose . Database Navigator Export Data
(Note: you also can export data from the custom SQL query results. For that, choose  in the results Export data
context menu).

In the opened dialog box choose  type as the data transfer target and press .Database Next

Data migration

Step 1: Define the data source

Step 2: Define data transfer target type
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For proper table mapping, the following options are available:

Step 3: Define data mapping
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Target container - defines a database or a scheme where the data will be transferred to. Press  button 
and choose the container.
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Source - contains names of all the tables selected at step 1. You can also see the list of columns existing in 

the source table by pressing 

Target - contains names of the tables where the data will be transferred to.

Mapping - contains the list of actions to be applied to the source data on data transfer. The following options 
are available:

- the source data will be populated into a newly created table or column of the target container.Create
 - the source data will not be transferred to the target container.Skip

 - the source data will be transferred to the table that already exists in the target container.Existing
 - this value is set by default when there is no target defined.Unassigned

If the cells are marked with , it means that in the target table there are no columns with matching names, 
otherwise the names will be filled in automatically.

You may also want to transform the values of some columns during the transfer. To do that, define column 
transformers by clicking on corresponding cells in the  column. You can choose one of three options: Transform

Set to NULL. All values in the corresponding column will be set to null.

Constant. All values in the corresponding column will be set to the specified constant.



DBeaver User Guide 23.1. Page 339 of 526.

Expression. This transformer uses expressions (namely, JEXL expressions) to calculate the cell's value. You 
can use basic arithmetic operations and column names to construct an expression.

You can define a target table by clicking on a cell in the  column and entering its name, or press the  Target New

button  and enter a new name in the opened dialog box.

You can also choose a name for a target table from the drop-down list.
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Or select a table from the existing tables in the target container by pressing the  button Browse

To define the mapping setting for a column in a target table, release the list of source table columns by pressing 

 next to the table's name in the  column, then click the name of the target column and enter a new one Source

or select one from the dropdown list. To collapse the list, press 

If you want tables of the target container to be named like those of source, press the  button Auto assign

 and the  column will be automatically populated.Target

You can also define the names of target columns, as well as their data types, by clicking a row with a table name 

and pressing the  button Columns
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The following elements are available here:

Source column -this column contains names of columns existing in the selected source table;

Source type - this column contains the list of data types assigned to the columns in the selected source table;

Target column - this column contains names of target table columns where the data from the source column 
will be transferred to. To change the name, click the cell and enter a new name.

Target type - this column contains the list of data types that will be assigned to the columns in the target 
table.

: Sometimes data types that are supported on the source database are not supported on the IMPORTANT
target or vice versa. 
To set a data type for a column in a target table, click the cell in the  column and select one from Target Type
the dropdown list of data types supported on the target.

Mapping - this column contains the list of actions to be applied to the data on data transfer.

To change the mapping type, click a cell in the  column of  and select the Mapping Table mapping dialog box
required mapping type.
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You can also view the SQL script that will be run on data transfer by pressing the  button Target DDL

.

If you want to see a preview of the imported data, you can select the  buttonPreview data



DBeaver User Guide 23.1. Page 343 of 526.

The following keyboard shortcuts for easy navigation within the mapping table area of  screen are Table mapping
supported:

Shortcut Action

Up Moves one row up.

Down Moves one row down.

Right Releases the list of source table columns.

Left Swaps the list of source table columns.

Space Auto-assigns the target.

Del Sets mapping type to skip.

Configure data mapping and press .Next

Data export settings are grouped into  and .Extraction settings Data load settings

Step 4: Define export settings
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Extraction settings define how the data will be pulled from the source. The following options are available:

Option Description

Maximum 
threads

Defines the number of threads to be used for data transfer.

Extract 
type

Select  option if your data load is not too big. Select  option if you need to migrate a Single query By segments
solid amount of data. When this option is selected you can set the  value, that is to define the Segment size
number of rows to be transferred in each segment.

Open new 
connection
(s)

If selected, a new connection will be opened and the data transfer will not interfere with other calls to the 
database whose data is being transferred.

Select 
row count

If selected, a progress bar displaying data migration process will be shown.

Fetch size
Specifies the number of rows to fetch per server round trip. This setting has a significant impact on the extraction 
performance during data retrieval.

Extraction Settings
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Data load settings define how the extracted data will be pushed to the target. The following options are available.

Option Description

Transfer auto-
generated columns

Fill in or skip columns marked with the "autogenerated" status. Some databases accept values in such 
columns, while others will throw a syntax error.

Truncate target 
table(s) before load

Select this checkbox only if you want all the data to be cleared from the target table. Be very careful 
with this option!

Disable referential 
integrity checks 
during the transfer

Disabling constraints in the target table. This setting prevents database errors by temporarily disabling 
the constraints. However, please note that not all databases support this functionality.

Replace method Read our guide on  to learn more about the replacing method option.Data Import and Replace

Open new 
connection(s)

Use this option to speed up data transfer. If selected, a new connection will be opened and the data 
transfer will not interfere with other calls to the database where data is being transferred to.

Use transactions
This option allows you to speed up the data transfer and to define the number of rows for each 
transaction by setting the  parameter.Commit after insert of

Do Commit after 
row insert

Performing a commit after a certain number of inserted rows. This setting specifies that a commit 
operation should be executed after a specified number of rows have been inserted into the table.

Use multi-row 
value insert

Use multi-row insert with extended values number for higher performance. Database-specific setting.

Skip bind values 
during insert

This option can drastically increase performance for some drivers like Redshift by skipping a process of 
binding values and setting them directly, but it opens up a vulnerability to SQL injections. Not 
recommended if you are not sure of imported file contents.

Disable batches
Select this checkbox if you want to disable the use of batch imports. The import will be made row by 
row. Enabling this function will show all import errors, but make the import process slower.

Ignore duplicate 
rows errors

In the import process, if a database encounters a duplicate key from the import row in the target table, 
such errors are ignored, and the import operation continues without failure.

Use bulk load
Bypasses transaction settings and loads the entire dataset using the native tool provided by the 
database.

Open table editor 
on finish

If selected, the table editor is to be opened when data transfer is finished.

Show finish 
message

If selected, a notification message will be shown when the transfer is finished.

Save task
Opens the  to assist in creating a task during the data transfer process. This window Save Task window
provides options and settings for creating and configuring a task related to the data transfer operation.

Data load settings

Step 5: Confirm
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Check out the data transfer settings and press  or save as .Start task
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Sometimes there are situations when you want to ignore the current primary key value when importing into a table. 
Some databases have syntax constructs in addition to the INSERT INTO that may help.

The choice of the replacement method is in the import settings - in "Data load settings".

By default, the selection is >, you can select other options from the drop-down list. The options available <None

depend on the target database you are importing to.

Data Import and Replace

Data Import and Replace.
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The database can only support the replace method or the ignore method. In this case, the list of methods will 
consist of only one item except >. If the base does not support the replacement methods, or if we have not <None

added an implementation yet, then the combo with the list will be disabled.

Further, you will find a list of databases supporting these methods and examples of syntax.

Let's take a look at an example of how this works. We use a small, simple, slightly-modified Sakila (MySQL) table - 
sakila.language

CREATE TABLE language_insert (
language_id tinyint unsigned NOT NULL,
name char(20) NOT NULL,
last_update timestamp NOT NULL,
PRIMARY KEY (language_id)
);

INSERT INTO sakila.language_insert (language_id,name,last_update) VALUES
(1,'English','2006-02-15 05:02:19.0'),
(2,'Italian','2006-02-15 05:02:19.0'),
(3,'Japanese','2006-02-15 05:02:19.0');

If we try to execute this request twice, we will get the following error: SQL Error [1062] [23000]: Duplicate entry '1' 
for key 'language_insert.PRIMARY' (This message may look different in other databases).

Let's take a new .csv file with the following content and try to use the replace methods.

"language_id","name","last_update"
1,Spanish,"2020-04-20 05:02:19.0"
2,Russian,"2020-05-20 05:02:19.0"
3,Belgian,"2020-06-20 05:02:19.0"
4,Mandarin,"2006-02-15 05:02:19.0"
5,French,"2006-02-15 05:02:19.0"
6,German,"2006-02-15 05:02:19.0"

If we set the "INSERT IGNORE" method in the settings, the result of the insert will look like this:

There will be no insertion errors, the first three lines will not change, and the fourth to sixth lines will be added to 
the table.

If we set the "REPLACE INTO" method in the settings, the result of the insert will look like this:
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There will be no insertion errors, the first three lines will be replaced and the fourth to sixth lines will be added to 
the table.

INSERT IGNORE and REPLACE INTO

Insert examples:

"INSERT IGNORE"

INSERT IGNORE INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0');

"REPLACE INTO"

REPLACE INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0');

Documentation 
"INSERT OR IGNORE" and "INSERT OR REPLACE"

Insert examples:

"INSERT OR IGNORE"

INSERT OR IGNORE INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0');

"INSERT OR REPLACE"

INSERT OR REPLACE INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0');

Which databases support replace/insert methods?

MySQL

SQLite

https://dev.mysql.com/doc/refman/8.0/en/insert.html
https://dev.mysql.com/doc/refman/8.0/en/replace.html
https://sqlite.org/lang_insert.html
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Available for . PostgreSQL version 9.5
"ON CONFLICT DO NOTHING" and "ON CONFLICT DO UPDATE SET"

Insert examples:

"ON CONFLICT DO NOTHING"

INSERT INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0') ON CONFLICT DO NOTHING;

"ON CONFLICT DO UPDATE SET"

INSERT INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0')
ON CONFLICT (language_id)
DO UPDATE SET (language_id, name, last_update) = (EXCLUDED.language_id, EXCLUDED.name, EXCLUDED.last_update);

Available for . FireBird version 2.1
"UPDATE OR INSERT INTO"

Insert examples:

"UPDATE OR INSERT INTO"

UPDATE OR INSERT INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0');

Available for . Oracle version 11.2
"INSERT IGNORE ROW INDEX"

Insert examples:

"INSERT IGNORE ROW INDEX"

INSERT /*+ IGNORE_ROW_ON_DUPKEY_INDEX(LANGUAGE_INSERT, LANGUAGE_INSERT_PK) */
INTO LANGUAGE_INSERT(LANGUAGE_ID, NAME, LAST_UPDATE) VALUES(1, 'English', TIMESTAMP '2006-02-15 05:02:19.0');

PostgreSQL

FireBird

Oracle

https://www.postgresql.org/docs/9.5/sql-insert.html
https://firebirdsql.org/refdocs/langrefupd21-update-or-insert.html
https://docs.oracle.com/cd/E11882_01/server.112/e41084/sql_elements006.htm#CHDEGDDG
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NB: This feature is available in ,  and  editions only.Enterprise Ultimate Team

DBeaver supports native database backup/restore functions for the following databases:

PostgreSQL

MySQL

The native backup restore differs from the standard DBeaver  feature. It uses database native dump data transfer
formats and it may work much faster as it uses special utilities for the direct high-performance database access.

These functions can be accessed from the Context Menu's Tools or the Main Menu's Database->Tools. 

In order to execute native backup/restore tools you need to configure the database native client. The native client 
is a set of binaries (different for different OSes) which will be executed by DBeaver to process an actual backup
/restore. The native client configuration can be done in  or directly from the backup/restore driver editor dialog
wizard. Just click on the  button in the button bar: Client ...

To configure a new client location, choose the  item and add a new client in the following dialog:Browse ...

Database backup/restore

Database Backup/restore

Native client configuration

https://dbeaver.com/dbeaver-team-edition
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You can choose what schemas/tables you want to backup/dump: 

Database dump object selector

Database native tool configuration
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You can pass a set of additional dump/restore parameters to the native tool. The particular set of configuration 
options depends on the database type.
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Note: This feature is available in ,  and  editions only.Enterprise Ultimate Team

The task is a saved configuration of a database tool. It can be started from the task management view or from the 
menu by a single click. You can create tasks for frequently used tools. Also, tasks can be  for regular scheduled
execution.

You can save the tool configuration into a task and run your task later with a single click. For example, you can 
start the  wizard and configure the data export from several tables in the SQLite database into CSV Data Transfer
files:

Click on the  button and fill the task properties:Save configuration as task

Task management

Creating tasks

Create a task from tool configuration

https://dbeaver.com/dbeaver-team-edition
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Now click on the  link to open the task list:Open Tasks view

You can configure the Database Tasks View to see more or fewer View columns. Right-click inside the Database 
Tasks tab and choose the  button from the menu.Configure columns
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Also, you can create a new task from the main menu .Database -> Tasks -> Create new task...
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From the task view you can add, edit, remove and execute saved tasks. You can use the context menu or view 
tools for that:

Editing/running tasks
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By clicking on  or by double-clicking on a task you can open the tasks edit wizard. In this wizard, you can Edit

change the task settings as well (use button ) as the actual tool configuration. You can change the set of Back

input objects for data transfer or any export configuration. After changing the task settings, click on the  Save task

button (it is on the last page of the task configuration wizard).
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You can create a task from scratch using the tasks view. Open tasks view and click on the  Create new task

button in the View toolbar or in the context menu. In the task wizard, you can choose the task category, task type, 
task folder, and name. On the next wizard pages, actual tool configuration pages will be shown (they depend on 
the chosen task type).

For better structuring, you can store your tasks in the folders. Create folder can also be from the context menu 
Database Tasks View.

Create a task from task management view

Tasks folders
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You can choose a project for the new task folder and add a new unique name.

You can change the task folder for an existing task in the task Edit dialog (use button ). Or you can drag Back

your task to another task folder in the View.

The task folder as a task can be deleted with the button .Delete

You can schedule tasks for later/regular execution. See the  article.Task Scheduler

Scheduling tasks
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Note: This functionality is available in ,  and  editions only.Enterprise Ultimate Team

DBeaver can schedule execution for regular tasks. DBeaver supports  on Windows and Windows Task Scheduler

 on macOS and GNU/Linux. In addition, you can manually configure schedulers .cron using command line

You can open the tasks view from the main toolbar:

or from the main menu Window. Select a task that you want to schedule in the tasks view and open the context 
menu:

DBeaver will open the scheduler configuration dialog. You can configure task frequency, recurrence period and 
start time there:

Task scheduler

Scheduling tasks from the Tasks view

Windows

https://dbeaver.com/dbeaver-team-edition
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To schedule the task, click on the Schedule button. If everything is OK, you will see the confirmation dialog:
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1.  

If anything goes wrong, you will see an error message dialog. You can view error details in the  view.Error Log

You can change the scheduler settings at any moment by choosing Edit scheduled task command from the 
context menu. You can also cancel the schedule by clicking on Remove schedule.

You first need to open the tasks view. There are three ways to do that:

Database -> Tasks -> Database Tasks

macOS or GNU/Linux



DBeaver User Guide 23.1. Page 364 of 526.

2.  

3.  

1.  

2.  

Window -> Database Tasks

Click on 'Show View (Database Tasks)' icon

Select a task you want to schedule in the tasks view. To open the scheduler dialog, either:

Open the context menu with right-click -> Scheduler -> Schedule task

or click on the 'Schedule task' icon
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DBeaver will open the scheduler dialog. It has a lot of similarities with the corresponding dialog in Windows, but 
unfortunately, there are fewer settings on macOS and GNU/Linux due to the limitations of . For instance, cron

when configuring an hourly task, you can only choose the minute at which the scheduler executes the task. In the 
example below, the task executes at 1:42 PM, 2:42 PM, 3:42 PM, and so on:

There is also no start date option and, in the case of minutely tasks, no start time either. The scheduler will 
execute the task at the specified time, but there are no guarantees when the execution starts. It is also worth 
pointing out that even though you can specify the seconds in the start time selector, the scheduler will ignore 
them. Even though we try to be compliant with as many cron implementations as possible, most cron 
implementations do not support this type of granularity.

On macOS 10.15 or newer versions, when scheduling a task for the first time, you will be prompted with 
something like this:
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Click 'Yes' to proceed. The reason for that prompt is that macOS considers the  settings (crontabs) to be cron

system settings, and DBeaver will not be able to change them without your permission.

After that, you will see the confirmation message. Just like in Windows, you can change the scheduler settings at 
any moment by choosing the 'Edit scheduled task' command from the context menu, or cancel the schedule by 
clicking on 'Remove schedule'.

You can see and change the scheduled task details in the Windows Task Scheduler. Click on the Open scheduler 
settings command in the task view context menu:

DBeaver stores all tasks in a folder called .DBeaver

See schedule details

Windows
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You can take a look at the crontab DBeaver uses to schedule tasks in  by clicking the 'Open scheduler cron

settings' command in the task view context menu. You can also do it in the terminal by using the command 
. Although you can also edit the crontab by using , we strongly do not recommend it.crontab -l crontab -e

You can look through the task execution logs on the right side of the tasks view. By double-clicking on a task run 
item, you can see the full log with all details, errors, and warnings:

DBeaver keeps the task run logs in the  directory, subfolder .metadata/task-stats.workspace

The task scheduler uses the DBeaver  interface to perform task executions. Command-line command line
parameter  launches saved task executions (immediately). TASK_ID has the form -runTask TASK_ID

. You can omit the project name part if you have only one project in your workspace. In @projectName:taskName

Windows, you can use the  executable to run tasks. Please note that if you use  executable dbeaver-cli dbeaver

(for any reason), you will need to add the command line parameter  to avoid a splash screen -nosplash

appearance.

macOS or GNU/Linux

Monitoring for task execution (any OS)

Running tasks from the command line (any OS)

Troubleshooting
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When you

Enable enterprise security for database credentials

Use Mail server authentication to send data transfer results over email

Then these settings won't be accessible in scheduled tasks by default. But you can use defult OS-specific 
enryption for that. Master password won't be used so it is a bit less secure configuration (credentials are still 
encrypted but they may be stolen if hacker will gain access to your computer).

To enable this you need to: 

Go to Prefefences->General->Security->Secure Storage

Disable "DBeaver Enterprise Password provider" and "UI prompt"

Update credentials you want to use for scheduled task:
For Mail profile you can open mail settings and click Ok

For database credentials got to Preferences->Connections->Entrprise security and toggle "Use secure 
password storage" on and off to trigger stored credentials re-encryption

User credentials + enterprise security
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1.  

2.  

1.  

2.  

1.  

2.  

1.  

There are two implementations of the Windows scheduler present:

CLI-based ( ): uses  to communicate with the scheduler; sensitive to locale-dependent Legacy schtasks.exe

data, such as Unicode names and date-time format.

COM-based ( ): uses COM API to communicate with the scheduler; more flexible and provides more New
features than the CLI version.

COM-based implementation is used by default, starting from the 21.1 version of DBeaver EE.

If you encounter an error in Windows which contains the following text: 
,com.sun.jna.platform.win32.COM.COMException

do the following:

Open the file  in the directory with your DBeaver installationdbeaver.ini

Place the line  below the  line.-Ddbeaver.scheduler.windows.legacy=true -vmargs

If you encounter an error in Windows which looks like this: 
,ERROR: Invalid Start Date (Date should be in %some_format% format).

do the following:

Open the file  in the directory with your DBeaver installationdbeaver.ini

Place the line  (where %some_format% is a format -Ddbeaver.scheduler.windows.dateFormat=%some_format%

from the error message) below the  line.-vmargs

This flag is available starting from the 7.3.4 EA version of DBeaverEnterprise and might be removed in the future.

When scheduling tasks on macOS 10.15 or newer versions, the OS will prompt you to elevate DBeaver's 
permissions to administer your computer. If you do not grant these permissions, DBeaver will fail to schedule your 
tasks with an error . To bypass this, simply restart DBeaver and try to Unable to read or write to crontab

schedule the task again. The operating system will prompt you to elevate the permissions again. If macOS never 
prompted to do that in the first place, you could grant  permissions in the macOS settings. Here Full disk access

is how to do that:

Open .System Preferences

Windows scheduler overview

Windows Task Scheduler: COM exception

Non-legacy scheduler only

Windows Task Scheduler: incorrect date format

Legacy scheduler only

macOS 10.15+: Unable to read or write to crontab
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2.  

3.  

4.  

5.  

6.  

7.  

8.  

9.  

Click on .Security & Privacy

Choose the  tab.Privacy

Choose the  folder.Full Disk Access

Unlock the preferences lock to the bottom if it is locked.

Click the + button.

Select DBeaverEE in the file picker that opens.

Click .Open

Close the lock.

You need to pass a password for one or more projects via the command-line interface.

To do so, you need to set the  parameter in  like so:dbeaver.project.password the external configuration file

# You can specify a single password for all projects:
dbeaver.project.password=p4$$w0rd

# Otherwise, you can specify a list of passwords for given projects:
dbeaver.project.password=@General:p4$$w0rd,@Other:12345

The syntax for a single entry is ; others are separated by @ <name of the project> : <password of the project>

the  symbol.,

Please note that  and  symbols are mandatory.@ :

Tasks from password-protected projects cannot be run
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Note: This functionality is available in ,  and  editions only.Enterprise Ultimate Team

As the name suggests, the  is a type of task that consists of other tasks. Just like the other type of composite task
tasks, the composite tasks can be scheduled via . Let's take a look at what they can offer.Task Scheduler

The first thing we need to open is the  dialog. You can do it in multiple ways:Create a task

From the context menu in the database navigator -> Tools -> Create new task... -> Composite task

By clicking Database -> Tasks -> Create new task... -> Composite task

From the context menu in the Database Tasks view.

Choose , enter the task name, description (optional), and hit .Composite task Next

You will be presented with the following dialog:

When creating a composite task, you need to specify which tasks the composite task consists of.

Composite tasks

Creating a composite task

Setting up a composite task

https://dbeaver.com/dbeaver-team-edition
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1.  

2.  

3.  

This can be done:

By adding an existing task. To do that, click the button with the plus sign

By creating a new task and adding it simultaneously. To do that, click the button below the aforementioned 
button with the plus sign

By drag-and-dropping a task from the _Database tasks panel.

As a side note, you can add a composite task to your new composite task.

You can edit tasks in the same dialog, delete a task from a composite task, and change the execution order.

There is also a very important checkbox, . The tasks from the  are executed in the Ignore task error composite task
order they appear in the settings dialog. Executing a task from a  might produce an error that will composite task
block the next tasks from proceeding. The  checkbox can be used to bypass this behavior.Ignore task error



DBeaver User Guide 23.1. Page 373 of 526.

Note: The following feature is only available in  and  editions.Enterprise Ultimate

DBeaver offers a way to send data exported via  by email.Data Transfer

First, you'll need to add an SMTP profile to send the email. Go to  #  #  # Window Preferences General Mail
and create a new profile.

Parameters  and  may depend on the mail service you use. Use the latter if the service offers SSL Host Port
and TLS ports. Gmail, for example, uses host  and port . An example of a configured profile:smtp.gmail.com 587

Then you can use the  button to verify that the host and credentials are valid.Test connection

Please take a look at the  section for more information on resolving common authorization troubleshooting
problems.

When at least one  is present, you can set up email sending. Create a regular export task, go to the profile Output
page, and make sure the  option is enabled. By pressing the  label Send results by email Configure
near it, you can specify several recipients and the subject for your mail:

Sending results by e-mail

SMTP profile configuration

Setting up data transfer



DBeaver User Guide 23.1. Page 374 of 526.

You also have control over the specifics of what you receive, as follows:

Omit Empty Results: Enable this option to prevent emails from being sent when no results are displayed.

Report Task Failure: Enable this option to receive an email alert whenever a task fails.

Bypass Server Certificate Verification: This option can be used when working with self-signed certificates and 
you wish to bypass the standard certificate validation process.

That's it. After completing the task, the specified recipients will receive an email containing the exported file in a 
specified format during the data transfer.

You may face various problems while setting up a new SMTP profile.

Several common errors when using Gmail and solutions for them are described below:

535-5.7.8 Username and Password not accepted . Check that the username and password are correct. If you 
are confident that you have entered valid credentials, then try creating an app password.
Read more at https://support.google.com/accounts/answer/185833

534-5.7.9 Application-specific password required . You have two-factor authorization enabled. You will 
need to generate a special password for DBeaver to use.
Read more at https://support.google.com/accounts/answer/185833

There were also several cases when the antivirus would block DBeaver from sending an email.

Authorization troubleshooting

https://support.google.com/accounts/answer/185833
https://support.google.com/accounts/answer/185833
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1.  

2.  

Using , you can export files to external storage, such as Google Drive.Data Transfer

Download and install Google Drive for desktop here

Configure Drive for streaming mode according to this article

After that, in the data transfer wizard, change the output directory to the Drive directory.

It can be achieved by using .Task Scheduler

Note: This functionality is available in ,  and  editions only.Enterprise Ultimate Team

Uploading result to external storage

Exporting files to Google Drive

Exporting automatically

https://www.google.com/drive/download/
https://support.google.com/drive/answer/10838124
https://dbeaver.com/dbeaver-team-edition
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Cloud Explorer provides a deep integration with classic cloud service providers such as Amazon, Google and 
Azure.

Note: Cloud Explorer is supported only in .DBeaver Ultimate Edition  Version 21.0 supports only AWS (Amazon 
Cloud Services) cloud.

It allows users to configure cloud access once and then easily browse, connect and manager all cloud databases 
with just a few clicks.
There is no need to configure each database connection manually, all database endpoint information reads 
directly from the cloud provider. Authentication is managed in a centralized mode - you use your cloud account to 
get access to the cloud databases.

Before you begin to work with cloud explorer you need to configure your cloud provider access. Configuration 
includes access credentials, availability zones which will be used to search databases and some other cloud-
specific settings. Cloud configuration is different for each cloud service provider.

Once you configure the cloud configuration you can open the Cloud Explorer dialog and start adding database 
connections. In the top drop-down of explorer dialog you can select the active cloud configuration or click "Edit" to 
change the cloud configuration.

In the center of the dialog you can see cloud databases in a hierarchical view. All databases are grouped by 
database/service type. When you expand one of the top elements, DBeaver will start to search cloud databases in 
configured availability zones/regions.

Cloud Explorer

Overview

Cloud configuration

Configuring AWS cloud

Explorer

https://dbeaver.com/products/dbeaver-ultimate-edition/


DBeaver User Guide 23.1. Page 377 of 526.

If you have a large number of databases in your cloud, you can search or filter them using filter text above the 
cloud navigator.

You can drag-and-drop cloud databases directly to  or . You can also check database navigator view projects view
any number of databases in the Cloud Explorer using the checkbox control on the left side of the Cloud Explorer 
tree, and then click on the "Add to Project" button in the bottom right corner.

You can always see your cloud database configuration in a special tab in the connection settings dialog. This 
information depends on both cloud and database type. You can also click on the external link to open your 
database configuration in the cloud provider web console.

Database cloud information
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AWS

AWS (Amazon Web Services) Cloud Explorer

Cloud configuration
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Supported cloud databases



DBeaver User Guide 23.1. Page 382 of 526.

1.  

2.  

3.  

4.  

5.  

6.  

7.  

Note: This feature is available in , ,  and  editions only.Lite Enterprise Ultimate Team

DBeaver is integrated with AWS IAM authentication.
Thus it provides the possibility to authenticate in AWS to access your cloud databases.
To use IAM authentication in DBeaver, in connection configuration  should be selected as an AWS RDS IAM

authentication method:

DBeaver AWS IAM has endless ways to authorize and authenticate users. DBeaver supports all basic ones.

You can select the credentials type by selecting the required credential in  selector:Credentials

When you use Default Credentials, AWS will then try to determine credentials by using the standard credential 
providers chain:

Java system properties

Environment variables

Web identity token from AWS STS

The shared credentials and config files

Amazon ECS container credentials

Amazon EC2 instance profile credentials

Amazon SSO credentials

Using default credentials is essentially the simplest way to integrate with various SSO providers and web identity 
providers, as they usually provide credentials through config files.

Please read the  for a detailed explanation.AWS credentials documentation

AWS Credentials

Default credentials

https://dbeaver.com/dbeaver-team-edition
https://docs.aws.amazon.com/sdk-for-java/latest/developer-guide/credentials.html
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To use Default credentials, enter the username in the  field and select the AWS region.User

It is the most straightforward way to authenticate. You only need to enter the IAM user access key and secret key. 
You can save them locally or (more securely) enter them every time you connect to a database.

As previously mentioned in the Default configuration, you should enter your username and select AWS region. 
Then, if you checked , you need to fill in the  and  fields. If Save credentials locally Access key Secret key

 is not checked, the dialog asking to fill these fields will be prompted each time you Save credentials locally

connect to the database:

Official AWS instructions: Managing access keys for IAM users

Similar to default credentials, but you can also choose which credentials profile you want to use.

First, select the available configured profile, information how it can configured can be found below, then as in 
previous examples fill in  field and select your AWS region.User

The official AWS instructions can be found at .credentials config files

Access keys

AWS Profiles

Single Sign On

https://docs.aws.amazon.com/IAM/latest/UserGuide/id_credentials_access-keys.html
https://docs.aws.amazon.com/credref/latest/refdocs/creds-config-files.html
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If your AWS account has a configured SSO portal, you can use a web-based SSO authorization. SSO support can 
be enabled for Default and Profile-based AWS authorization types.
You need to turn on the "Enable SSO" option.

If you have a configured AWS Secret, you can use it to access your database. Secrets can be used for RDS 
databases and Redshift. Instructions on how to create AWS Secret can be found . A Password field is here
required.

To use this functionality tick  and fill in the  fieldUse AWS Secrets Manager Secret Name

The secret needs to be in the same region as the database.

AWS Secrets Manager

Note

https://docs.aws.amazon.com/secretsmanager/latest/userguide/
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NB: This feature is available in , ,  and and  editions only.Lite Enterprise Ultimate Team

AWS Single Sign-On is a cloud-based single sign-on (SSO) service that makes it easy to centrally manage SSO 
access to AWS resources.
You do not need to specify any user credentials explicitly in DBeaver connections configuration. All authorization is 
performed in a web browser in a 3rd party SSO provider, e.g. Google workspace, Microsoft AD portal, Facebook, 
etc.

You need to install AWS CLI (Command Line Interface) utilities to enable SSO authorization.
AWS CLI installation

AWS CLI version 2.2 is recommended.

If you are in a corporate environment where all AWS configurations are provided by system administrators then 
you do not need to configure SSO parameters. Otherwise, you need to open the command shell ( ), enter win+R

, press enter, and provide the required parameters. Read  for the aws configure sso configuration instructions
details.

Restart DBeaver after the AWS CLI SSO configuration will be finished.

In the DBeaver database connection dialog you need to:

Set Authentication to .AWS IAM

Set Credentials to .AWS Profile

Choose the profile which was configured with AWS SSO (see the previous chapter).

Click on the  check.Enable SSO

Now you can connect. DBeaver will open a web browser with SSO authorization.

AWS SSO

AWS CLI

AWS SSO configuration

Connection configuration

https://dbeaver.com/dbeaver-team-edition
https://docs.aws.amazon.com/singlesignon/latest/userguide/what-is.html
https://docs.aws.amazon.com/cli/latest/userguide/install-cliv2.html
https://docs.aws.amazon.com/cli/latest/userguide/cli-configure-sso.html
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Service Read Policy Write Policy

Login -

Cloud 
Explorer

-

S3 AmazonS3ReadOnlyAccess AmazonS3FullAccess

Redshift AmazonRedshiftReadOnlyAccess AmazonRedshiftFullAccess

RDS AmazonRDSReadOnlyAccess AmazonRDSFullAccess

DynamoDB AmazonDynamoDBReadOnlyAccess AmazonDynamoDBFullAccess

DocumentDB AmazonDocDBReadOnlyAccess AmazonDocDBFullAccess

Keyspaces AmazonKeyspacesReadOnlyAccess AmazonKeyspacesFullAccess

Athena

"lakeformation:Describe",
","lakeformation:Get

"lakeformation:List",
"sns:ListTopics",
"sns:GetTopicAttributes",

","s3:Describe
"s3:Get",

","s3:List
"s3:Put",

","glue:Get
"glue:List",

","glue:BatchGet
"athena:List",

","athena:Get
"athena:Batch*",
"athena:StartQueryExecution",
"athena:StopQueryExecution"

AmazonAthenaFullAccess

Redis AmazonElastiCacheReadOnlyAccess AmazonElastiCacheFullAccess

SSO

AWS Permissions

AWS managed policies you need to assign to user for make CloudExplorer works.

https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonS3ReadOnlyAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonS3FullAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonRedshiftReadOnlyAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonRedshiftFullAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonRDSReadOnlyAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonRDSFullAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonDynamoDBReadOnlyAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonDynamoDBFullAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonDocDBReadOnlyAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonDocDBFullAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonKeyspacesReadOnlyAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonKeyspacesFullAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=eu-central-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonAthenaFullAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=us-east-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonElastiCacheReadOnlyAccess
https://us-east-1.console.aws.amazon.com/iamv2/home?region=us-east-1#/policies/details/arn%3Aaws%3Aiam%3A%3Aaws%3Apolicy%2FAmazonElastiCacheFullAccess
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1.  

2.  

3.  
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DBeaver is integrated with Google Cloud IAM authentication.
Thus it provides the possibility to authenticate in GCP to access your cloud databases.

When you use Default Credentials, Google Cloud will then try to determine credentials by using the standard 
credential providers chain:

Environment variables (GOOGLE_APPLICATION_CREDENTIALS)

Identity token from GCP CLI

The shared user or service credentials and config files (usually application_default_credentials.json in 
AppData)

Google Compute Engine

Using default credentials is essentially the simplest way to integrate with various SSO providers and web identity 
providers as they usually provide credentials through config files.

Please read the  for a detailed explanation.GCP authentication documentation

You can provide the path to your service credentials or user credentials file in the "Configuration" field.

You can read more about User and Service authentication here

Google Cloud Shell will be used for authethication. If your GCP account has a configured SSO portal, you can use 
a web-based SSO authorization.

GCP Credentials

Default credentials

Access key file

Web browser or Single Sign On

https://cloud.google.com/docs/authentication
https://cloud.google.com/docs/authentication#principals
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NB: This feature is available in , ,  and  editions only.Lite Enterprise Ultimate Team

GCP web browser-based authentication allows you not to use a service or user-based key file, or other default 
authorization methods. You can provide access to your connection by authorization through the Google account.

To enable SSO authorization, you need to install GCP CLI (Command Line Interface) utilities.
GCP CLI installation

If DBeaver didn't find your executable CLI file (error message: "Authentication error: Error running GCP CLI. Is it 
installed on the local machine?)", you can add the path for your executable file manually in the Preferences -> 
Connections -> Cloud Configurations -> GCP Configuration

First  request to your CLI will be used. If token will be not empty, then this token gcloud auth print-access-token

will be used for the authentication. If token will be empty, then command  will be executed, gcloud auth login

which will open the web-browser and offer to choose your Google account.

In the DBeaver database connection dialog, you need to:

Set Authentication to .Google Cloud IAM

Set Credentials to .Web Browser

Add user and password info if they needed

GCP SSO

GCP CLI

GCP web browser-based authentication configuration

Connection configuration

https://dbeaver.com/dbeaver-team-edition
https://cloud.google.com/sdk/docs/install
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Now you can connect. DBeaver will open a web browser with SSO authorization. Choose your account with 
Goggle projects on the web page.

As example:
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Note: This functionality is available in  and  editions only.Ultimate Team

You have to provide just the ID of the application (client) that is used for authentication and database access:

As of DBeaver 22.3, the only supported service is Azure SQL.

Azure

Azure Cloud Explorer

Cloud configuration

Supported services

https://dbeaver.com/dbeaver-team-edition
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DBeaver Enterprise Edition (EE) is a commercial version of DBeaver CE. The EE version includes all features of 
the CE version plus:

All popular JDBC drivers are included in the EE distribution so you will not need to download/configure them 
separately.

Support of NoSQL databases:
Apache Cassandra

MongoDB

Redis

InfluxDB

Couchbase

CouchDB

Google BigTable

AWS DynamoDB

AWS Keyspaces

AWS DocumentDB

AWS Timestream

WMI (Windows Management Instrumentation)

Yugabyte CQL

Additional EE plugins:
Office formats support (XLS) for data import

Visual Query Builder

Schema/table compare, diff DDL generation

Data compare

Analytical charts rendering

Persistent query database. Search in query history

Eclipse Marketplace (provides easy installation of any additional Eclipse plugins)

Mock data generators

Version control support

Automatic proxy configuration (PAC)

ERD edit mode

Enterprise Edition

https://dbeaver.com
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Retaining query history (after restart)

SQL execution plan diagram

Tasks (Composite Tasks, Email results, Task scheduler)

Kerberos UI Authentication

Spelling

Command Line Interface

A possibility for us to support and develop the Community version, add new features faster, provide 
better support, and much more.

Even if you do not need enterprise features you can purchase a license as a form of donation. Thank you!
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DBeaver EE supports MongoDB schema browser, data viewer, SQL and JavaScript queries execution. It also 
supports various administrative tools (like server sessions manager).
DBeaver uses MongoDB Java driver 3.8.0 to operate with a server. It supports MongoDB servers from 2.x to 4.x.

You can connect directly to a server or use SSH tunneling or SOCKS proxy.
You can specify server address as a host/port/database configuration or you can enter the target database URL 
with all necessary parameters:

MongoDB

Overview

Connecting to MongoDB Server
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You can view/edit MongoDB collections content as standard relational tables (grid/plain text presentations) or as 
JSON documents.
The presentation can be switched in the Results Viewer toolbar.
In a grid, DBeaver will try to unify all documents in some particular collection (as they have the same structure/the 
same set of properties).

Browsing Mongo collections
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JS statements can be executed in the SQL editor as usual. DBeaver supports all JS queries for MongoDB 2 and 3 
as well as a subset of the  shell queries.mongo

The following example creates a user in the current database.

db.createUser({
    user: 'testuser',
    pwd: 'test',
    roles: []
})

This example returns all documents in the collection 'test_col':

db.test_col.find().toArray()

Note: the script will be executed in the current database.
You can not set an explicit database name in your query.
The current database can be changed on the SQL Editor toolbar or on the Database Navigator.

Executing JavaScript
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You can use standard SQL statements ( , , , ) to manipulate Mongo data.SELECT INSERT UPDATE DELETE

SELECT queries support , , ,  and  clauses.WHERE ORDER BY GROUP BY JOIN HAVING

MongoDB dialect doesn't support SQL sub-queries.

SELECT * FROM test_col
WHERE propName.subProp='value'

UPDATE FROM test_col
SET propsName.val1=123
WHERE propName.subProp='value'

SELECT queries with  support , , , , , ,  and  operators:WHERE AND OR < <= > >= = !=

SELECT * FROM Employees
WHERE (Country = 'CA' OR Country = 'RU') AND Age > 20;

Please note that  has higher precedence than  and will evaluate first, so you need to surround it with AND OR

parentheses.

Nested JSON fields can be divided by dot. If your field contains any special characters (e.g. spaces, dashes, etc.), 
you must enclose it with double quotes. For example:

SELECT title FROM movies WHERE info."imdb-details".rating > 6

When you need to find a document by ID, you must use the function :ObjectId

SELECT * FROM documents
WHERE _id = ObjectId('5f9c458018e3c69d0adc0fbd')
ORDER BY value DESC

Currently, SQL dialect for MongoDB supports  and :LEFT JOIN INNER JOIN

Executing SQL

SELECT queries

Conditions

Nested fields

Working with object IDs

Working with JOINs
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SELECT
    ar.Name as Artist,
    al.Title as Album,
    SUM(tr.Milliseconds) as Duration
FROM Track tr
INNER JOIN Album al ON tr.AlbumId = al.AlbumId
INNER JOIN Artist ar ON al.ArtistId = ar.ArtistId
GROUP BY Artist, Album
ORDER BY Duration DESC

The only limitation is that you have to specify aliases for both source and target tables in a particular order:

SELECT *
FROM <source> <source-alias>
INNER JOIN <target> <target-alias> ON <source-alias>.column = <target-alias>.column

Note that executing the following script will not result in a merged document, but it will result in separate 
documents for  and :Track Album

SELECT *
FROM Track tr
INNER JOIN Album al ON tr.AlbumId = al.AlbumId

In version 22.x only COUNT function is supported.

You cannot use condition in INSERTS so just basic form is supported:

    INSERT INTO <collection-name> (field1, field2) VALUES (val1, val2);

You can use any expressions in WHERE clause but you cannot use sub-selects or joins.

    UPDATE <collection-name> SET field2=val3 WHERE field1=val1;

You can use any expressions in WHERE clause, but you cannot use sub-selects or joins.

    DELETE FROM <collection-name> WHERE field1=val1;

You cannot specify column list in CREATE TABLE. Only collection name can be specified.

    CREATE TABLE  <collection-name>;

Aggregate functions

INSERT statement

UPDATE statement

DELETE statement

CREATE TABLE statement

DROP TABLE statement
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    DROP TABLE  <collection-name>;

If you need to operate with dates then you must specify them in an ISO format. It is possible in both the JavaScript 
and SQL dialect:

db.dates.insert([
    { value: new Date('2016-05-18T16:00:00Z') },
    { value: new Date('2017-05-18T16:00:00Z') },
    { value: new Date('2018-05-18T16:00:00Z') },
    { value: new Date('2019-05-18T16:00:00Z') },
    { value: new Date('2020-05-18T16:00:00Z') }
])

Querying data in JavaScript:

db.dates.find({
    value: { $gte: new Date('2018-05-18T16:00:00Z') }
}).toArray()

Querying data in the SQL dialect (ISO and UNIX timestamp, in milliseconds):

SELECT value FROM dates
WHERE value > ISODate('2018-05-18T16:00:00.000Z')
ORDER BY value DESC

SELECT value FROM dates
WHERE value > ISODate(1526659200000)
ORDER BY value DESC

Working with dates
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DBeaver EE supports Cassandra schema browser, data viewer and CQL queries execution. It also supports 
various administrative tools.

You can connect directly to a server or use SSH tunneling or SOCKS proxy. DBeaver uses the DataStax Java 
driver to operate with a server. It supports Cassandra servers 2.x, 3.x or higher.

Cassandra

Overview

Connecting to Cassandra cluster
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You can browse, view, edit and filter Cassandra tables the same way as with regular (relational) tables. However, 
being a distributed key-value database, Cassandra does not support any kind of referential integrity. There are no 
foreign keys, references, etc.
You should note that Cassandra has a very advanced (comparing to relational databases) data type system. Each 
column may be a collection, map, or set of values (with very big number of values). In some cases this makes 
browsing data in the "Grid" mode inconvenient.

Browsing Cassandra tables
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CQL  is a very simple SQL language dialect.Cassandra Query Language
It supports simple SELECT queries, DDL statements (like CREATE TABLE) and some other query types.

You can use the standard DBeaver SQL editor to execute CQL queries. DBeaver supports Cassandra query 
execution, results scrolling, data export/import, mock data generation and other features. Data viewer (of individual 
tables or custom CQL query results) query tracing is supported.

Executing CQL

http://cassandra.apache.org/doc/4.0/cql/
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Physical ERD (Entity Relation Diagram) does not make much sense for Cassandra as there are no foreign keys. 
However, you can make you own  and connect an actual Cassandra table with each other using custom ERD
logical associations.

ERD
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DBeaver EE supports InfluxDB schema browser, data viewer and InfluxQL queries execution.
DBeaver uses InfluxDB Java driver 2.12 to operate with the server over HTTP/HTTPS (standard InfluxDB 
protocol).
It supports InfluxDB servers of any version (in the moment of writing).

You can connect directly to a server or use SSH tunneling or SOCKS proxy.

InfluxDB

Overview

Connecting to Influx Server
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InfluxDB is , it does not support tables, foreign keys and other relational entities.TimeSeries database

DBeaver does not support data insert/update in InfluxDB. Database is basically a in read-only state for DBeaver. 
You can browse schema and view/analyse data.
While data itself is loaded by various sensors/data collectors in real time.
Instead of tables InfluxDB has . Instead of columns it has  and .measurements fields tags

Browsing InfluxDB schema

https://docs.influxdata.com/influxdb/v1.6/concepts/crosswalk/
https://docs.influxdata.com/influxdb/v1.6/concepts/key_concepts/#measurement
https://docs.influxdata.com/influxdb/v1.6/concepts/key_concepts/#field-key
https://docs.influxdata.com/influxdb/v1.6/concepts/key_concepts/#tag-key
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Executing InfluxQL (versions < 2)
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InfluxQL is a query language similar to SQL.
DBeaver fully supports all InfluxQL statements. Query results are presented as grid or as graphs:

https://docs.influxdata.com/influxdb/v1.6/query_language/
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Flux is a query language that is used in the new versions of Influx. It is not similar to InfluxQL and doesn't use SQL 
syntax.

from(bucket: "example-bucket")
    |> range(start: -1d)
    |> filter(fn: (r) => r._measurement == "example-measurement")
    |> mean()
    |> yield(name: "_results")

Executing Flux (versions > 2)

Query example

https://docs.influxdata.com/flux/v0.x/get-started/
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DBeaver EE supports Redis key browser, key value viewer and Redis commands shell.
DBeaver uses  driver 2.9.0 to operate with  server. It supports Redis servers of any version.Jedis Redis

You can connect directly to a server or use SSH tunneling or SOCKS proxy.

Redis

Overview

Connecting to Redis Server

https://github.com/xetorthio/jedis
https://redis.io
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You can view/edit Redis keys as a plain list. However the Redis database usually contains a lot of keys (millions or 
even billions) and using list presentation is not convenient (or it is not possible).
DBeaver supports a hierarchy presentation of keys. Internally Redis does not support hierarchies but application 
level key names may be divided into groups using a character (e.g. coma, dash or colon). DBeaver uses this 
pattern to show hierarchy. Group separator can be configured in connection properties.

Key browser may be convenient in some cases but in the case of big databases it is very difficult to find your key 
in the navigator, so the SQL editor should be used instead. Redis  is the most flexible way to operate commands
with keys.

Browsing Redis keys

https://redis.io/commands
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Redis does not support SQL or any other query language. Instead, it supports  and .build-in commands LUA scripts

Redis commands can be executed in the same way as in a Redis command line shell:

In order to execute a command, run it using CTRL+Enter or ALT+X. All standard DBeaver SQL editor shortcuts work for Redis as well.

In order to execute a LUA script, surround it with {} brackets and run it as a single statement. If the script contains empty lines or special characters, select the script text before the execution.
```lua
{
    return {1,2,{3,'Hello World!'}}
}
```

Executing Redis commands

https://redis.io/commands
https://redis.io/commands/eval
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NB: This feature is available in ,  and  editions only.Enterprise Ultimate Team

Table data view

Table data edit in document (json) mode

Data filters

SQL queries execution

JSON queries execution

Data export and import

DBeaver supports AWS Cloud and Standalone versions of DynamoDB.
For standalone server you need to enter endpoint (http or https URL).
For cloud server you must enter the AWS region. DynamoDB exists in all available regions in your AWS account 
but the tables are different.

DynamoDB

Supported features:

DynamoDB connection

https://dbeaver.com/dbeaver-team-edition
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AWS Access Key and Secret Key are used for authentication.
For 3rd-party account access you must specify the 3rd party account ID (12-digits number) and the 3rd party role 
name. This role will be used for permission management. You account must be added to the whitelist in the 3rd 
party account.

Press "Test Connection" to validate your connection settings.

DynamoDB has a simple metadata structure. Basically, you can only access Table and Global tables.
Table has primary attributes (a kind of primary key) and indexes.
DynamoDB is a document-oriented database. Each table may have its own set of attributes and sub-attributes.

You can open table editor and see the table data.
You may need to switch to the "Data" tab. DBeaver converts DynamoDB documents into a table format by default, 

Database navigation

Viewing table data
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but you can switch to another data representation.
You can use data filters in order to find documents.

Viewing data in JSON document format
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You view, search and edit JSON documents. Double-click on a document to activate the editor.

DBeaver supports simple SQL dialect for DynamoDB.
You can use the WHERE clause in the same fashion as in regular SQL in order to find or filter documents.

You can also use JSON requests syntax to query documents. See .Amazon DynamoDB query reference

Executing queries

https://docs.aws.amazon.com/amazondynamodb/latest/APIReference/API_Query.html
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You can export data from a DynamoDB table in different file formats (CSV, XLSX, XML, JSON, etc,) or export data 
directly to another table.

Exporting and importing data
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AWS DocumentDB is based on the  engine.MongoDB
It has several minor differences in the query processing and network configuration.
However, most features which work for MongoDB will work for DocumentDB as well. Please refer to the  MongoDB
article.

AWS restricts direct access to DocumentDB clusters from outside of the cloud (region). So you can connect to it 
directly (using a cluster host name) only when DBeaver is deployed on the EC2 instance.

In other cases you will need to use the SSH tunnel through a proxy machine to access DocumentDB instance. 
Please read the AWS Documentation about proxy configurations: https://docs.aws.amazon.com/documentdb/latest
/developerguide/connect-from-outside-a-vpc.html

In DBeaver you can use the SSH tab on the connection settings page. Just enter proxy host, user name and 
specify a private key file (it is provided by AWS as a keypair).

DBeaver processes DocDB SQL queries exactly like in . It supports SELECT, UPDATE, INSERT and MongoDB
DELETE queries.
SELECT queries support WHERE, ORDER BY, GROUP BY and HAVING clauses.

DocumentDB restricts the  function so all JavaScript queries will be parsed on the client's side and then eval

evaluated at a DocDB cluster one by one. Most JS functions work exactly like in Mongo Shell.

DocumentDB

Connections

Queries

https://docs.aws.amazon.com/documentdb/latest/developerguide/connect-from-outside-a-vpc.html
https://docs.aws.amazon.com/documentdb/latest/developerguide/connect-from-outside-a-vpc.html
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AWS Keyspaces is a key-value database based on .Apache Cassandra

DBeaver EE supports the Keyspaces schema browser, data viewer and CQL queries execution. It also supports 
various administrative tools.

AWS Keyspaces uses AWS IAM authentication.
You need to specify your IAM credentials and AWS region. There is no specific endpoint - there is only one cluster 
per account per AWS region.
There is also no need to configure SSH or SSL - DBeaver uses default AWS settings to access the Keyspace 
cluster.

You can browse, view, edit and filter Cassandra tables the same way as with regular (relational) tables. However, 
being a distributed key-value database, Keyspaces does not support any kind of referential integrity. There are no 
foreign keys, references, etc.
You should note that Cassandra has a very advanced (comparing to relational databases) data type system. Each 
column may be a collection, map, or set of values (with a very big number of values). In some cases this makes 
browsing data in the "Grid" mode inconvenient.

Keyspaces

Overview

Connecting to Keyspaces

Browsing Keyspaces tables

https://docs.aws.amazon.com/keyspaces/latest/devguide/what-is-keyspaces.html
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CQL  is a very simple kind of SQL language dialect.Cassandra Query Language
It supports simple SELECT queries, DDL statements (like CREATE TABLE) and some other query types.

You can use the standard DBeaver SQL editor to execute CQL queries. DBeaver supports Cassandra query 
execution, results scrolling, data export/import, mock data generation and other features.

Physical ERD (Entity Relation Diagram) does not make much sense for Keyspaces as there are no foreign keys. 
However, you can make you own  and connect Keyspaces tables with each other using logical custom ERD
associations.

Executing CQL

ERD

http://cassandra.apache.org/doc/4.0/cql/
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Supported features:

Table data view

Table data edit in document (json) mode

Data filters

SQL queries execution

Data export and import

Bigtable

Bigtable connection
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Note: This functionality is available in ,  and  editions only.Enterprise Ultimate Team

Couchbase client uses  to connect to a cluster (8091-8096, 9140, etc). Some of these ports are multiple ports
dynamic (i.e. depend on server settings) and cannot be overwritten. It makes SSH tunnelling impossible. Thus, if 
you work with a remote Couchbase deployed behind a firewall, you will need to setup a VPN connection or 
SOCKS proxy.

Couchbase

Connecting to Couchbase server

https://dbeaver.com/dbeaver-team-edition
https://docs.couchbase.com/server/current/install/install-ports.html
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Couchbase is a document-oriented database. It means that all documents may have different structures.
You can view/edit buckets content, such as standard relational tables (grid/plain text presentations) or JSON 
documents.

Viewing and editing Couchbase tables
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Couchbase uses  for queries. It is very similar to the standard SQL language.N1QL language

SELECT country FROM `travel-sample` WHERE name = "Excel Airways";

Executing Couchbase queries

https://docs.couchbase.com/server/current/getting-started/try-a-query.html
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Hive is a Hadoop-based storage system. Hive uses a special SQL dialect (HiveQL) to operate with data and 
metadata. Generally, it is quite similar to SQL.

There are multiple implementations of storage systems which utilize Hive on the server-side - including Apache 
Spark, Impala, etc. Most of them support the standard Hive JDBC driver which is used in DBeaver to communicate 
with the server.

DBeaver uses a so-called Hive JDBC Uber Jar driver ( ) which includes https://github.com/timveil/hive-jdbc-uber-jar
all necessary dependencies. You do not need to download anything - DBeaver will download everything 
automatically (if you have internet access).

Apache Hive/Spark/Impala

Apache Hive

Connection setup

https://github.com/timveil/hive-jdbc-uber-jar
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Schema/data browser
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Limitations
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Hive does not support referential integrity so you will not see primary keys or foreign keys. ER diagrams also do 
no make much sense.
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There are several ways to configure a database connection and several ways to perform an authentication.

Host/port based configuration

Parameter Description Example

Host Server host name 192.168.1.25

Post 
number

Server listener port 1521 (default)

Database Service or SID name ORCL

Oracle

Connecting to Oracle databases

Configuration types

Basic connections
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Service/SID It depends on the server configuration.
SID must be selected for some servers and the Service Name for 
others

SID

TNS configuration is the simplest but it requires you to have the  file somewhere on your disk. tnsnames.ora

tnsnames.ora contains information about all accessible Oracle server connections. DBeaver can determine the 
default location of this file but sometimes you will need to manually specify it.

Parameter Description Example

Network Alias Name of configuration from tnsnames.ora ORCL1

TNS names 
path

Path to  file.tnsnames.ora

By default, it is got from the TNS_ADMIN environment variable or from Windows' 
registry

c:
\oracle\network\admin

For more a sophisticated configuration, you can specify the full JDBC URL manually (see Data Sources and URLs
).

Sample URL (Oracle Cloud):
jdbc:oracle:thin:@(description= (retry_count=20)(retry_delay=3)(address=(protocol=tcps)(port=1522)(host=adb.us-ashburn-1.oraclecloud.com))(connect_data=(service_name=xxxxxxxxxxxxxxxxx_high.adb.oraclecloud.com))(security=(ssl_server_cert_dn="CN=adwc.uscom-east-1.oraclecloud.com, OU=Oracle BMCS US, O=Oracle Corporation, L=Redwood City, ST=California, C=US")))

Parameter Description Example

User name Database user name SYS

Password Database user password

Role
Role for connection.
Roles SYSDBA and SYSOPER are needed for some administrative 
operations

Normal

Save 
password

Saves the user/password information in the local DBeaver configuration SID

The Oracle driver gets user information from the current OS user.
You do not need to explicitly specify any credentials.

TNS

Custom URL

Authentication

Database

OS authentication

Oracle Wallet

https://docs.oracle.com/database/121/JJDBC/urls.htm#JJDBC28270
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Note: This functionality is available in ,  and  editions only.Enterprise Ultimate Team

A more secure way to connect is to use the Oracle Wallet. Wallet is a directory with security keys and some other 
optional connection information. Wallets are usually distributed as ZIP archives. You need to extract the ZIP 
archive to a folder on a disk and specify this folder in the  field.Wallet location

Wallet may contain information about a database user. This, however, is optional. You will sometimes need to 
specify the user too.

Wallet may also contain a TNS configuration. If it does, you can use the TNS connection configuration easily by 
setting the  to the same value as the .TNS path Wallet location

Parameter Description Example

User name, Password, Role See Database authentication

Wallet location Oracle wallet directory C:\oracle\network\wallet\example

Wallet password Optional. Some wallets are password-protected

Note: This functionality is available in ,  and  editions only.Enterprise Ultimate Team

Kerberos is the most complicated authentication in Oracle.

Parameter Description Example

Username Database user name c##testuser

Kerberos 
user

Kerberos / Active directory user 
name

testuser@THE-REALM

Realm Kerberos realm THE-REALM

KDC server KDC server address krb5.your-domain.com

Password Kerberos user password

DBeaver supports Oracle Cloud Autonomous databases connectivity.
There are two ways to authenticate:

To use a plain URL connection you must enable the  for the Oracle autonomous Access control list

database.

Then add your IP address to the IP list.

Use the Custom connection configuration ( ). You can copy the URL from the Oracle Cloud database URL
page (link "DB Connection").

Kerberos

Oracle Cloud connections

Plain URL connection

https://dbeaver.com/dbeaver-team-edition
https://dbeaver.com/dbeaver-team-edition
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It is the default authentication type for the Oracle Cloud.
.

Download Wallet from the Oracle Cloud website

Expand the wallet archive to a folder

Set  configuration typeTNS

Set the  to the wallet location directoryTNS path

Choose the proper  from the drop-down menuNetwork Alias

Set  to the Oracle WalletAuthentication

Set the database user name and password (you can get them from the Oracle Cloud database information 
page)

Set the  to the wallet location directoryWallet location

Oracle Wallet connection
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You can read more about the Snowflake database in the Snowflake .documentation

There are several ways to configure a database connection.

Connection parameters

Parameter Description Example

Host Server host name
https://account.region.
snowflakecomputing.com

Post 
number

Server listener port 443 (default)

Snowflake

Connecting to the Snowflake database.

https://docs.snowflake.com/
https://account.region.snowflakecomputing.com
https://account.region.snowflakecomputing.com
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Database* Database name SNOWFLAKE_SAMPLE_DATA

Warehouse*
Cluster of compute resources in Snowflake. Warehouses are required for 
queries, as well as all DML operations, including loading data into tables

SNOWFLAKE

Schema* Schema name SAMPLE_DATA

*Click on the "Test Connection" button to load the warehouse/database/schema list from the server.

Parameter Description Example

Username Database user name ADMIN

Password Database user password *****

Save 
password

Saves the user/password information in the local DBeaver configuration

Role Role for connection SYS

Authenticator Authenticator parameter/option https://.okta.com

Note: This feature is available in , , and  editions only.Lite Enterprise Ultimate

Parameter Description Example

Username Database user name ADMIN

Private key Path to encrypted or unencrypted private key
C:/Users/admin/Downloads/rsa_key.
p8

Key 
Password

Private key password *****

Save 
password

Saves the user/password information in the local DBeaver 
configuration

Role Role for connection SYS

Note: This feature is available in , , and  editions only.Lite Enterprise Ultimate

Connection with the help of an external browser will be used.

Parameter Description Example

Username
Database user 
name

ADMIN

Role Role for connection SYS

Authentication

Database

Private key 

SSO (Browser) 
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You can use preconfigured connection profile here.

DBeaver provides an opportunity to view and manipulate such types of metadata:

Databases

Schemas

Data types

Tables

Views

Procedures and functions

Sequences 

Stages 

Pipes 

Streams 

Tasks 

Table statistics are also available only in PRO DBeaver versions. As well as expanded metadata about tables and 
schemes.

DBeaver Profile 

Metadata
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Go to Preferences->User Interface:

Select your language in the drop-down list and click the "Apply and Close" button.
If DBeaver is installed in a read-only directory, the automatic language change is not possible. In this case, try to 
edit the configuration file (see below).

Locate the  file. It is in the same directory where DBeaver is installed.dbeaver.ini

Open  in a text editor and add the following lines before the line dbeaver.ini -vmargs

-nl
XX

where XX is two-letter language code:

Changing interface language

Changing interface language in Preferences

Changing interface language in configuration file



DBeaver User Guide 23.1. Page 454 of 526.

Language Code

English en

Chinese zh

French fr

Italian it

Japanese jp

German de

Korean ko

Portuguese 
(BR)

pt_BR

Russian ru

Spanish es
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You can install a lot of optional extensions (plugins) in DBeaver. Most of the extensions can be found on the 
 website.Eclipse Marketplace

Office formats support (XLSX)

Vector graphics support (SVG)

SSHJ and advanced cryptography (since version 21 it is included in the base distribution)

Git support - Git version control integration

SQL debugger

Darkest Dark theme - the best Dark theme for DBeaver

Eclipse Color Theme - if for some reason you do not like the Darkest Dark theme, you can use this one

Subversion support - Subversion integration

Embedded Shell - Allows you to run shell commands directly from DBeaver

Editor vertical indents - Adds vertical indents to all text editors

CodeTogether - Allows you to share the IDE and collaborate

In DBeaver EE you can use drag-n-drop from the Marketplace web site (see button ) in the DBeaver Install

main window. This will launch the Marketplace installation wizard automatically. In the DBeaver Community or 
other DBeaver-based products which do not include marketplace clients, you can use the following instructions:

Installing extensions - Themes, version control, etc

DBeaver-specific extensions

Popular 3rd party extensions for Eclipse and DBeaver

Install Process

Extension installation in CE version:

https://marketplace.eclipse.org/
https://marketplace.eclipse.org/content/dbeaver-office-integration
https://marketplace.eclipse.org/content/dbeaver-svg-format-support
https://marketplace.eclipse.org/content/dbeaver-git-support
https://marketplace.eclipse.org/content/dbeaver-sql-debugger
https://marketplace.eclipse.org/content/darkest-dark-theme-devstyle
https://marketplace.eclipse.org/content/eclipse-color-theme
https://marketplace.eclipse.org/content/subclipse
https://marketplace.eclipse.org/content/easyshell
https://marketplace.eclipse.org/content/indent-guide
https://www.codetogether.com/download/
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1.  

2.  

3.  

Copy URL of extension update site: 

In the DBeaver main menu open Help -> Install New Software

Paste update site URL into  field and press Work with Enter
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4.  Check items you wish to install (in most cases just all items) 
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5.  

6.  

7.  

Click Next. You may need to accept the extension license before installing 

Some extensions may contain unsigned bundles. Only install such extensions if you really trust the author. 

Click Next->Finish. The installation will take some time. Restart DBeaver.
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Command line parameters might be passed directly to dbeaver[.exe] executable.
In Windows, you can use  executable (it does not spawn a new window so you can see the dbeaver-cli.exe

output messages).

Also, you can add parameters in the  configuration file. You need to write them to the beginning of dbeaver.ini

the file, and each parameter has to be on its line.

Name Value Example

-help Prints help message

-stop Quits DBeaver

-dump Prints DBeaver thread dump

-f
Opens the file in DBeaver UI, if the command has -con 
argument, connects it to datasource

-f c:\some-path\some-file.sql

-con Opens database connection in DBeaver UI See connection parameters table

-closeTabs Closes all open editor tabs

-disconnectAll Closes all open connections

-
reuseWorkspace

Forces reuse of single workspace by multiple DBeaver 
instances

-newInstance
Forces new DBeaver instance creation (do not try to reuse 
already running one)

-bringToFront Brings the DBeaver window on top of other applications

-var 

Customs variables for runTask. You can change existing 
variables in the task. You cannot add new task variables 
with this parameter. You can add several parameters at 
once to the command line, each starting with "-var". Used 
right before -runTask. Template: 
-var variableName=variableValue

-var film=sakila.film

-var actor=sakila.actor

-runTask "exportFromSakila"

EE version only.

-vars Path to a property file with variables
-vars c:\path\to\file.properties

For more information see the main 
article

-runTask Executes specified task
-runTask "@projectName:taskName" .

EE version only. See .task scheduler

-license Path to the EE license file
-license "/etc/licenses/dbeaver.txt"

.
EE version only.

Command Line

Command line parameters

DBeaver control
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Name Value Example

-nl Locale en_US

-data Workspace path c:\ProgramData\MyWorkspace

-nosplash Omits splash screen true

-clean Clears all Eclipse caches. Use it if DBeaver fails to start after it upgrades.

-vmargs VM parameters See VM arguments table

You can pass any advanced Java parameters supported by your local JVM (Oracle, OpenJDK, IBM, etc).
Parameters supported by Oracle JVM (11): https://docs.oracle.com/en/java/javase/11/tools/java.html

Parameters supported by all JVMs:

Name Value Example

-Xms Sets initial memory available for DBeaver -Xmx1000m

-Xmx Sets maximum memory available for DBeaver -Xmx4000m

All connection parameters must be supplied as a single command line argument. The parameters are divided by 
pipe ( ). The parameter name and value is divided by .| =

Example: 
-con "driver=sqlite|database=C:\db\SQLite\Chinook.db|name=SQLiteChin|openConsole=true|folder=SQLite"

Name Description Example

name Connection name Test connection

driver Driver name or ID driver=sqlite , , etcdriver=mysql

url

Connection URL. Optional 
(JDBC URL may be 
constructed by a driver from 
other parameters)

url=jdbc:sqlite:C:\db\SQLite\Chinook.db

host Database host name (optional) host=localhost

port Database port number (optional) port=1534

server
Database server name 
(optional)

server=myserver

database
Database name or path 
(optional)

database=db-name

user User name (optional) user=root

System parameters

VM arguments

Connection parameters
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password User password (optional) password=mysecret

auth
Authentication model ID. See 
Auth models

auth=postgres_pgpass

authProp.propName
Custom authentication 
parameters (depends on the 
driver and )auth model

authProp.oracle.net.wallet_location=C:/temp/ora-wallet

savePassword
Does not ask user for a 
password on connection

savePassword=true

showSystemObjects
Shows/Hides system schemas, 
tables ,etc

showSystemObjects=true

showUtilityObjects
Shows/Hides utility schemas, 
tables ,etc

showUtilityObjects=true

folder
Puts a new connection in a 
folder

folder=FolderName

autoCommit
Sets connection auto commit 
flag (default value depends on 
driver)

autoCommit=true

prop.propName
Advanced connection 
parameters (depend on driver)

prop.connectTimeout=30

id Connection id
oracle_thin-16a88e815bd-70598e648cedd28c  (useful in 

conjunction with )create=false

connect Connects to this database connect=false

openConsole
Opens the SQL console for this 
database (sets  to connect

true)
openConsole=true

create Creates new connection
create=false  (true by default). If it is set as false, then an 

existing connection configuration will be used. The name or id 
parameter must be specified.

save Saves new connection
When , then  (default) makes new create=true save=false

connection temporary,  means that new connection save=true

will be saved and accessible between DBeaver launches.

See the main article

Declare external variables in a file
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1.  

2.  

3.  

You might want to reset UI settings in the following cases:

Shortcuts suddenly stop working

Theme colors are messed up

Broken or invalid localization

Other UI elements aren't shown anymore

This can happen due to the following reasons:

After multiple version upgrades

After switching between newer and older versions

After an incorrect shutdown

You can perform a reset using the  #  action.Help Reset UI Settings...

Be careful: this will reset  UI settings and other user preferences, including:all

layout of menus, toolbars, windows, editors

theme, colors, and fonts

other settings from installed third-party plugins

After accepting the confirmation, DBeaver will restart and greet you with a fresh workspace.

If you cannot launch DBeaver, you can reset the workspace manually.

Be careful: only delete any other files if you know what you're doing, and follow the steps below.

To do so, do the following:

On , open Explorer and navigate to Windows %APPDATA%\DBeaverData\workspace6\.metadata\.plugins

On , open Finder and navigate to macOS ~/Library/DBeaverData/workspace6/.metadata/.plugins

On , open file explorer and navigate to Linux
$XDG_DATA_HOME/DBeaverData/workspace6/.metadata/.plugins

First, you can try deleting the file  located in the  directoryworkbench.xmi org.eclipse.e4.workbench

If it didn't help, try deleting all files in the  directory or that directory itself.plugins

Reset UI settings

Reset UI settings

Manual reset
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You can clean up the workspace by deleting redundant files that accumulate as you use DBeaver.

You do so, use the  #  action.Help Clear History...

You will need to choose one or more options provided below:

Name Description

Task run history Contains information about previously run tasks along with logs collected during their execution

Query log history Contains information about previously run (user and meta) SQL queries

When you're happy with the options, click the  button to continue.Apply and Restart

Clear History
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The article has been moved to .Reset UI settings

Reset workspace
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DBeaver is an Eclipse RCP application. Therefore, it may have issues with GTK. Here are known workarounds 
regarding various issues which may arise.

Add  to . export GTK_IM_MODULE=ibus ~/.profile

To fix the issue, we recommended having a graphical theme which is similar to system one in terms of the 
color palette.

You need to install  library to your system, this will solve the issue and allow you to use libwebkit2gtk

DBeaver browser functionality

This issue requires you to change the GTK-program-style (the system settings-appearance-program style

setting location may vary for different systems).

To fix this issue, you need to remove the overlay scrollbars in .~/.config/gtk-3.0/settings.ini

[Settings]
gtk-overlay-scrolling = false

Troubleshooting system issues

Linux

GTK

Fixing screen flickering.

Parts of DBeaver are white/dark on dark/white theme

No more handles because there is no underlying browser available

GTK-WARNING xxx:Theme parsing error

gtk_box_gadget_distribute: assertion size 'size >=0 0' failed in GtkScrollbar



DBeaver User Guide 23.1. Page 466 of 526.

A few tips.

Check existing issues for your issue (including closed ones). Duplicating an issue is slower for both parties so 
search through the open and closed issues to see if what you are running into has already been addressed.

Be clear about what your problem is: what was the expected outcome, what happened instead? Detail how 
someone else can recreate the problem.

If you posting a bug report check "Error Log" view. If there are any errors related to your bug then post a 
complete stacktrace. Sometimes there are no errors in Error Log - if so, try to find them in .log files

If your issue is related to database data or metadata management - check the Query Manager view. It 
contains information about all queries DBeaver executes (explicitly or implicitly). To see more detailed 
information you can configure Query Manager in Preferences. 

Depending on the nature of your bug report provide information about:

Operating system

Window manager (for Linux)

Database (name and version)

Database driver (name and version)

Do not write issue type in the issue title (like Feature Request:, Bug: etc). We will review your issue and 
assign a corresponding label.

Posting issues
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There is an Error Log view (main menu Window->Show View->Error Log) which contains all errors which occur 
during the DBeaver runtime.
You can double click on the warning/error in the log viewer and see the error stacktrace. Please attach it to the 
bug report.
Also, you can open the full log (all error messages) if you need:

DBeaver writes different log files. Most of them are Eclipse logs.
Log files usually reside in the /workspace6/.metadata .workspace

In Windows open Explorer and paste path .%APPDATA%\DBeaverData\workspace6\.metadata

In Linux just type cd $XDG_DATA_HOME/DBeaverData/workspace6/.metadata

In MacOS open path  in Finder.~/Library/DBeaverData/workspace6/.metadata

To view hidden folders press  in the folder view.Cmd+Shift+.

Two standard log files:

workspace/workspace6/.metadata/.log - all warnings and errors which happen during normal work

workspace/workspace6/.metadata/dbeaver-debug.log - the same as  plus debug information.log

In special cases log files can be written in other directories. A special case is an emergency situation when 
DBeaver cannot start and there is no workspace. Two typical places to find emergency logs:

<install-path>/configuration

${HOME}/.eclipse/org.jkiss.dbeaver.product_<dbeaver-version>

If you are reporting an error, please attach the applicable part of the log - not the complete file.
Logs are very useful. Many errors cannot be reproduced and fixed without a full error stacktrace (all the details).

Log files

Error Log view

Log files

Java fatal logs
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On the rare occasion that the DBeaver process dies, it does not leave any valuable logs. This is caused by a Java 
VM crash.
JVM creates a fatal log file for each crash (log gile ). This log usually resides in the same hs_err_PID.log

directory where the DBeaver launcher is (e.g. dbeaver.exe).
But in some cases it is a write-protected directory and the log file will be created in other folder.
Instructions on how to find the Java fatal log file: https://docs.oracle.com/javase/9/troubleshoot/fatal-error-log.htm

Log files usually reside in the /team-workspace/.metadata .workspace

In Windows open Explorer and paste path .%APPDATA%\DBeaverData\team-workspace\.metadata

In Linux just type cd $XDG_DATA_HOME/DBeaverData/team-workspace/.metadata

In MacOS open path  in Finder.~/Library/DBeaverData/team-workspace/.metadata

To view hidden folders press  in the folder view.Cmd+Shift+.

Log files for Team Edition

https://docs.oracle.com/javase/9/troubleshoot/fatal-error-log.htm
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1.  

2.  

3.  

4.  

5.  

6.  

In some cases, custom JDBC drivers work incorrectly in DBeaver - they show the wrong metadata like table 
columns, constraints or foreign keys.
It usually happens because the driver is not compliant with the JDBC API specification and DBeaver cannot 
correctly interpret the metadata provided by the driver.

To understand what is going on inside the driver, you can enable JDBC tracing:

Find  file (it is located in the same folder where DBeaver is installed)dbeaver.ini

Add line  in the end of -Ddbeaver.jdbc.trace=true dbeaver.ini

Restart DBeaver

Connect to your database and browse the metadata in the database navigator/object editors.

In DBeaver  go to  folderWorkspace .metadata

File  contains all JDBC API invocations and all queries with results.jdbc-api-trace.log

Analyzing contents of  you can understand what is wrong with the metadata. Attach the piece jdbc-api-trace.log

of the trace file in the GitHub ticket if you think that something is wrong on DBeaver's side.

WARNING: disable JDBC tracing in your regular work. Enable it only for debugging. The trace generation 
decreases application performance and may produce huge log files.

JDBC trace
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Sometimes (due to some bug) DBeaver UI hangs, freezes, or works incorrectly. It is usually impossible to find the 
reason for such an issue without a thread dump. A thread dump is information about the internal execution state of 
the Java program. To get thread dump:

Run the following on your terminal:

jstack $(pgrep dbeaver) > ~/dbeaver-thread-dump.txt

Open the task manager ( ), find DBeaver in the process list, and copy its process ID value. In CTRL+SHIFT+ESC
Windows 8+ you need to switch to the "Details" tab.

Open the command prompt (  and type , then press ), run the following command:Win+R cmd ENTER

jstack PID > thread-dump.txt

The produced file will be located in the user's home folder, e.g. .C:\Users\Username

Now you can attach thread-dump.txt to the GitHub issue.

Thread dump

Mac and Linux

Windows
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This guide describes how to manage/secure the DBeaver database connections. It is designed for System 
administrators. Regular users should check  guide.this

DBeaver keeps connections information in the project folder. By default, all projects reside in the .workspace
The default project folder is \workspace6\General.workspace

DBeaver keeps information about project connections in the . file..dbeaver/data-sources.json

All secured information (user name, password, secret keys, etc) is stored in the encrypted file, 
..dbeaver/credentials-config.json

DBeaver can load multiple connection files. Any files in the project folder matching the 
 pattern will be loaded on the startup. So you can create a file, for example, .dbeaver/data-sources*.json

 in the project folder and DBeaver will see it..dbeaver/data-sources-2.json

DBeaver keeps information about project connections in the . file..dbeaver-data-sources.xml

DBeaver can load multiple connection files. Any files in the project folder matching the 
 pattern will be loaded on the startup. So you can create a file, for example, .dbeaver-data-sources*.xml

 in the project folder and DBeaver will see it..dbeaver-data-sources-2.xml

You can import a connection from CSV or XML files.

The CSV file must have a header row (first line of file) with column names (see list of supported columns below). 
The XML file should contain a top-level element and a set of nested elements. The connections config must be 
specified in the attributes of the nested elements. Attribute names are the same as the CSV column names.

Name Meaning

name Connection name

url JDBC URL

host Database server host name

port Database server port

database Database/schema name

Managing connections

Provide predefined connections

DBeaver 6.1.3+

DBeaver < 6.1.3 (Legacy)

Importing connections from CSV/XML

Supported names:
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user User name

password User password

You can only specify the URL or the host/port/etc setting.
User name/password are optional.

name,host,port,server,database,url,user,password,type
Postgre Import XML 1,localhost,5432,,postgres,jdbc:postgresql://localhost:5432/postgres,postgres,postgres,dev
Postgre Import XML 2,localhost,5432,,postgres2,jdbc:postgresql://localhost:5432/postgres2,postgres2,postgres2,prod

<connections>
        <connection name="Postgre Import XML 1" host="localhost" port="5432" server="" database="postgres" url="jdbc:postgresql://localhost:5432/postgres" user="postgres" password="postgres" type="dev" />
        <connection name="Postgre Import XML 2" host="localhost" port="5432" server="" database="postgres" url="jdbc:postgresql://localhost:5432/postgres2" user="postgres2" password="postgres2" type="prod" />
</connections>

It is possible to set the connection settings as read-only (protected by password)

Generate MD5 hash of your password. You can do it from the command line using Linux utility md5sum (
) or you can do it online - just google "MD5 hash online".md5sum <<<"your password"

Add field  in the connection descriptor (in  in  lockPassword .dbeaver/data-sources.json connections

element. So it will look like this:

"postgres-jdbc-161537836e8-3e0957d039995715": {
   "provider": "postgresql",
   "driver": "postgres-jdbc",
   "name": "PostgreSQL - postgres",
   "save-password": true,
   "show-system-objects": true,
   "read-only": false,
   "folder": "PG",
   "lockPassword": "2ba81a47c5512d9e23c435c1f29373cb"
...
}

If the user will try to change connection settings now, he/she will be asked for a password.

You can use references on environment variables in most of connection configuration properties.
For example:

"postgres-jdbc-161537836e8-3e0957d039995715": {
   "provider": "postgresql",
   "driver": "postgres-jdbc",
   "name": "PostgreSQL - postgres",
   "user": "${dbeaver.default-user}",
...
}

Sample CSV

Sample XML

Secure connections from editing

Using environment variables
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1.  

2.  

3.  

4.  

Disclaimer: this article does NOT cover variables used in SQL editor.

A variable is a special template which is replaced with an associated value. Variables help keep your configuration 
clean and tidy by avoiding unnecessary repetitions: instead of manually replacing each occurrence of some value, 
you can replace the value of a variable just once and its occurrences will be kept intact.

Variables are available in a lot of places. You might find them in:

The Connection settings

The SSH tunnel settings

Data Transfer and in other tasks

The Command Line Interface

Wherever you find variables available in the user interface, a hint will usually be present:

By clicking on it, a separate window will open showing all the available variables with their descriptions and values:

Managing variables

Variables

What are variables
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1.  

2.  

3.  
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To use the variables you need to utilize a special syntax:

${variable_name}

Where  is a variable name which you want to use. The window shown above already contains  variable_name ${

и  anchors so you do not need to specify them multiple times.}

Variables may be a part of something bigger: e.g., a part of a path. For example, if some file lies under the user's 
root folder, you may want to use variable : : .home ${home} ${home}/path/to/file.txt

A value of a particular variable may be resolved from different places depending on its origin.

The resolution is performed in the following order (from the highest to the lowest priority):

Dialog, where a specific variable is used

Datasource-specific variables ( , , , , etc.)host port server database

Application-specific variables ( , , , etc.)application.name application.version home

Using variables

The Variable resolution
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4.  

5.  

Environment variables. For additional information see .Wikipedia

External configuration (see )the below

If you have an environment variable called , it will be resolved in the application-specific variable because it home

has higher priority.

You can create a file and fill it with pairs of named values and pass it to DBeaver using the   -vars command-line
argument.

Variables from this file can be accessed by other command-line arguments, in the data transfer wizard, and in 
other places that support variable resolutions.

For example, you may want to put your credentials in that file to avoid showing them to everyone else:

# Lines that start with the `#` symbol are comments and therefore ignored.
sampleVar1=abc
someOtherVar=DBeaver is cool
password=P4$$w0r3

You can use them as such:

dbeaver.exe -vars C:\secrets.properties -con "driver=<xxx>|url=<xxx>|password=${password}"

Here, the  argument has the  variable that will be replaced with  defined in the -con ${password} P4$$w0r3

example file from above.

Declare external variables in a file

https://en.wikipedia.org/wiki/Environment_variable
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You can customize drivers configuration in the /.metadata/.plugins/org.jkiss.dbeaver.core/drivers.xml workspace
file. If you have some pre-installed jar files you can reference them in drivers.xml. Example:

<library type="jar" path="absolute-jar-folder-path\driver-jar.jar" custom="true" />

Also in drivers.xml you can use the following variables to specify relative paths:

Variable Meaning

drivers_home Standard DBeaver drivers location - ($workspace/drivers by default)

dbeaver_home DBeaver installation folder

home User home folder

workspace DBeaver workspace path

For instance:

<library type="jar" path="${workspace}\drivers\my-driver.jar" custom="true" />

Full drivers.xml example:

<?xml version="1.0" encoding="UTF-8"?>
<drivers>

        <provider id="postgresql">
                <driver id="postgres-jdbc" custom="false" embedded="false" name="PostgreSQL" class="org.postgresql.Driver" url="jdbc:postgresql://{host}[:{port}]/[{database}]" port="5432" description="PostgreSQL standard driver">
                        <library type="jar" path="maven:/org.postgresql:postgresql:RELEASE" custom="false" version="42.2.20">
                                <file id="org.postgresql:postgresql" version="42.2.20" path="${drivers_home}/maven/maven-central/org.postgresql/postgresql-42.2.20.jar" />
                        </library>
                        <library type="jar" path="maven:/net.postgis:postgis-jdbc:RELEASE" custom="false" version="2.5.0">
                                <file id="net.postgis:postgis-jdbc" version="2.5.0" path="${drivers_home}/maven/maven-central/net.postgis/postgis-jdbc-2.5.0.jar" />
                        </library>
                        <library type="jar" path="maven:/net.postgis:postgis-jdbc-jtsparser:RELEASE" custom="false" version="2.5.0">
                                <file id="net.postgis:postgis-jdbc-jtsparser" version="2.5.0" path="${drivers_home}/maven/maven-central/net.postgis/postgis-jdbc-jtsparser-2.5.0.jar" />
                        </library>
                </driver>
        </provider>

</drivers>

In some cases you may need to provide a driver's configuration or driver  files for a number of DBeaver jar

installations automatically.
This can be done by adding a special parameter in the  file: dbeaver.ini

-Ddbeaver.drivers.configuration-file=c:\some-path\dbeaver-drivers-config.xml

This file has the same structure as  file (see above) and it will be loaded  .drivers.xml before drivers.xml

You can specify partial driver configuration. For example if you need to configure only the jar path then it may look 
like this:

Managing drivers

Configure drivers with pre-installed jars

Provide predefined drivers configuration
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<?xml version="1.0" encoding="UTF-8"?>
<drivers>

  <provider id="generic">
    <driver id="netezza">
      <library type="lib" path="X:\jdbc-drivers\netezza-jdbc.jar" />
    </driver>
  </provider>
</drivers>
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This guide describes how to set up application preferences through configuration files without even booting it up.

Preference files have the extension  and can be found in the  directory under the following path: .prefs workspace
.metadata/.plugins/org.eclipse.core.runtime/.settings

You might not find a preference file you are interested in, if it has not been created yet. In this case, you will need 
to create one yourself. See the examples below to figure out which preference file you need.

Preference files consist of key-value pairs glued together with  and separated with a line break:=

# file org.jkiss.dbeaver.test.prefs
some.key=value1
some.other.key=value2

You can place the following preferences in the  file:org.jkiss.dbeaver.core.prefs

Name Type
Default 
Value

Allowed 
Values

Description

navigator.settings.default.preset string simple
simple , 
advanced

Sets the default view mode for new 
connections
Do not specify this preference if you want to 
configure a custom preset.

navigator.settings.default.
showSystemObjects

boolean false
true , 
false

Controls whether system objects must be 
shown.
Used if preset is not specified.

navigator.settings.default.
showUtilityObjects

boolean false
true , 
false

Controls whether utility objects must be shown.
Used if preset is not specified.

navigator.settings.default.
showOnlyEntities

boolean false
true , 
false

Controls whether only schemas and tables 
must be shown.
Used if preset is not specified.

navigator.settings.default.
mergeEntities

boolean false
true , 
false

Controls whether all tables must be shown in a 
single list.
Used if preset is not specified.

For more information, please see .Simple and Advanced View

Name Type Default Value
Allowed 
Values

Description

Managing preferences

Locating preference files

Reading and modifying preference files

Default navigator view for new connections

Miscellaneous navigator settings
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navigator.settings.default.
connectionPattern

string host_or_database
expression 
with variables

Pattern for new connections title

navigator.show.folder.
placeholders

boolean true true , false
Shows placeholders for special 
folders (e.g. Scripts)

navigator.sort.case.insensitive boolean true true , false
Sorts items in case-insensitive 
mode

navigator.sort.forlers.first boolean true true , false Shows folders first

Name Type
Default 
Value

Allowed 
Values

Description

transaction.smart.commit boolean false
true , 
false

Enables smart commit mode

transaction.smart.commit.
recover

boolean true
true , 
false

Returns to auto-commit mode after transaction 
end

transaction.auto.close.
enabled

boolean false
true , 
false

Automatically ends (rollback) transaction after 
idle period

transaction.auto.close.ttl integer 900
integer 
value

Timeout before transaction close

transaction.show.
notifications

boolean true
true , 
false

Shows folders first

Name Type
Default 
Value

Allowed 
Values

Description

database.meta.separate.
connection

string DEFAULT
ALWAYS , 
NEVER

Controls whether to open a separate connection 
for metadata read. 
Do not specify this preference if you want to use 
default settings.

database.meta.
casesensitive

boolean false
true , 
false

Specifies the usage of case-sensitive names in 
DDL statements.

database.props.expensive boolean true
true , 
false

Enables display of row count for tables.

database.meta.server.side.
filters

boolean true
true , 
false

Enables display of server-side object filters.

Name Type Default Value Allowed Values Description

qm.
queryTypes

string
USER , , USER_FILTERED

USER_SCRIPT

USER , , USER_FILTERED

,USER_SCRIPT

, , UTIL META META_DDL

View for different query 
types.

Default transaction settings

Metadata settings

Query manager settings



DBeaver User Guide 23.1. Page 480 of 526.

qm.
objectTypes

string session , ,txn query session , ,txn query View for different object 
types.

qm.
maxEntries

integer 200 integer value
Number of entries displayed 
per page.

qm.
storeLogs

boolean false true , false Enables the saving of logs.

qm.
logDirectory

string workspace directory string value
Folder location for saving 
logs.

qm.
historyDays

integer 90 integer value
Number of days for storing 
logs.

Name Type
Default 
Value

Allowed Values Description

navigator.show.
connection.host

boolean true true , false

Displays the 
connection 
host name.

navigator.show.
objects.
description

boolean false true , false

Displays the 
objects 
description.

navigator.show.
statistics.info

boolean true true , false
Displays the 
statistic info.

navigator.show.
node.actions

boolean true true , false
Displays the 
actions icons.

navigator.show.
folder.
placeholders

boolean true true , false

Displays 
placeholders 
for special 
folders.

navigator.sort.
forlers.first

boolean true true , false
Displays 
folders first.

navigator.sort.
case.insensitive

boolean false true , false

Orders 
elements 
alphabetically.

navigator.color.
nodes.all

boolean false true , false

Sets 
connection 
color for all 
elements.

navigator.show.
objects.tips

boolean true true , false

Displays 
object 
modifiers in 
tree.

navigator.show.
tooltips

boolean true true , false
Display 
tooltips.

navigator.show.
tooltips.file.
contents

boolean false true , false

Displays file 
contents in 
tooltips.

navigator.object.

The behavior 
on double-

Database Navigator settings
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doubleClick string EDIT EXPAND clicking a 
node.

navigator.
connection.
doubleClick

string EXPAND

EDIT ,
,CONNECT

,SQL_EDITOR

SQL_EDITOR_NEW

The behavior 
on double-
clicking on 
connection.

navigator.object.
defaultEditorPage

string ""

default.object.editor ,
org.jkiss.dbeaver.ui.editors.data.DatabaseDataEditor

,
org.jkiss.dbeaver.erd.ui.editor.ERDEditorEmbedded

The behavior 
of default 
editor page.

navigator.expand.
on.connect

boolean false true , false

Expands 
navigator 
tree on 
connect.

navigator.restore.
filters

boolean false true , false

Database 
navigator 
filter.

navigator.long.list.
fetch.size

integer 5000 integer values
Elements 
fetch size.

navigator.restore.
state.depth

integer 0 integer values

Restores the 
navigator 
state up to a 
certain depth.

Name Type Default Value
Allowed 
Values

Description

logs.debug.enabled boolean true
true , 
false

Enables debug logs.

logs.debug.location string ${workspace}/.metadata/dbeaver-debug.log
string 
values

Location of the log 
save file.

logs.files.output.
maxSize

integer 10485760
integer 
values

Maximum log file size 
(KB).

logs.files.output.
maxCount

integer 3
integer 
values

Maximum backup log 
files count.

Name Type Default Value Allowed Values Description

ui.auto.update.
check

boolean true true , false Enables automatic updates check.

platform.
language

string en

en , , , , zh_CN ru fr

,de

, , , , it ja es pt

, ,ko zh_TW

Platform language setting.

java.client.
timezone

string
operating system 
time zone

time zones Time zone setting.

Error Logs settings

User Interface settings
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notifications.
enabled

boolean true true , false Popup notification setting.

notifications.
closeDelay

integer 3000 integer values
Popup window automatic hides 
delay setting (ms).

Name Type
Default 
Value

Allowed 
Values

Description

database.editor.separate.connection string DEFAULT
ALWAYS , 
NEVER

Opening a separate connection for 
each editor.

database.editor.connect.on.activate boolean true
true , 
false

Connects on editors activation.

database.editor.connect.on.execute boolean false
true , 
false

Connects on query execution.

SQLEditor.autoSaveOnChange boolean false
true , 
false

Auto-saves after any modifications.

SQLEditor.autoSaveOnClose boolean false
true , 
false

Auto-saves editor on close.

SQLEditor.autoSaveOnExecute boolean false
true , 
false

Saves editor on query execution.

SQLEditor.autoSaveActiveSchema boolean true
true , 
false

Saves/restore active schema.

SQLEditor.resultSet.closeOnError boolean false
true , 
false

Closes results tab on error.

SQLEditor.resultSet.
replaceCurrentTab

boolean true
true , 
false

Replaces active result tab on single 
query execution.

SQLEditor.resultSet.orientation string HORIZONTAL VERTICAL Result orientation view.

SQLEditor.outputPanel.autoShow boolean true
true , 
false

Opens output viewer on new 
messages.

SQLEditor.outputPanel.autoShow integer 20
integer 
values

Sets maximum of result tabs for single 
query.

SQLEditor.ContentAssistant.auto.
activation.enable

boolean true
true , 
false

Enables auto-activation in SQL 
assistant.

SQLEditor.ContentAssistant.activate.
hippie

boolean false
true , 
false

Activates Hippie Engine for 
autocompletition in SQL assistant.

SQLEditor.ContentAssistant.auto.
activation.delay

integer 0
integer 
values

Auto activates delay (ms).

SQLEditor.ContentAssistant.auto.
keystrokes.activation

boolean true
true , 
false

Activates SQL assistant on typing.

SQLEditor.ContentAssistant.insert.
single.proposal

boolean true
true , 
false

Auto inserts proposal in SQL assistant.

SQLEditor.ContentAssistant.
autocompletion.tab

boolean true
true , 
false

Use Tab for autocompletion in SQL 
assistant.

SQL Editor settings
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SQLEditor.ContentAssistant.insert.
case

integer 0 1 , 2
Inserts case in SQL assistant (1- 
Upper case, 2 - Lower case).

SQLEditor.ContentAssistant.replace.
word

boolean false
true , 
false

Replaces current word in SQL 
assistant.

SQLEditor.ContentAssistant.hide.
duplicates

boolean false
true , 
false

Hides duplicate names from non-
active schemas in SQL assistant.

SQLEditor.ContentAssistant.
proposals.short.name

boolean false
true , 
false

Uses short object names in SQL 
assistant.

SQLEditor.ContentAssistant.show.
helpTopics

boolean false
true , 
false

Shows server help topics in SQL 
assistant.

SQLEditor.ContentAssistant.show.
values

boolean true
true , 
false

Shows values in SQL assistant.

sql.proposals.insert.table.alias string PLAIN
NONE , 
EXTENDED

Inserts table aliases (in FROM 
clauses).

SQLEditor.format.activeQuery boolean true
true , 
false

Enables format active query only.

script.auto.folders boolean false
true , 
false

Creates script folder for each 
connection.
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It is possible to install DBeaver in silent mode using the Windows Installer command line parameters.
This might be very useful for mass install automation (SSCM and other similar systems).
Installer was improved in DBeaver 5.3.3, special thanks to the  team.https://github.com/Drizin/NsisMultiUser

Command line parameters supported by DBeaver installer:

Parameter Description

/S silent mode, requires /allusers or /currentuser, case-sensitive

/D=path (installer only) set install directory, must be last parameter, without quotes, case-sensitive

/allusers (un)install for all users, case-insensitive

/currentuser (un)install for current user only, case-insensitive

/uninstall (installer only) run uninstaller, requires /allusers or /currentuser, case-insensitive

In order to install with the  parameter the current user must have the administrator's permission./allusers

Code Meaning

0 normal execution (no error)

1 (un)installation aborted by user (Cancel button)

2 (un)installation aborted by script

666660 invalid command-line parameters

666661 elevation is not allowed by defines

666662 uninstaller detected there is no installed version

666663 executing uninstaller from the installer failed

666666 cannot start elevated instance

other Windows error code when trying to start elevated instance"

Windows Silent Install

Parameters

Installer return codes (decimal):

https://github.com/Drizin/NsisMultiUser
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1.  

2.  

3.  

4.  

Note: This feature is available in , ,  and  editions only.Lite Enterprise Ultimate Team

Commercial versions of DBeaver ask the user to import the license file if they cannot find it locally. It is the most 
simple and convenient way to import the product license for individual users.

There are several ways to automate the license management process. It makes sense for a multi-user 
environment.

Install DBeaver

Save license text to a file. It should be named as  or .dbeaver-%PRODUCT_PREFIX%-license.dat

..dbeaver-%PRODUCT_PREFIX%-license.txt

Add the license file to one of the following locations:
Windows

%HOMEPATH%\

%APPDATA%\DBeaverData\workspace6\.metadata\

MacOS X
~/  (user home)

~/Library/DBeaverData/workspace6/.metadata/

Linux
~/  (user home)

$XDG_DATA_HOME/DBeaverData/workspace6/.metadata/

License Administration

Manual license import

License management automation

Put the license file to the predefined locations

https://dbeaver.com/dbeaver-team-edition
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4.  Launch DBeaver from Start Menu

Product prefixes:

Product name Prefix

DBeaver 
Enterprise

ee

DBeaver Lite le

DBeaver Ultimate ue

You can add the command line parameter  to the DBeaver EE shortcut. Also, you can license <license-path>

add this parameter to the  config file.dbeaver.ini

Command line reference.

Passing license file through command line
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Import from email

Import from the personal account

Insert the License key into the License Manager

Import of Subscription license

Import of License extension

License Manager

To start using commercial versions of DBeaver you can

request a  for 2 weeks;Trial license

request an  if you are a student or a teacher;Academic license

buy a Subscription license, Standard DBeaver license or DBeaver license extension.

After purchasing the DBeaver license or getting the Trial/Academic license, you will receive a License text by 
email. It will also be available in your personal account on our . This License text will contain your License ID e. site
g. DB-841MRZHY-ZH54, the start date and license owner’s name and company name. It is very important to 
import your License correctly.

You can just copy-paste the License Key to import the license into the License Manager. Please note that you 
need to copy-paste the full license text (not just the license ID). The license text starts with “–” and ends with “==” 
characters.

Sometimes an email client can corrupt the formatting of the License Key that can cause an error.

How to Import License

Import from email

https://dbeaver.com/trial/
https://dbeaver.com/academic-license/
https://dbeaver.com/buy/
https://dbeaver.com/
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Therefore, you need to import your License Key from your personal account on our site .https://dbeaver.com/

Firstly, you need to .Sign in

Secondly, you should open the  tab, where you can find all your licenses.Licenses

To open License details and copy the license key text click the license ID link. Here you can find your license 
status, type, maintenance period, and end support date.

Import from the personal account

https://dbeaver.com/
https://dbeaver.com/signin/
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At the bottom of the page you can find the License Key required to start using DBeaver. There are two options 
how to copy your License Key from the personal account:

1)Press the  button, then press OK. The license text will be copied to the clipboard.COPY TO CLIPBOARD

2)Press the  button, then press OK.DOWNLOAD LICENSE

.txt file with your License Key will be downloaded to your download folder. The file name is License ID, e. g. DB-
841MRZHY-ZH54.
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Then you need to insert the copied License Key to License Manager in DBeaver.

To start using commercial versions of DBeaver with your License Key you need to open License Manager in 
DBeaver: Help -> DBeaver License Info

The License information window can look different depending on whether you already have a valid license or not.

Then you open the License Manager and press the Import button to paste your License Key.

Insert the License key into the License Manager



DBeaver User Guide 23.1. Page 491 of 526.

If you copied the License Key to the clipboard, press the Paste button and then Import. If you downloaded a .txt 
file with the License Key, press the Load button and then select the file from Downloads. The License Key will be 
pasted automatically. Then press the Import button and your license will be added to the License Manager. You 
have successfully imported your license.

You have successfully imported your license. Now you can close the License Manager and start using DBeaver.

A subscription license requires internet access on the workstation for the first activation and each prolongation.

If you do not have an active internet connection or work behind a corporate firewall while importing the 
Subscription license, the following error can appear:

Invalid subscription

Can`t find the subscription information for license ‘DB-841MRZHY-ZH54’.

Check your internet connection and/or firewall settings and restart application.

In this case you need to check that DBeaver has internet access or you will need to configure your firewall.

The standard DBeaver license is a perpetual license with a limited period of support (1 year or 2 years).

After the end of the selected support period you can continue to use commercial versions of DBeaver without 
support and updates or buy a license extension or a new license.

If you buy the DBeaver license extension and DBeaver has internet access, the license in DBeaver will be updated 
automatically. Otherwise, you have to import the license key from your personal account once again.

Import of Subscription license

License extension
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License Manager provides you with the following information about your licenses:

License ID e. g. DB-841MRZHY-ZH54;

License type: Trial/Academic/Subscription/Standard;

Version;

License owner`s name and company name;

License owner`s email;

Start time is the date the license was received;

End time is the date the license expires (standard perpetual licenses do not have this)

Number of users: single user or multiuser for group licenses;

Support period is the period you have access to the internal support system on the site and the possibility to 
download new product versions;

State: valid or expired.

License Manager
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After purchasing a set of DBeaver licenses, you have to assign each license to an end user.

If an employee subsequently is leaving the company or the team that is using DBeaver, the license admin may 
need to reassign the license to another employee.

You can reassign the license to another user in your personal account.

Firstly, you need to .Sign in

Secondly, you should open the , where you can find all your licenses.Licenses tab

Secondly, you click the Assignment subtab. Here you can manage the license end-users and track the license 
usage.

How to Reassign License

https://dbeaver.com/signin/
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You select which license you need to reassign and press the icon in the right column.

A pop-up opens, and you can enter the new license end user's data: email; first and last name; and company. 
After filling in the form, you need to press the  button and the license owner will be changed. The license key SAVE
that contains the license end user’s name and company name will be changed too.

If you have a group or unlimited license, it is also possible to assign users. In addition, if you click the checkbox 
'Allow User 1 to manage license users', this user will become a license manager and will be able to assign users.

The license will remain in your personal account. The end user's email will be in the end-user column on the 
Assignment tab.
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Also, the new license end user will be able to find the license in the personal account and  but the end import it
user cannot change the license data. If the new license end-user has not been signed up on our website, the 
account will be created automatically. The new user will receive a welcome email with a link to set up a password 
while the previous user will receive an email that the license has been withdrawn.

https://dbeaver.com/docs/wiki/How-to-Import-License/
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1.  

2.  

3.  

4.  

5.  

6.  

7.  

This article discusses how to establish connections to an Oracle database using JDBC OCI (Type II). Please take 
into consideration that the proposed way uses DBeaver's Generic driver. It means that you cannot get Oracle-
specific functionality this way.

JDBC OCI connections require  on the local machine. Please pay attention to the Instant Oracle Instant Client
Client and the JDBC driver versions, as they must be identical. DBeaver uses the 12.2.0.1 version by default at 
the moment, so we recommend using the 12.2.0.1 version of the Instant Client.

Install the Instant Client into some folder. We will refer to this folder as ORA_HOME for the rest of the article. 
Append ORA_HOME to the PATH variable and restart DBeaver before proceeding.

Place your  file into ORA_HOME/network/admin directory.tnsnames.ora

In DBeaver, click Window -> Driver Manager -> New. This opens Create new driver dialog.

In the Settings tab, add a  of your liking. Set  to 'oracle.jdbc.OracleDriver'. Set URL Driver name Class Name
Template to 'jdbc:oracle:oci:@tnsAlias', where 'tnsAlias' is an alias from your  file. Make sure tnsnames.ora
that the Driver Type is set to Generic.

In the Libraries tab, you need to add Maven artifacts. To do that, click Add Artifact. Paste the following XML 
into the text field:

<dependencies>
    <dependency>
        <groupId>com.oracle.database.jdbc</groupId>
        <artifactId>ojdbc8</artifactId>
        <version>12.2.0.1</version>
    </dependency>
    <dependency>
        <groupId>com.oracle.database.nls</groupId>
        <artifactId>orai18n</artifactId>
        <version>12.2.0.1</version>
    </dependency>
    <dependency>
        <groupId>com.oracle.database.xml</groupId>
        <artifactId>xdb6</artifactId>
        <version>12.2.0.1</version>
    </dependency>
    <dependency>
        <groupId>com.oracle.database.xml</groupId>
        <artifactId>xmlparserv2</artifactId>
        <version>12.2.0.1</version>
    </dependency>
</dependencies>

NB: Replace the versions of the artifacts if you use a different version of the Instant Client.

In the Driver properties tab, make right-click -> Add new property.

Set the property name to 'protocol' (without quotes). Set the Value to 'oci' (without quotes).

Connecting to Oracle Database using JDBC OCI driver

Prerequisites

Configuration

https://www.oracle.com/database/technologies/instant-client/downloads.html
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7.  

8.  

Close the Driver manager.

Create a new connection using your newly configured driver.
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Note: This article is relevant for you if you work behind the corporate firewall with a different root certificates set. In 
other cases, your issues can be caused by the incorrect .SSL Configuration

It's possible that your system administrator has installed a local Java and imported the required certificates to its 
keystore. We can use them to fix the issue.

Press Windows + R to open the Run window. Type  in the prompt and press OK. It will open the command cmd

prompt. In the command prompt, type the following and press Enter:

where java

Open the Terminal and execute the following command:

/usr/libexec/java_home -V

Open a terminal and execute the following command:

readlink -e /usr/bin/java

It's pretty easy. Just find the path where you installed DBeaver and open the  folder there.jre

Open the folder with the Java you found in step 1. Locate the  files under , then copy-cacerts /lib/security

paste it into , replacing the old file. Restart DBeaver and you are ready to go.<PATH_FROM_STEP_2>/lib/security

Importing CA certificates from your local Java into DBeaver

Step 1: locate your Java

Windows

macOS

Linux

Step 2: Find the JRE in DBeaver's installation

Step 3: Copy the cacerts

https://github.com/dbeaver/dbeaver/wiki/SSL-Configuration
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The error may occur due to incorrect SSL settings usage. As a general Pkix path building failed 

recommendation, we suggest . This checkbox is available in some databases' SSL ignoring host name validation
tabs of the Connection settings.

SSL configuration
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This guide provides detailed instructions on creating a new table in DBeaver. This is a beginner-friendly guide, 
meaning it is written for individuals who may not have previous experience with databases or DBeaver.

A database table, the focal point of our guide, is a systematic arrangement of data. It consists of rows and 
columns, forming cells where the data resides. While the number of columns is fixed for a table, it can encompass 
an unlimited number of rows. The maximum number of columns a table can have in a database depends on the 
database management system. DBeaver facilitates various operations, including data manipulation and data 
definition, with these tables.

Initially, the guide will cover the essential step of creating a table. After successfully creating a table, there are 
several enhancements you can add, such as columns, constraints, indexes, and triggers. The creation of a table is 
a fundamental operation in database management, and while there are many aspects to consider, not all of them 
are mandatory. The only mandatory step is the creation of the table itself and the definition of columns. The rest 
are optional and can be used to enhance the functionality and integrity of your database.

Table creation

Creating columns

Implementing constraints

Utilizing foreign keys

Creating indexes

Incorporating triggers

While this guide is designed around PostgreSQL within DBeaver, the processes can vary slightly with other 
database systems.

In DBeaver, creating a table is a straightforward process. Once you've , you can connected to your database
initiate the table creation process by right-clicking on the Tables folder in the  and selecting Database Navigator

.Create New Table

New Table Creation

Overview

Table of contents:

Create table
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Upon creating a new table in DBeaver, a window will open presenting the . This is the dedicated Properties editor
interface where you can manage and manipulate your tables. The specific options available to you will depend on 
the capabilities of your chosen database system.

There are also various ways to create a table: from the  and from the .Properties editor ER diagram

From : In the , double-click on the database name or table name, or select Properties editor Database Navigator
 from the context menu. In the window that opens, navigate to the  tab, select the  View schema Properties Tables

section, right-click on the window, and choose .Create New Table
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From ER Diagram: In the , double-click on the database name or table name. In the window Database Navigator
that opens, navigate to the  tab, right-click on the window, and choose . ER Diagram Create New Table
Alternatively, in the , right-click on the database/table name and click . In the Database Navigator View Diagram
window that opens, you can right-click and choose .Create New Table

Saving a table in DBeaver is a crucial yet straightforward process. Once you have defined the properties of the 
table, it's important to commit these changes to the database. Until you save your changes, your new table exists 
only within DBeaver and hasn't been created in the actual database. Here are the three options for saving the 
changes:

Click on  ->  -> .File Save Persist

Select the desired table in the  and press  (or  for Mac OS), choose Database Navigator Ctrl+S CMD+S
 to save the changes.Persist

Utilize the  button  located at the bottom of the  and press  to save the Save Editor panel Persist
changes.

Modifying a table in DBeaver involves adjusting its structure or properties, such as adding, removing, or changing 
columns, adjusting constraints, or altering table settings. To make adjustments, navigate to the  editor. Properties
Access this by right-clicking the table's name in the  menu and selecting .Database Navigator View Table

Saving changes

Modify table
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The specific options and capabilities available to you when modifying a table will depend on the database system 
you're working with. Always refer to the documentation of your specific database system for detailed information.

Deleting a table in DBeaver involves a few simple steps. Firstly, navigate to the table you wish to delete in the 
. Once you've located the table, right-click on it and select the  option from the context Database Navigator Delete

menu. A confirmation dialog box will appear, allowing you to review the action before it's performed.

Upon confirming your decision, DBeaver will execute the necessary SQL command to remove the table from your 
PostgreSQL database. Please be aware that this action is permanent, and any data stored in the table will be 
irretrievably lost. Therefore, it's crucial to ensure that you've adequately backed up any important data before 
proceeding with the deletion.

Tip: The confirmation dialog box, which appears when you are deleting a table in DBeaver, offers an important 
feature called the  option. This option, when selected, automatically removes all related records in Cascade delete

Delete table
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child tables, aligning with the deletion of a record in the parent table. While this can be useful for maintaining data 
integrity, it should be used with caution. If not handled properly, it can lead to unintended data loss by deleting 
records that you may not have intended to remove. Always ensure you understand the relationships and 
dependencies in your data before using the  option.Cascade delete

DBeaver is a database management tool, and as such, it doesn't impose its own restrictions on table creation. 
Instead, the restrictions that apply when creating tables are determined by the specific database system you're 
using.

However, there are some general considerations to keep in mind when creating tables:

Naming Restrictions: The name of the table must be unique within its schema. Most database systems also 
have restrictions on the length of the table name and the characters it can contain.

Storage Restrictions: The total amount of data that can be stored in a table is determined by the storage 
capacity of the database system.

Performance Considerations: While not a restriction per se, it's important to note that the structure of a table 
can have significant impacts on the performance of data retrieval and manipulation operations. For example, 
having a large number of columns, especially ones that are rarely used, can slow down query performance.

Remember that the specific restrictions and limitations can vary depending on the database system you're using. 
Always refer to the documentation of the specific database system for detailed information.

New Table Creation | Creating columns >>

Restrictions on table creation
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1) Go to the  tab in the , right-click on the pane of the object's sub-entities, and select Columns Properties editor
 from the context menu.Create New Column

![](images/tutorial_images/4_RightClick_CreateNewColumn.png) 

You can also add a new column by expanding the table view in the  and selecting Database Navigator Create 
 from the context menu.New Column

Additionally, to create a new column, you can utilize the  button  located at the Create New Column
bottom of the .Editor panel

2) Customize a column's settings in the  window. Adjust the , , , , Edit Attribute Name Data type Identity Collation Not 
,  value, and add a  as needed.null Default Comment

![](images/tutorial_images/5_Column_Edit.png) 

3) Persist the changes.

Columns

Create

Modify
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Go to the  menu, and choose the right database and column to modify its settings. Right-click Database Navigator
the column and select .View Column

You can rename the column, change its data type, tweak the  option, adjust permissions, and add Not Null
comments.

Note: not all databases support the ability to modify columns.

To delete a column, right-click on the column's name in the  and select , or you can Database Navigator Delete
select the necessary column and press the  key.Delete

Delete
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Tip: Before deleting a primary key column, remove its constraint within the table properties before deleting it.

Data Type: Each column in a table has a specific data type. The type of data that can be stored in a column is 
dictated by its data type.

Nullability: By default, columns can hold . However, by specifying  during column creation, NULL NOT NULL
you can enforce that every row must contain a value for that column.

Unique : A unique constraint ensures that all values in a column are distinct. Duplicate entries are Constraint
not permitted.

Check Constraint: A check constraint enables you to specify a condition on a column. Every value added to 
the column must satisfy this condition.

Default Value: A column can be given a default value. If no value is specified during data insertion, the 
column uses the default.

Remember, these restrictions are essential to ensure data integrity, accuracy, and reliability in your database.

Restrictions
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1) In the , move to the  tab of the corresponding table, right-click on the pane or Properties editor Constraints
window, and  from the context menu.Create New Key

Constraints

Primary key

Create
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2) Select the column and save.

: Уou can create a composite primary key by selecting multiple columns for it.Note

3) After you hit , a window will appear displaying the newly created primary Key.OK

 4) Persist the changes.

To modify an existing primary key, you need to first delete it and then add a new primary key with the updated 
parameters.

Modify
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To delete a primary key, right-click on the key's name in the  and select , or you can select Properties editor Delete
the necessary column and press the  key.Delete

You can't delete a primary key in a table with records unless you first remove all dependent foreign keys. Or, you 
can adjust the  and  actions of the foreign key.On Delete On Update

Tip: If you see an error, try using  option to delete dependent objects.Cascade

When you're adding constraints, you can pick not just a primary key, but also a unique key.

Delete

Restrictions

Unique key
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A Unique key is a database constraint ensuring distinct values in a column or a group of columns. While it 
identifies unique records in a table, it's not necessarily the primary key. It can be created on a single column or a 
group of columns, with each value being unique. A Unique key maintains data integrity in the table. If you try to 
insert a duplicate value, you'll get an error.

A check expression in a database is also a constraint, it defines acceptable values for a column.

Check expression
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When creating or altering a table, you can set a check expression to enforce specific conditions, such as values 
being greater than or equal to a certain number or within a certain range. For instance, you could set a constraint 
for salary_amount column to always be non-negative. Inserting a negative value, like  for salary, would -100000

trigger an SQL Error.
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1) In the corresponding table, click on the  tab, right-click, and select  from Foreign Keys Create New Foreign Key
the menu.

Additionally, to create a new foreign key, you can utilize the  button  located at Create New Foreign Key
the bottom of the .Editor panel

2) Choose the Reference table, Unique Key, and hit save.

Foreign-Keys

Create
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: If necessary, set the On Delete and On Update clauses to dictate what happens when you delete or update Note
a row in the main table.

3) After hitting , a window displaying the newly created foreign key will appear.OK

 4) Persist the changes.

You can rename a foreign key, add a comment, and tweak the  and  rules. To view On Delete On Update
parameters, and double-click the foreign key name.

Modify
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To delete a foreign key, right-click on the key's name in the  and select , or you can select Properties editor Delete
the necessary column and press the  key.Delete

Warning: Be extra cautious here, as deleting a key can significantly affect your data.

Referential Integrity: Foreign keys enforce referential integrity. The values in the foreign key column must 
match those in the referenced primary key.

Impact on Performance: Managing foreign keys can slow down insert and update operations because of the 
need to check referential integrity.

No Circular References: Circular foreign key references are not permitted in most databases where two or 
more tables refer to each other.

Delete

Restrictions
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Delete and Update Operations: Deleting or updating rows from the referenced table can be complicated 
because of the need to preserve referential integrity.

Schema Modifications: Changes to the schema of a table (like altering data types or column deletions) can be 
restricted if a foreign key references the table.

Note: these limitations can vary based on the specific SQL database system you are using, such as PostgreSQL, 
MySQL, Oracle, SQL Server, etc. Always refer to the detailed documentation for your database system.
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1) To create an index, navigate to the corresponding table. Click on the  tab. Right-click and select Indexes Create 
.New Index

2) Choose the column for the index and click .OK

Indexes

Create
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Note You have the option to create a composite index, which is an index built on several table columns. It boosts 
query execution speed when dealing with multiple-column conditions. A composite index can greatly improve 
database performance with complex conditions. It's recommended to put unique fields at the end of the composite 
index.

3) Persist the changes.

To modify indexes, double-click the index name to view its parameters.

Modify
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Remember, the ability to alter index parameters depends on the DBMS type. Changing these parameters may 
slow down query performance. Always test performance implications before making changes to a production 
server.

To delete an index, right-click on the index's name in the  and select , or you can select the Properties editor Delete
necessary column and press the  key.Delete

Delete

Restrictions
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Unique indexes created due to a primary key or unique constraint can't be deleted. Instead, remove the 
constraint. This action removes the uniqueness requirement for column values involved in the constraint 
expression and deletes the corresponding unique index.

Unique Indexes: These enforce uniqueness on the indexed column(s), which can limit data entry if values 
must be distinct.

Performance Impact: Indexes can improve query speed, but they slow down data modification operations 
(INSERT, UPDATE, DELETE) as the index must also be updated.

Storage: Indexes consume disk space. This might become significant if there are many indexes or the table is 
large.

Null Values: Depending on the database system, there may be restrictions related to indexing null values.

Data Types: Certain data types might not be indexable or may require specific index types.

Always consider these factors when creating indexes to ensure optimal database performance and efficiency.
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1) To create a trigger, start by creating a function. Navigate to the  section in the . Functions Database Navigator
Right-click to open the context menu and select .Create New Function

2) Choose the function name, type, language, and return type (trigger) for your new function.

Triggers

Create

Function
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3) In the  section, write the function that will be called when the trigger is activated.Source

For example:

BEGIN
    IF NEW.salary_amount < 0 THEN
        RAISE EXCEPTION 'Error: Salary cannot be negative';
    END IF;
    RETURN NEW;
END;

1) Once you've created the function, create the trigger. Navigate to the  section in the  of Triggers Properties editor
the relevant table. Right-click on the screen and select .Create New Trigger

Trigger
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2) In the opened window, choose the trigger's name and the function to be used.

3) Finally, describe the code for the trigger.
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For instance:

CREATE TRIGGER check_negative_salary_trigger
BEFORE INSERT
ON company.salary
FOR EACH ROW
EXECUTE function company.salary_trigger();

4) Persist the changes.

In this example, a  function is created that evaluates the new salary value (NEW.salary). If the salary_trigger()

salary is negative, it throws an exception with an error message. Then, a  is check_negative_salary_trigger

established to run this function before any  or  operations on the "salary" table. Should the salary INSERT UPDATE

value be negative, an exception is triggered and the operation is stopped.

1) To modify a function or trigger, navigate to the .Database Navigator

2) In the relevant sections, select the function or trigger you want to change.

3) Then, click  for functions or  for triggers. This action opens the selected item in an View Function View Trigger
editable format.

![](images/tutorial_images/17_View_Function_Trigger.png)

To delete a function or a trigger, navigate to the . Here, you will find sections for both functions Database Navigator
and triggers.

Modify

Delete
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Locate the function or trigger you want to delete within the relevant section and select either  from the Delete
context menu, or you can select the necessary function or trigger and press the  key.Delete

Recursive Triggers: Some databases allow recursive triggers, where a trigger can call itself. This can lead to 
infinite loops and excessive system load if not handled correctly.

Data Modification: Triggers can't be used to modify a table that is already being used (for reading or 
modifying) in the statement that invoked the function or trigger.

Execution Order: The order in which multiple triggers are fired isn't guaranteed. This can lead to unexpected 
results if triggers have interdependencies.

Performance: Triggers can slow down data modification operations because they add extra processing. They 
should be used sparingly and optimized for performance.

Transaction Control Statements: In many SQL databases, transaction control statements (like COMMIT and 
ROLLBACK) are not allowed within trigger code. However, exceptions apply depending on the database 
system.

Note: these limitations can vary based on the specific SQL database system you are using, such as PostgreSQL, 
MySQL, Oracle, SQL Server, etc. Always refer to the specific documentation for your database system to 
understand its unique foreign keys behavior.

Restrictions
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